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保証 
スペクトラムアナライザ GSP-9330 

この度は Good Will Instrument 社の計測器をお買い上げいただきあり

がとうございます。今後とも当社の製品を末永くご愛顧いただきますよう

お願い申し上げます。 

GSP-9330/VT/VGT/VG は、正常な使用状態で発生する故障について、

お買上げの日より 1 年間に発生した電気的故障については無償で修

理を致します。 

ただし、キーパッド、エンコーダなどの機構部品は除きます。 

また、液晶は 1 年間、ケーブル類など付属品は除きます。 

また、保証期間内でも次の場合は有償修理になります。 

1．火災、天災、異常電圧等による故障、損傷。 

2．不当な修理、調整、改造がなされた場合。 

3．取扱いが不適当なために生ずる故障、損傷。 

4．故障が本製品以外の原因による場合。 

5．お買上げ明細書類のご提示がない場合。 

お買上げ時の明細書（納品書、領収書など）は保証書の代わりとなりま

すので、大切に保管してください。 

また、校正作業につきましては有償にて受け賜ります。 

この保証は日本国内で使用される場合にのみ有効です。 

This warranty is valid only Japan. 

 



本マニュアルについて 

ご使用に際しては、必ず本マニュアルを最後までお読みいただき、 

正しくご使用ください。また、いつでも見られるよう保存してください。 

本書の内容に関しましては万全を期して作成いたしましたが、万一不

審な点や誤り、記載漏れなどがございましたらご購入元または弊社ま

でご連絡ください。 

このマニュアルは著作権によって保護された知的財産情報を含んで

います。 当社はすべての権利を保持します。 当社の文書による事

前の承諾なしに、このマニュアルを複写、転載、他の言語に翻訳する

ことはできません。 

このマニュアルに記載された情報は印刷時点のものです。 部品の

仕様、機器、および保守手順は、いつでも予告なしで変更することが

ありますので予めご了承ください。 

Microsoft、Windows および Excel は米国マイクロソフト社の登録商

標です。 

 

2016 年 7 月 6 日 
Good Will Instrument Co., Ltd. 

No. 7-1, Jhongsing Rd., Tucheng Dist., New Taipei City 236, Taiwan. 
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安全上の注意 
この章は、本器の操作および保存時に気をつけな

ければならない重要な安全上の注意を含んでいま

す。 操作を開始する前に以下の注意をよく読んで安

全を確保し、最良の環境に機器を保管してください。 

安全記号 

以下の安全記号が本マニュアルまたは本体上に記載されています。 
 

 警告 
警告： ただちに人体の負傷や生命の危険につながる

恐れのある状況、用法が記載されています。 

 注意 
注意：本器 または他の機器へ損害をもたらす恐れの

ある個所、用法が記載されています。 

 
危険：高電圧の恐れあり。 

 
注意：マニュアルを参照してください。 

 
保護導体端子 

 
フレームまたはシャーシ 端子 

 

Do not dispose electronic equipment as unsorted 

municipal waste. Please use a separate collection 

facility or contact the supplier from which this 

instrument was purchased. 
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安全上の注意 
 

一般注意事項 

 注意 

・ 電源コードは、製品に付属したものを使用してくださ

い。ただし、入力電源電圧によっては付属の電源コ

ードが使用できない場合があります。その場合は、

適切な電源コードを使用してください。 

・ 感電の危険があるためケーブルの先端を信号源に

接続したまま抜き差ししないでください。 

・ 入力端子には、製品を破損しないために最大入力が

決められています。製品故障の原因となりますので

定格・仕様欄または安全上の注意にある仕様を越え

ないようにしてください。周波数が高くなったり、高圧

パルスなどによっては入力できる最大電圧が低下し

ます。 

・ 重量のある物を本器の上に置かないでください。 

・ 激しい衝撃または荒い取り扱いは本器 の損傷につ

ながります。 

・ 本器 に静電気を与えないでください。 

・ 端子に対応したコネクタのみを使用し、裸線は使用

しないでください。 

・ RF 入力への信号が+30dBm または DC 電圧最大 

＋30dBm を越えていないようにしてください。入力回

路が破損します。 

・ TG 出力端子に信号を入力しないでください。 

・ 通気口および冷却用ファンの通気口をふさがないで

ください。製品の通気口をふさいだ状態で使用すると

故障、火災の危険があります。 

・ 認定者以外は、本器を分解しないでください。 
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 (測定カテゴリ) EN61010-1:2010 は測定カテゴリと要求事項を以下の

要領で規定しています。 GSP-9330 シリーズはカテゴリⅡの部類に

入ります。 

•測定カテゴリ IV は、建造物への引込み電路、引込み口から電力量

メータおよび一次過電流保護装置（分電盤）までの電路を規定しま

す。 

•測定カテゴリ III は、直接分電盤から電気を取り込む機器（固定設

備）の一次側および分電盤からコンセントまでの電路を規定します。 

•測定カテゴリ II は、コンセントに接続する電源コード付機器（家庭用

電気製品など）の一次側電路を規定します。 

•測定カテゴリ I は、コンセントからトランスなどを経由した機器内の

二次側の電気回路を規定します。ただしこの測定カテゴリは今後廃

止され、Ⅱ/Ⅲ/Ⅳに属さない測定カテゴリ 0 に変更されます。 

電源電圧 

 警告 

電源電圧：AC 100V～240V、50/60Hz  

感電を避けるために AC 電源コードのアースを接続し

てください。 

バッテリー 

 注意 

・ 定格：10.8V、6 cell Li-ion バッテリー 

・ バッテリーの取り付け/取り外しの前に本体の電源を

オフにし、電源コードを取り外してください。 

クリーニング 
・ クリーニング前に本器の電源コードを外してくださ

い。 

・ 中性洗剤と水の混合液に浸した柔らかい布地を使

用します。 液体はスプレーしないでください。本器に

液体が入らないようにしてください。 

・ ベンゼン、トルエン、キシレン、アセトンなど危険な材

料を含む化学物質を使用しないでください。 
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操作環境 
・ 屋内で直射日光が当たらない場所、ほこりがつかな

い環境、ほとんど汚染のない状態 でご使用くださ

い。以下の注意事項を必ず守ってください。 

・ 可燃性ガス内で使用しないで下さい。 

・ 高温になる場所で使用しないでください。 

・ 湿度の高い場所での使用を避けてください。 

・ 腐食性ガス内に設置しないで下さい。 

・ 風通しの悪い場所に設置しないで下さい。 

・ 傾いた場所、振動のある場所に置かないで下さい。

・ 温度：5℃～ 45℃ 

・ 湿度：<90％ 

 (汚染度) EN61010-1:2010 は測定カテゴリと要求事項を以下の要領

で規定しています。 GSP-9330 シリーズは汚染度 2 に該当します。

汚染の定義は「絶縁耐力か表面抵抗を減少させる固体、液体、また

はガス(イオン化気体)の異物の添加を指します。 

汚染度 1: 汚染物質が無いか、または有っても乾燥しており、非電導

性の汚染物質のみが存在する状態。汚染は影響しない状態を示し

ます。 

汚染度 2: 結露により、たまたま一時的な電導性が起こる場合を別

にして、非電導性汚染物質のみが存在する状態。 

汚染度 3: 電導性汚染物質または結露により電導性になり得る非電

導性汚染物質が存在する状態。 

保存環境 場所：屋内 

温度：-20℃～70℃ 

湿度：< 90％ 

Disposal 

 

Do not dispose this instrument as unsorted municipal 

waste. Please use a separate collection facility or 

contact the supplier from which this instrument was 

purchased. Please make sure discarded electrical 

waste is properly recycled to reduce environmental 

impact. 
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イギリス向け電源コード 

本器をイギリスで使用する場合、電源コードが以下の安全指示を満たし

ていることを確認してください。 
 

注意：このリード線/装置は資格のある人のみが配線することができます。 

警告：この装置は接地する必要があります。 

重要：このリード線の配線は以下のコードに従い色分けされています： 

緑/ 黄色： 接地 

青色： 中性 

茶色： ライブ (位相) 

主リード線の配線の色が使用しているプラグ/装置で指定されている色

と異なる場合、以下の指示に従ってください： 

緑と黄色の配線は、E の文字、接地記号   がある、または緑/緑と黄色

に色分けされた接地端子に接続する必要があります。 

青い配線は N の文字がある、または青か黒に色分けされた端子に接

続する必要があります。 

茶色の配線は L または P の文字がある、または茶色か赤に色分けさ

れた端子に接続する必要があります。 

不確かな場合は、装置に梱包された説明書を参照するか、代理店にご

相談ください。 

この配線と装置は、適切な定格の認可済み HBC 電源ヒューズで保護

する必要があります。 詳細は装置上の定格情報および説明書を参照

してください。  

参考として、0.75mm2 の配線は 3A または 5A ヒューズで保護する必要

があります。 それより大きい配線は通常 13A タイプを必要とし、使用す

る配線方法により異なります。 

ソケットは電流が流れるためのケーブル、プラグ、または接続部から露

出した配線は非常に危険です。 ケーブルまたはプラグが危険とみなさ

れる場合、主電源を切ってケーブル、ヒューズおよびヒューズ部品を取

除きます。 危険な配線はすべてただちに廃棄し、上記の基準に従って

取替える必要があります。 
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先ず初めに 
この章では、GSP-9330 の概要、パッケージ内容、

初めて使用する場合の説明、前面パネル、背面パ

ネルと GUI を説明します。 

  
 

GSP-9330 について ................................ 9 
主な特徴 .................................................................................................................................................. 9

アクセサリ ............................................. 11 
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GSP-9330 について 
GSP-9330 は、3GHz GSP-9300 の機能を大幅に強化しパフォーマン

スを向上させました。 

GSP-9330 は、スペクトル表示の他にもトポグラフィックやスペクトログラ

フ表示が可能です。分割画面表示によりスペクトルと同時に表示する

機能を備えています。また、測定機能には、EMI と EMS の予備試験の

ための EMC プリテスト機能や 2FSK、1PdB など測定機能を多数サポー

トしています。 

GSP-9330 は、GSP-9300 から大幅に掃引時間を強化しています。  

モデル一覧 

機能 型式 

基本モデル： GSP-9330 

G 付きモデル： TGSP-9330VT 

TG+GPIB 付きモデル： GSP-9330VGT 

GPIB 付きモデル： GSP-9330VG 

 

主な特徴 
 

性能 
・ 周波数範囲：9kHz～3.25GHz 

・ 周波数分解能：1Hz 

・ RBW 確度（Nominal）：±5％<1MHz、±8％=1MHz  

・ VBW：1Hz～1MHz (1-3-10 ステップ) 

・ 振幅測定範囲：DANL～30dBm (周波数に依存) 

・ 入力アッテネータ：0～50dB、1dB ステップ 

・ 位相ノイズ：< -88dBc/Hz@1GHz、10kHz, typical 

特長 
・ RBW フィルタ：1-3-10 ステップ 

・ 3 種類の表示モード：スペクトラム、トポグラフィック、 

スペクトログラフィック 

・ 画面分割表示（上/下） 
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・ EMI 用-6dB RWB フィルタ：200Hz, 9kHz, 120kHz, 

1MHz を標準でサポート 

・ 自動起動モード：指定した曜日と時間で自動起動 

・ プリアンプを標準装備 

・ ゲートスイープ機能をサポート 

・ マーカ周波数カウンタ 

・ EMI プリテスト機能 

・ SEM 測定 

・ ACPR 測定 

・ OCBW 測定 

・ 2FSK 測定 

・ 位相ジッタ測定 

・ 高調波測定 

・ P1dB 測定 

・ チャンネルパワー測定 

・ 復調解析 

・ 豊富なマーカ機能とピークテーブル 

・ シーケンス機能：設定した操作を自動実行 

・ EMI Quasi-peak と Average ディテクタをサポート 

・ 別売バッテリーパックで 2 時間動作 
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インターフェース 
・ 8.4 インチカラー液晶 SVGA (800600) 

・ 機能アイコンを画面上に表示 

・ RS-232 with RTS/CTS ハードウェアフロー制御 

・ USB 2.0：USB TMC をサポート 

・ LAN TCP/IP LXI をサポート 

・ GP-IB 対応モデル：IEEE488 インターフェース 

・ IF 出力@ 886MHz 

・ ヘッドフォン出力：AM/FM 復調時（モノラル） 

・ REF (リファレンスクロック)入力/出力 BNC 端子 

・ アラーム/オープンコレクタ出力 BNC 端子 

・ トリガ/ゲート入力 BNC 端子 

・ RF N 型（メス）入力端子 

・ トラッキングジェネレータ付きモデル 

・ オプション用出力端子：DC +7V/最大 500mA、 

SMB 端子  

アクセサリ 
 

標準アクセサリ 部品番号 内容 

 仕向け地による 電源コード 

 N/A ユーザーマニュアル CD： 

内容：ユーザーマニュアル、プロ

グラミングマニュアル, IVI ドライ

バ 

 N/A クイックスタートガイド 

 N/A Certificate of calibration 

別売アクセサリ 型式 内容 

 Opt2.  Battery (10.8V/5200mAH  

Li-ion バッテリー) 

 ADB-002 DC ブロック：BNC 端子 50Ω 

10MHz～2.2GHz 
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 ADB-006 DC ブロック N 型端子 50Ω 

10MHz～6GHz 

 ADB-008 DC ブロック SMA 端子 50Ω 

0.1MHz～8GHz 

 GSC-009 ソフトキャリングケース 

 GRA-415 6U ラックマウントキット 

ソフトウェア Web サイトよりダウンロード可能 

 Windows 用 PC ソフトウェア (SpectrumShot quick start 

guide, SpectrumShot software) 

 サポート s LabView と LabWindows/CVI Programming

をサポートした IVI ドライバ 

 Android システム用ソフトウェア(“GSP-9330 Remote 

Control”は、Google play からダウンロード可能) 

注意：LabView & LabWindows/CVI は、ナショナルインスツルメンツ株式会社 

Windows は米国 Microsoft Corporation の米国およびその他の国における登

録商標です 

Android および Google Play  は、Google Inc.の商標または登録商標です。  
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外観 

GSP-9330 前面パネル 

LOC AL

C ON TR OL

FILE AUXILIARY

F requen cy

A ut oset

A mp li tu de

S pa n

B W /A VG

D is pl ay

Trace

S we ep

M ea su re

Trigg er

F ile

R ec a l l

S av e

Pea k

M ar ker

M ar ke r

S ys te m

P re se t

S earc h

Q uick

S av e

E MC
P re test

7

4

1

0

8

5

2

9

6

3

/ E nter

BK SP

S we ep

M od e

L im it

L in e

S eq ue nc e

O pt ion

C on tr ol

F as t/

N ormal

F 4

F 3

F 2

F 1

F 6

F 5

F 7

R F INPUT 50

R EV PWR + 30 d Bm

TG OUTPU T 50 � �500 m A MAX .

D C 7 V

O UT PUT + 30 d Bm MAX .

M AX .D C ±50 V M AX .D C ±50 V

9 kHz 3 .2 5G Hz

S pect rum Ana ly zerG SP -9 33 0

LCD ディスプレイ メインキー

ファンクションキー

コントロールキー

電源キー

ファイルキー

補助キー

スクロールノブ

矢印キー

RF入力端子

オプション用
DC電源出力端子

トラッキング
ジェネレータ出力

テンキー、
Enter とBK SPキー

USB A ,
Micro SDポート

マーカキー

Preset /Local
とQuick Saveキー

MARKER

 

LCD ディスプレイ 8 インチ、SVGA（800600）カラー液晶を搭載。画面に

現在の機能メニュー、振幅とマーカ情報を表示。  

ファンクション 

キー 
F 1

  

~ F 7 F1 から F7 ファンクションキーは、直

接画面右側のソフトキーに対応して

います。 

メインキー 

 

センター周波数、スタート周波数、ス

トップ周波数、センター周波数ステッ

プと周波数オフセット値を設定しま

す。 
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フルスパン、ゼロスパンとラストスパ

ンオプションとスパンを設定します。 

 

 

振幅リファレンスレベル、アッテネー

タ、プリアンプ制御、スケールおよび

減衰とスケールのその他のオプショ

ンを設定します。 

 

 

自動的に最大振幅とピーク信号を検

索し、最適な水平および垂直スケー

ルで表示します。 

コントロールキー 

 

分解能帯域幅（RBW）、ビデオ帯域幅

（VBW）、トレースの平均設定と EMI

フィルタのオン/オフを切り換えます。

 

 

スイープ時間とゲート時間を設定しま

す。 

 

 

スイープコントロールの Fast と 

Normal を切り替えます。 

 

 

ACPR、OCBW、復調測定、 SEM、

TOI、2FSK、位相ジッタやその他の高

度な測定オプションメニューを表示し

ます。 

 

 

EMI プリテストの設定メニューを表示

します。 

 

 

トレースおよびトレース関連の機能を

設定します。 

 

 

Pass/Fail リミットラインの設定と実行

をします。 
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ディスプレイキーは、ウィンドウモード

と基本的な表示プロパティを設定しま

す。 

 トリガモードを設定します。 

ファイル 

 

ファイル操作のメニューを表示しま

す。 

 

 

トレース、情報などの保存と保存オプ

ションを設定します。 

 

 

トレース、情報その他の呼出と呼出

オプションを設定します。 

マーカ 

 

マーカのオン/オフとマーカ設定メニ

ューを表示します。 

 

 

Marker キーは、トレース上のマー

カ位置を設定します。 

 

 

ピークマーカのメニューを表示しま

す。最大と最少ピークを検出します。

マーカと一緒に使用します。 

補助 

 

シーケンスの設定と編集のメニュー

を表示します。  

 

 

Option Control キーは、トラッキング

ジェネレータやデモキットなどのオプ

ションの設定をします。 

 

 

System キーは、システム情報の表

示、インターフェース設定やその他関

連機能メニューを表示します。 
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Preset / Local 

キー 
 

Preset キーは、本体のパネル設定を

工場出荷時設定またはユーザー設

定状態に変更します。 

また、Preset キーはリモートモード解

除し本体をローカルモードに戻しま

す。 

 

 

Quick Save キーを押すと、File 設定

設定した内容（情報、トレース、画面

表示、リミットライン、補正値またはシ

ーケンス）を簡単に保存できます。  

電源キー 本器の電源をオン/オフします。 

On = 黄色、off = 青色 

スクロールノブ 数値の編集、項目一覧の選択 

矢印キー 値の増加/減少（ステップ）や 

一覧項目の選択 

RF 入力端子 

 

RF 入力。RF 信号を入力します。 

最大入力： +30dBm 

入力インピーダンス：50Ω 

最大 DC 電圧：±50V 

N 型端子、メス 
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オプション用 

DC 電源 
500mA  MAX.

DC  7V
OUTPUT  

オプション用 DC 電源供給端子：

SMB 端子 

DC +7V/最大 500mA 

数値キー 数値キーパッドは、

数値やパラメータの

入力に使用します。

矢印キーやスクロー

ルノブと併用する場

合もあります。 

TG 出力端子 

 

トラッキングジェネレータ（TG）の信号

出力端子 

N 型：メス 

出力インピーダンス：50Ω 

出力パワー：-50dBm～0dBm 

最大リバースパワー：+30dBm 

USB A, Micro SD
 

データ等の保存用 USB A ポートと

Micro SD ポート 
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背面パネル 

AC 100    240V
50    60Hz 82W  MAX.

AC 100    240V
50    60Hz 82W  MAX.

USB -B,

LANポート

冷却ファンDVI-Iポート
IF OUT

TRIG IN/GATE IN
ポート

ALARM出力/
オープンコレクタ

REF OUT バッテリーカバー

別売バッテリーパック

REF IN

RS-232Cポート

GP-IB
モデルによる

電源ソケット

 

RS-232C RS-232C ポート、D-Sub 9 ピン、オ

ス？ 

IF 出力端子 SMA 端子、メス、 IF 出力端子 

DVI-I DVI ビデオ出力端子。 

SVGA (800X600)サポート @ 60Hz. 

冷却ファン   
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電源コードソケッ

ト 

電源ソケット： 

AC 100～240V、50/60Hz. 

バッテリーパック

（別売） 

電圧：10.8V 

電流容量： 5200mAH 

REF IN リファレンスクロック信号を入力。 

BNC 端子メス 

REF OUT リファレンス信号出力。BNC メス。 

10MHz、インピーダンス 50Ω 

盗難防止ロック  

アラーム出力 BNC 端子、メス。 オープンコレクタ、ア

ラーム信号を出力 

TRIG IN/GATE IN BNC 端子、メス。3.3V CMOS トリガ入

力/スイープゲート入力 

イヤフォン 3.5mm ステレオヘッドフォンジャック 

(モノラル結線) 

USB B USB B デバイスポート。 

USB 1.1/2.0 
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LAN RJ-45 10Base-T/100Base-Tx 

表示 

 

スケールと
リファレンス
レベル

アッテネータ
レベル 日付と時間

機能
メニューマーカ情報

トレース/
検出設定

未割当設定
アイコン

スイープ
トリガ
プリアンプ-
USB

周波数/帯域幅設定 情報アイコン

スイープ
設定

トレースと
波形

LXIアイコン

入力値
メッセージ

スイープ
プログレス
バー

 

スケール 垂直目盛のスケールを表示します。 

詳細は、48 ページを参照ください。 

リファレンス 

レベル 

リファレンスレベルを表示します。 

詳細は、46 ページを参照ください。 

アッテネータ 

レベル 

入力信号のスケール（アッテネータ）を表示します。詳

細は、47.ページを参照ください。 

日付/時間 日付と時間を表示します。 

詳細は、116 ページを参照ください。 

マーカ情報 マーカ情報を表示します。 

詳細は、92 ページを参照ください。 
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LXI アイコン LXI 接続の状態を表示します。 

詳細は、270 ページを参照ください。 

ファンクション 

メニュー 

F1 から F7 キーは、画面右のソフトメニューキーに関

連します。 

スイープモード 

 

スイープモードキーで設定された 

スイープモードをアイコン表示します。 

詳細は、76 ページを参照ください。 

スイープ設定 

 

スイープアイコンは、スイープ状態を表

示します。  

詳細は、70 ページを参照ください。 

トレースと 

ディテクタ設定 

 

トレースアイコンは、トレースの種類と

各トレースのディテクタモードを表示し

ます。 

詳細については、79 ページを参照して

ください。 

ブランク 未割り当ての設定アイコン。 

トリガ設定 

 

トリガアイコンは、トリガ情報を表示し

ます。 

詳細は、87 ページを参照ください。 

プリアンプ設定 

 

プリアンプアイコンは、プリアンプ情報

を表示します。 

詳細は、60 ページを参照ください。 

USB 設定 USB A ポートの状態を表示します。  
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情報アイコン インターフェース情報、電源情報、アラーム情報などを

表示します。情報アイコンの概要については、22 ペー

ジの情報アイコン一覧を参照ください。 

周波数/ 

BW 設定 

スタート周波数、センター周波数、ストップ周波数、

RBW、VBW、SPAN とスイープ設定を表示します。 

入力/メッセージ

欄 

画面下のこのエリアは、システムメッセージ、エラーメッ

セージ表示と入力値/パラメータ表示に使用されます。

トレースと波形 メイン表示は、入力信号、トレース（79 ページ）、リミット

ライン（221 ページ）とマーカポジション（92 ページ）を表

示します。 

スイープ進行 

状況バー 

スイープ進行状態バーは、掃引が遅い（2 秒より遅い）

場合に掃引の進行状況を表示します。 

情報アイコンの概要 
 

3G アダプタ 
 

3G アダプタが装着されオン状態を表

示します。 

デモキット 
 

デモキットが装着されオン状態を表示

します。 

プリアンプ プリアンプがオン状態を表示します。 

AC  AC 電源で動作中を表示します。 

AC 充電 
 

AC 電源でバッテリーの充電中を表示

します。 

アラーム オフ アラームブザー出力が現在オフです。
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アラーム オン アラームブザー出力が現在オンです。 

振幅オフセット 
 

振幅シフトが有効であることを表示し

ます。このアイコンは振幅関連の機能

が使用されているとき表示されます： 

リファレンスレベルオフセット 

振幅補正 

Input Z = 75Ωと Input Z cal >0 

バッテリー表示 
 ~  

バッテリーの充電状況を表示します。

BW 設定表示 
 

RBW または VBW 設定が手動モード

のとき表示されます。 

Average 平均機能が有効なとき表示します。 

外部ロック 
 

システムが現在ロックされ外部リファレ

ンス入力信号をリファレンスクロックに

していることを表示します。 

外部トリガ 
 

外部トリガ信号で使用していることを

表示しています。 

演算 
 

トレース演算の使用中を表示していま

す。 

シーケンス表示 
 

シーケンスの実行中を表示していま

す。 

スイープ表示 
 

スイープ時間が手動設定中を表示し

ています。 

トラッキング 

ジェネレータ  
トラッキング·ジェネレータがオンになっ

ていることを表示しています。 
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TG ノーマライズ 
 

トラッキングジェネレータがノーマライ

ズされていることを表示しています。 

Wake-up clock 
 

自動起動クロックがオンになっている

ことを表示します。 

USB 
 

USB フラッシュドライブが、前面パネル

に挿入され、認識されていることを表

示します。 

Micro SD 
 

マイクロ SD カードが前面パネルに挿

入され、認識されていることを表示しま

す。 
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先ず初めに 
本器を初めて使用する場合の手順として、先ず（必要な場合は、別売

のバッテリーパックを挿入して）チルトスタンド（足）の引き起こし、時計

の設定、必要な場合は、Wake-Up クロック、ファームウェアを更新して

デフォルト設定にしてください。 

本章後半の表記セクションでは、ユーザーマニュアル全体で使用される

基本的な操作の規則を紹介します。 

チルトスタンドを使用する 
 

概要 本器は、機器の接地で 2 つの状態に調節可能な

ゴム脚（2 個）があります。  

直立 機器を直立に立てるに

は、本体底面へゴム足

を押し込んでください。

傾斜 本器を斜めで使用する

場合、本体底面のゴム

足を持って後方（背面）

へ回転するように回し

てください。 
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別売のバッテリーパックを挿入する 
 

概要 本器は、別売のバッテリーパックを挿入することで

AC 電源なしに使用できます。 

バッテリーパックを使用する場合には、電源コード

を AC 電源ソケットに接続する前にバッテリーパッ

クを挿入してください。  

手順 1. 電源がオフで本器から AC 電源コードが外してあ

ることを確認してください。 

 2. 背面下部のバッテリーカバーを外します。 

 3. 下図の様にバッテリーのコネクタを本体内のバッテ

リー用コネクタを挿入してバッテリーを挿入します。

 4. バッテリーカバーを戻します。 

アイコン表示 
  

本器がバッテリーで動作するとバッテリー

アイコンが表示されます。 

バッテリー 

取り付け図 カバー固定用ツメ

コネクタ
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電源をオンする 
 

手順 1. AC 電源コードを電源ソケットへ挿入する。 

 2. 電源ボタンが青色に点灯し本器がスタンバイ 

モードになったことを表示します。 

 

 3. 電源ボタンを長押し（数秒程度）すると電源がオン

になります。 

 4. 電源ボタンがオレンジ色に変わり本器は起動開始

します。 

 

 注意 
本器の起動には 1 分程度かかります。 

起動中は画面に XX％と表示されています。 

電源をオフする 
 

概要 本器の電源オフ処理には、通常の終了と強制終

了の 2 種類があります。 

通常の電源オフでは、システム情報と最後に実行

中の処理を保存します。次回、本器を起動したとき

最後に保存された状態で起動します。 

（起動の設定条件が LAST の場合） 

強制的にパワーダウンした場合、最小の情報のみ

保存します。  

通常の電源オフ 電源ボタンを押します。システムは、自動的に以下

の順序でパワーダウン処理を処理します。 
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システム情報を保存 

未処理のプロセスを順次閉じていきます 

LCD バックライトをオフにします 

システムはスタンバイモードに入ります（電

源ボタンがオレンジ色から青色に変わりま

す）  

 注意 
終了処理には、10 秒程度かかります。 

強制終了 システムがオフになるまで 4 秒ほど電源ボタンを

押します。電源ボタン LED が青色に変わります。 

 注意 
強制終了をした場合、次回起動時にシステム 

チェックのため通常より起動時間がかかります。 

日付、時間と起動（ウェイクアップ）クロックを設定する 
 

概要 本器は、ウェイクアップクロック機能を使用すること

で自動的に電源オンする曜日と時間を設定するこ

とができます。この機能は、機器を使用前に自動

で起動しウオームアップ待ち時間を短縮するのに

役立ちます。 
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システム日付 例：システム日付を 2016 年 7 月 1 日に設定しま

す。 

1. >Date/Time[F4]>Set Date[F1]>Year[F1].の
順で押します。 

2. 2016>Enter[F1].の順で入力します。 

3. Month[F2]>7>Enter[F1].の順で入力します。 

4. Day[F3]>1>Enter[F1].の順で入力します。 

5. Return[F7].を押し確定します。 

 注意 
システム日付は画面上部に表示されます。 

システム時間 例：システム時間を AM9:00 に設定します。 

1. >Date/Time[F4]>Set Time[F2]>Hour[F1].の
順で押します。 

2. 9>Enter[F1].の順で入力します。 

3. Minute[F2]>0>Enter[F1]. の順で入力します。 

4. Second[F3]>0>Enter[F1]. の順で入力します。 

5. Return[F7]. を押し確定します。 

 注意 
システム時間は、画面上部に表示されます。 
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システム起動時間 例：本器の起動時間を AM9:00 に設定します。 

1. >Date/Time[F4]>Wake-Up 
Clock[F3]>Select Clock[F1].の順で押します。 

2. Clock 1[F1] ～ Clock 7[F7] から Clock1 から

Clock7 のいずれかを選択します。 

3. State[F2] でウェイクアップクロックのオンまたはオ

フします。 

4. Hour[F3]>9>Enter[F1].の順で入力します。 

5. Minute[F4]>0>Enter[F1]. の順で入力します。 

6. [F5] を押し Rept. (繰り返し)または Single.（単独）

を選択します。 

7. Select Date[F6] で月曜から日曜までの曜日を選

択します。 

8. Return[F7] を押しウェイクアップクロック設定を確

定します。 

 注意 
システム時間は、時計用電池（CR2032）で保持さ

れています。もし、システム時間とウェイクアップク

ロックが保持されなくなったら時計用電池を交換し

てください。 

詳細は、284 ページを参照ください。 

ファームウェアの更新 
 

概要 本器のファームウェアは、お客様で更新することが

可能です。最新のファームウェアについては、弊社

ウェブサイトまたは弊社にお問い合わせください。 
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システムバージョ

ンの確認 

ファームウェアを更新する前に、ファームウェアの

バージョンを確認してください。 

 1. >System Information[F1].の順で押します。 

2. 画面にシステム情報一覧が表示されます。 

一覧にファームウェアのバージョンが表示されてい

ます。 

 

 

 3. システム情報の画面から戻るには、他キー（メイン

/コントロール/ファイル/マーカ/補助キー等）を押

してください。 

 4. ファームウェアをアップグレードするには、USB 

フラッシュドライブまたはマイクロ SD カードの 

ルートディレクトリに新しいファームウェアフォルダ

「gsp932」を保存し、前面パネルの適切なポートに

ドライブ/カードを挿入します。 

USB（またはマイクロ SD カード）を挿入され認識さ

れると画面下にアイコンが表示されます。 

 

注意：ファームウェアファイルは、フォルダ名

「gsp932」という名前のディレクトリに保存されてい

る必要があります。 
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 5. >More 1/2[F7]>Upgrade[F2].の順で押しま

す。 

 6. 本器は、自動的に USB フラッシュドライブ（または

マイクロ SD カード）上のファームウェアを見つけ、

ファームウェアの更新を開始します。 

更新が終了すると、画面下部に“Upgrade is 

finished”が表示され続いて“Rebooting”が表示さ

れます。 

 7. “Rebooting”が表示されたあとシステムは自動的

に再起動します。 

 注意 
アップグレードの実行には数分かかります。 

初期設定に戻す 
 

概要 前面パネルの Preset キーで工場出荷時設定また

はユーザー定義プリセットへ簡単に戻せます。 

出荷時の初期値は、工場出荷時の設定です。 

プリセット設定の設定方法については、119.ページ

を参照ください。  

手順 1. キーを押します。 

2. 本器は、指定されたプリセット設定の状態になりま

す。  
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表記について 

以下の表記はマニュアル全体で使用されています。  

本器のメニューシステムとフロントパネルキーの操作方法についての基

本的な知識については、以下の表記をお読みください。  
 

ソフトメニューキー 画面枠右側の F1 から F7 ファンクションキーは、そ

の左側のソフトメニューキーに直接対応していま

す。 

LOCAL

CONTROL

F IL E A U X IL IA RY

Frequency

Autoset

Amplitude

Span

BW /AVG

Display

Trace

Sweep

Measure

Trigger

File

Recall

Save

Peak

Marker

Marker

System

Preset

Search

Quick

Save

EMC
Pretest

7

4

1

0

8

5

2

9

6

3

/ Enter

BK SP

Sweep

Mode

Limit

L ine

Sequence

Opt ion

Con trol

Fas t/

Normal

F 4

F 3

F 2

F 1

F 6

F 5

F 7

RF INPUT 50

REV PWR + 30 dBm

TG OUTPUT 50 � �500 mA MAX .

DC 7 V

OUTPUT + 30 dBm MAX .

MAX.DC ±50 V MAX.DC ±50 V

9ｋHz-3.25GHz
Spectrum AnalyzerGSP-9330

M A R K E R

ソフトメニューキー

F1 ~ F7 ファンクションキー

 

パラメータ値の入

力 

 
 

このタイプのメニューキーを選択すると、テンキー

で新しい値を入力するかスクロールノブでパラメー

タ値の増減ができるようになります。 

状態の切り替え 

 
 

このメニューキーを押すと選択した機能の状態を

切り替えることができます。 
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状態の切り替えと

パラメータの入力 

 

このメニューキーを押すと、機能を Auto（自動）ま

たは Man(ual)（手動）を切り替えることができます。

手動では、パラメータ値を手動で編集できます。 

テンキーで新しい値を入力するか、スクロールノブ

で現在の値を増減することができます。 

サブメニュー 

 
 

 このタイプのメニューキーを押すとサブメニューに

移動します。 

パラメータを選択

するためのサブ 

メニュー 
 

 

このタイプのメニューキーを押すとパラメータを選

択するためのサブメニューに移動します。 

機能を有効にする

 
 

このタイプのメニューキーを押すと、その機能が有

効になります。メニューキーは、機能が有効である

ことを示すために強調表示されます。 
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パラメータの入力

LOCAL

Preset

Quick
Save

7

4

1

0

8

5

2

9

6

3

/ Enter

BK SP

テンキー
スクロールノブ

矢印キーバックスペース
Enterキー

 
 

パラメータの値は、テンキー、スクロールノブと時

には矢印キーを使用し入力することができます。 

テンキーを使う パラメータの入力が必要な場合、テンキー（0～

9）、小数点キー（．）と符号キー（+/-）で値を入力し

ます。値を入力した後、ソフトメニューキーで単位

を選択することができます。 

パラメータの値が画面下部に示され、編集可能に

なります。値には、整数以外にも実数のための小

数点または IP アドレスためのドット区切り表記を

入力することができます。 

 

バックスペース 

一文字空白 

入力した最後の文字または数字を削除するには、

バックスペースキーを使用してください。 

編集パラメータ 



  GSP-9330 ユーザーマニュアル 

36 

スクロールノブを

使用する 

現在の値を変更するには、スクロールノブを使用し

ます。 

時計回りは値が増加し、反時計回りは値が減少し

ます。 

方向矢印キー 個別のパラメータを選択するか、スクロールノブよ

りも粗い分解能で値を変更する場合に方向矢印キ

ーを使用します。 

左矢印キーは値が減少し、右矢印キーは値が増

加します。 
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周波数の設定 

センター周波数 
 

概要 センター周波数機能は、センター周波数を設定し 

センター周波数を画面中央に表示します。 

操作 1. >Center[F1] の順に押し、周波数と単位を

入力します。 

 範囲： 

分解能： 

初期値： 

0kHz～3.25GHz  

1Hz 

1.625GHz 

画面 センター周波数

センター周波数を設定

スタートとストップ周波数 
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説明 スタート/ストップ周波数機能は、スパンのスタート

周波数とストップ周波数を設定します。スタート周

波数は画面左、ストップ周波数は画面右に表示さ

れます。 

操作 1. スタート周波数を設定するには、 > Start 
Freq[F2] の順で押し周波数と単位を入力します。 

2. ストップ周波数を設定するには、 > Stop 
Freq[F3] の順で押し周波数と単位を入力します。 

 範囲： 

分解能： 

スタートの初期値： 

ストップの初期値： 

0kHz～3.25GHz 

1Hz 

0Hz 

3.25GHz 

画面 スタート周波数

スタート周波数 ストップ周波数

ストップ周波数

 

 注意 
スパン設定を変更すると、スタート/ストップ周波数

が変わります。 

ストップ周波数は、スタート周波数よりも高く設定す

る必要があります。（スパン≠0）、それ以外の場合

はスパンを自動的に 100Hz に設定されます。  
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センター周波数ステップ 
 

概要 CF ステップ機能は、矢印キーまたはスクロールノ

ブを使用した時のセンター周波数のステップサイズ

を設定します。 

センター周波数を変更するためにスクロールノブま

たは矢印キーを使用する場合、それぞれを回した

（または押した）とき、CF ステップ機能で指定したス

テップサイズ分だけセンター周波数を移動します。

自動モードでは、センター周波数のステップサイズ

は、スパンの 10％（1div：1 目盛）です。 

操作 1. > CF Step[F4] を押し、CF ステップを

Auto(自動)または Man(手動)に切り替えます。 

2. 手動（Man）を選択した場合、センター周波数のステ

ップサイズの周波数と単位を設定します。 

 手動範囲（Man）： 

自動範囲（Auto）： 

0Hz～3.25GHz 

スパン周波数の 1/10  

画面 

 

 

CF ステップ周波数 
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周波数オフセット 
 

概要 FREQ オフセット機能は、センター周波数、スタート

/ストップ周波数とマーカ周波数にオフセットを追加

しできます。 

オフセット値は、画面上のトレース表示に影響しま

せん。 

操作 1. >Freq Offset[F5] を押しオフセット値を設定

します。 

センター周波数、スタート/ストップ周波数とマーカ

周波数がそれに応じて変更されます。 

 オフセット周波数範囲： 0Hz～100MGHz 

画面 

周波数オフセット 
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Span の設定 

Span 
 

概要 Span 機能は、スイープの周波数範囲を設定しま

す。スイープはセンター周波数を中心に設定されま

す。 

 

Span を設定すると、スタート周波数とストップ周波

数の両方が設定されます。 

操作 1. > Span[F1] を押し、Span の周波数と単位を

入力します。 

 範囲： 

分解能： 

Span の初期値： 

0kHz～3.25GHz 

1Hz 

3.25GHz 

画面 Span

Span設定

フルスパン：Full Span 
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概要 フルスパン機能は、スパンを全周波数レンジに設

定します。 

 

この機能は、スタート周波数を 0Hz、ストップ周波数

を 3GHz に設定します。 

操作 1. > Full Span[F2].の順で押します。 

ゼロスパン：Zero Span 
 

概要 ゼロスパン機能は、スイープの周波数レンジを 0Hz

に設定しスタート周波数とストップ周波数をセンタ

ー周波数に固定します。 

ゼロスパン機能は、センター周波数における入力

信号の時間ドメイン特性を測定します。水平軸は、

時間ドメインを表示します。 

操作 1. > Zero Span[F3].の順で押します。 

 

Span 範囲が変更されます。 

画面 時間ドメイン

0Hz Span
 

例：AM 変調信号 
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 注意 
TOI、SEM、CNR、CTB、CSO、ACPR、OCBW、位相

ジッタ、ハーモニクス、NdB、P1dB および他の測定

機能など測定機能では、ゼロスパン設定は使用で

きません。 

Last Span 
 

概要 ラストスパン機能は、直前のスパン設定に戻しま

す。 

操作 1. > Last Span[F4].の順で押します。 

振幅設定 
垂直表示スケールは、リファレンスレベル振幅、アッテネータ、スケール

と外部ゲイン/ロスで定義されます。 

リファレンスレベル 
 

概要 リファレンスレベルは、電圧または電力で目盛上端

の振幅絶対レベルを定義します。 

操作 1. > Ref Level[F1] を押し、リファレンスレベル

の振幅値と単位を入力します。 

 範囲： 

単位： 

分解能： 

-120dBm～30dBm  

dBm, -dBm, W, V, dBV  

1dBm 
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画面 リファレンスレベル位置Refレベル表示

アッテネータ 
 

操作 入力信号レベルの減衰量は、Auto(自動設定）また

は Man(手動設定)を切り換えることができます。 

アッテネータが Man に設定されている場合、手動

で入力アッテネータを 1dB ステップで変更できま

す。  

操作 1. > Attenuation[F2] を押し、Auto または Man

を選択します。 

2. Man（手動）に設定した場合には、アッテネータのレ

ベルと単位を入力します。 

 範囲： 

単位： 

分解能： 

0dBm～50dBm 

dBm 

1dB 
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画面 

Scale/Div 
 

概要 スケールがログに設定されているとき、垂直軸の

目盛(div)はログ（対数）単位に設定されます。 

操作 1. > Scale/Div[F3] を押し、垂直目盛の単位を

選択します。 

 単位の範囲： 10, 5, 2, 1 

画面 

 注意 
Scale/Div 機能は、スケールがログ（対数）に設定

されているときのみ選択可能です。 

オートスケール：Auto Scale 
 

概要 オートスケール機能は、スペクトラム表示が最適に

なるように自動的にスケール/div、リファレンスレベ

ルとアッテネータ（オート設定の場合）を設定しま

す。 

アッテネータレベル 

スケール 
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操作 1. > Auto Scale[F4] を押しオートスケールをオ

ンにします。 

 注意 
この機能は、リニアおよびログスケールどちらでも

設定可能です。 

スケールの種類 
 

概要 垂直スケールの単位をリニアまたはログに設定し

ます。 

初期値は、リニアスケールが電圧、ログスケールが

dBm に設定されています。 

操作 1. > More[F7] > Scale Type[F2] の順に押し、

垂直スケールをリニアまたはログに設定します。 

 注意 
単位スケールを変更（例えば、dBm を Volts）したと

き、表示された垂直スケールの種類は設定された

ログまたはログ設定のままになります。 

スケール表示 
 

概要 スケール機能は、垂直スケールのオン/オフを切り

換えます。各目盛の値は、リファレンスレベルの設

定で使用されるのと同じ単位で表示します。 

操作 1. > Scale[F5] の順で押し、スケール表示のオ

ン/オフを切り替えます。  

2. Scale Pos.[F6] の順で押し、スケール表示の位置

を切り替えます。 

 スケール位置： Left, Center, Right 
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画面 

Scale 
Left

 
初期設定の垂直スケールの表示位置は、画面左

側です。 

垂直スケールの単位 
 

概要 リニアまたはログスケールの垂直スケール単位を

変更します。 

操作 1. > More[F7]>Y Axis[F1] の順で押し、単位を

選択します。  

2. F1 から F5 から単位を選択します。 

 単位： dBm, dBmV, dBuV, Watts, 

Volts 
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リファレンスレベルのオフセット 
 

概要 リファレンスレベルオフセット機能は、外部ネットワ

ークまたはデバイスからの損失やゲイン（利得）を

補正するためにリファレンスレベルにオフセット値を

設定します。  

オフセット値は、入力アッテネーションや画面上のト

レースに影響しません。 

この設定により、リファレンスレベル、スケールおよ

びマーカーのリードアウトが変更されます。 

操作 1. > More[F7]>RefLvlOffset[F4] の順で押し、

オフセットレベルと単位を設定します。  

2. オフセットレベルを解除するには、リファレンスオフ

セットを 0dB に設定します。 

 範囲： 0dB～50dB 

画面アイコン 
  

オフセットレベルを設定すると画面下に

AMP アイコンが表示されます。 

例： 

 

 
リファレンスレベルオフセット設定前 

（オフセット 0dB） 
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リファレンスレベル設定後（オフセット：10dB） 

振幅補正 
 

概要 振幅補正は、指定した周波数で振幅を変えること

で本器の周波数応答を調整します。 

この機能により、本器の特定周波数での外部ネット

ワークまたはデバイスの損失またはゲインを補正

することができます。  

範囲 補正セット： 5 セット、30 ポイント/セット

振幅： -40dB～+40dB 

振幅分解能： 0.1dB 

周波数範囲： 9kHz～3.25GHz 

周波数分解能： 1Hz 
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表示 補正ポイント

元の波形

補正後の
出力

 
例：上図は、特定の周波数における損失または利

得を補正する振幅補正方法を示しています。 

補正セットを作成する 
 

概要 本器は、補正セットを 5 個まで作成および編集する

ことができます。 

補正セットの補正ポイントと値は、簡単に操作でき

るように一覧表になっています。  

操作 1. > More[F7]>Correction[F3]> Select 
Correction[F1] の順で押し、編集または作成する

補正セット（F1 から F5）を選択します。 

 補正セット： 1～5 
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 2. Edit[F3].を押します。 

 

画面が、2 分割表示になります。 

画面上部に波形を表示し、画面下部に、補正ポイ

ント入力を表示します。 

スペクトラム表示

補正ポイント

選択ポイントの
周波数

 3. Point Num[F1] を押し編集するポイント番号を入力

します。ポイント番号は、番号順でのみ作成されま

す。 

例えば、Num2 ポイントは、Num1 ポイントを作成し

た後でしか選択することができません。同様に、

Num3 ポイントは、Num2 ポイントを作成された後で

のみ選択できます。 

 ポイント番号 Num： 1～20 

 4. Frequency[F2] を押し選択したポイントの周波数を

入力します。 

 5. Gain Offset[F3] を押し、選択したポイントの振幅を

入力します。 
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単位は、垂直軸スケールに使用しているものと同じ

です。  

 

選択したポイントの周波数が画面下部の補正テー

ブルに表示されます。 

Correction Table

 6. ステップ 3 から 5 を繰り返して、その他の補正ポイ

ントも設定します。 

7. 選択したポイントを削除する場合は Delete 
Point[F6].を押します。 

8. Return[F7]>Save Correction[F5] を押し補正セット

を保存します。 

 注意 
補正ポイントは、自動的に周波数順に並べ替えら

れますのでご注意ください（低→高）。 

補正セットをオンする前に必ず保存してください。 

 

補正テーブルに表示された周波数の値は、画面表

示用として値を切り捨て捨てて表示されています。 

各ポイントの実際の周波数は、周波数ソフトキーで

確認できます。  

振幅補正のオン/オフ 
 

概要 5 個の補正セットのいずれかを 1 つをオンすること

ができます。 

補正テーブル 
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補正を有効にす

る 
1. > More[F7]>Correction[F3]> Correction 

Set[F1] を押し、F1～F5 から補正セットを選択しま

す。 

補正セット： 1～5 

2. Correction[F2] を押し補正セットをオンにします。 

補正セットを無効

にする 
1. > More[F7]>Correction[F3]> Correction[F2] 

を押し補正をオフしもとに戻します 

補正セットの削除 
 

操作 1. > More[F7]>Correction[F3]> Correction 
Set[F1] の順に押し、削除する補正セットを F1～F5

から選択します。 

 補正セット： 1～5 

 2. Delete Correction[F6].の順で押し、削除します。 

 

補正セットをメモリへ保存します。 
 

操作 1. > Save To[F1] を押し保存場所を選択しま

す。  

 保存場所： Register1～6, Local, USB, 

SD 

 2. Type[F2]> Correction[F5].の順で押し補正セットを

選択します。 

3. Data Source[F3] を押し、保存する補正セット番号

を（F1～F5）を選択します。 
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 補正セット Correction 1～5 

 4. ファイル名を付ける場合 Name[F5].を
押します。 

以下に示すように、F1～F7 

キーを使って選択したファイルに名前

を付けたり、数値を入力するのにテン

キーを使用します。 

 

 
制約次項： 

空白文字（スペース）なし 

使用可能な文字：英数 1～9, A～Z, a～z のみ 

  

5. 入力中のファイル名は、画面下に表示されていま

す。 

 

  

 を押し、作成したファイル名を確定します。 

ファイル名 
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 注意 
ファイル名を変更しない場合、ファイル名は自動的

に以下の形式で作成されます： 

ファイル名： 

データの種類 ソースファイル番号 拡張子 

例： Correction1_0.cor 

ファイル番号のパラメータは、同じファイルタイプが

作成されるたびに増加します。 

 

 

 

6. Save Now[F7].を押し、保存を実行します。 

7. 補正セットは、選択した場所（保存場所）に保存さ

れます。 

保存/呼出の詳細については、260 ページを参照し

てください。 

補正セットをメモリから呼び出す 
 

操作 1. > Recall[F1] を押し、呼出す場所を F1～F4

から選択します： 

 呼び出す場所： Register1～6, Local, USB, 

micro SD 

 2. Type[F2]> Correction[F5].の順に押します。 

3. スクロールノブを使用してファイルディレクトリから

保存されている補正セットから選択してください。 

4. Destination[F3] を押し、呼出先の補正セット（F1～

F5）を選択します。 

 呼出先の補正セット： Correction 1～5 
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 5. Recall Now[F4].を押し、呼出を実行します。 

6. 指定した補正セットへ選択した補正セットが呼び出

されます。保存/呼出の詳細については、260 ペー

ジを参照してください。 

入力いピーダンス 
 

概要 入力インピーダンスを 75Ωまたは 50Ωから選択しま

す。 

操作 1. > More[F7]> More[F7] > Input Z[F1] の順で

押し、入力インピーダンスを切り替えます。 

 範囲： 75Ω, 50Ω 

入力インピーダンスの補正 
 

概要 入力インピーダンスを 50Ωから 75Ωに変換するた

めに、外付けのインピーダンス変換アダプタ（オプ

ションアクセサリ：ADP-101）を使用したとき、外部

損失が発生します。入力 Z Cal 機能は、オフセット

値で、この損失を補償するために使用します。 

初期値は、ADP-101 を使用した場合の値（6.000ｄ

B）に設定されています。 

 注意 
入力 Z Cal 機能は、入力インピーダンスの設定を

75Ωにしたときにのみ有効です。 

操作 1. > More[F7]>More[F7]>Input Z Cal[F2] の順

で押しインピーダンスオフセット値を設定します。 

 範囲： 

分解能： 

0dB～ +10dB 

1dB 
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表示アイコン n 
  

入力 Z Cal≠0dB と入力 Z=75Ωのとき、画

面下部に AMP アイコンが表示されます。 

内蔵プリアンプを使用する 
 

説明 内蔵プリアンプは、周波数範囲全体にわたって、

EMI テスト信号のような微弱な入力信号を扱いや

すいレベルまでブーストします。 

内蔵プリアンプのゲインは、20dB（公称値）です。 

 

オート設定のとき、プリアンプはリファレンスレベル

が-30dB 以下で自動的にオンになり、リファレンス

レベルが-30dBm よりも大きい場合には、プリアン

プがオフになります。 

バイパス設定は、リファレンスレベルの設定に関係

なくプリアンプをオフにします。 

操作 1. > More[F7]>Preamp[F5] を押し、プリアンプ

の設定を切り換えます。  

 範囲： Auto, Bypass 

画面アイコン プリアンプがオンになると、プリアンプアイ

コンが画面に表示されます。 
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例： 

プリアンプアイコン
 

 

 注意 
プリアンプをオンにすると、アッテネータ設定が

Auto のときは、0dB（例：減衰=0dB）に固定されま

す。 
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Autoset 
Autoset 機能は、2 段階（フルスパンとスパンを 0Hz～100MHz に限定）

でピーク信号を検索し、最大振幅を持つ信号ピークを選択し画面に表

示します。 

Autoset を使用する 
 

操作 1. > Autoset[F1].を押します。 

Autoset の範囲 振幅： 

Span: 

-80dBm～+20dBm 

0Hz～3.25GHz 

例： 

 
Autoset 実行前 

 
Autoset 実行後 



 Autoset の垂直サーチ範囲を制限する 
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 注意 
Autoset 機能を実行すると RBW、VBW とスイープ

設定がリセットされ Auto になります。 

Autoset の垂直サーチ範囲を制限する 
 

概要 設定より低い信号をオートセット検索で無視するよ

うに、振幅フロアを設定することができます。 

操作 1. > Amp.Floor[F2] を押し、Auto（自動）と

Man(手動)を切り換えます。 

2. Autoset サーチ範囲の振幅と単位を入力します。 

 範囲： −60dBm～+20dBm 

 注意 
振幅単位の設定は、48 ページを参照ください。 

Autoset の水平サーチ範囲を制限する 
 

説明 Autoset を実行したとき、より良好な表示になるよう

に周波数スパンを制限することができます。 

初期設定では、Autoset 実行後の Span は、3MHz

に設定されています。 

操作 1. > Span[F3] を押し、Auto と Man を切り換え

ます。  

2. Autoset サーチのための Span 周波数を入力しま

す。 

 手動設定範囲： 100Hz～3.25GHz  



  GSP-9330 ユーザーマニュアル 

64 

Bandwidth/Average 設定 
BW/AVG キーは、分解能帯域幅（RBW）、ビデオ帯域幅（VBW）と平均

機能の設定メニューを表示します。 

分解能、スイープ時間と平均の設定は 、トレードオフの関係にあるため

設定に注意する必要があります。 

分解能帯域幅（RBW）の設定 
 

概要 RBW (分解能帯域幅：Resolution Bandwidth)は、近

接する信号ピークを分離する IF（中間周波数：

Intermediate Frequency)フィルタの帯域幅の設定を

します。 

RBW の設定帯域が狭いほど、近接する周波数の

信号を分離する能力が大きくなります。 

しかし、RBW 設定を狭くすると同じ周波数スパン設

定でも掃引時間がより長くなります。 （表示更新が

頻繁にはされません） 

SPAN と RBW 

Auto 設定の関係 

RBW を Auto に設定すると、RBW は周波数スパン

によって自動的に設定されます。 

設定状態を、以下の表に示します。 

  

Auto モードにお

ける SPAN-RBW 

の関係 

Span (Hz)≦ RBW (Hz) Span (Hz)≦ RBW (Hz) 

 200 1 650k 3.0k 

 650 3 2M 10k 

 2k 10 6.5M 30k 

 6.5k 30 20M 100k 

 20k 100 65M 300k 

 200k 1k 200M 1M 
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操作 1. > RBW[F1] を押し、RBW を Auto または

Man に設定します。 

2. Man モードでは、分解能帯域幅と単位を設定しま

す。  

 モード： 

周波数範囲(-3dB)： 

 

周波数範囲(-6dB)： 

Auto または Man 

1Hz～1MHz (1-3-10 step) 

 

200Hz, 9kHz, 120kHz, 

1MHz 

 注意 
設定が Auto モードの場合、スクロールノブまたは

矢印キーでも RBW を手動モードに切り替えできま

す。 

アイコン表示 
  

RBW が Man モードの場合、BW アイコンが

画面下部に表示されています。 

 注意 
画面下の RBW 表示の後ろにアスタリスク（*）があ

る場合の場合、EMI（-6dB）フィルタを使用している

ことを示しています。 

ビデオ帯域幅の設定(VBW) 
 

概要 VBW（ビデオ帯域幅）は、検波後の帯域幅を決めま

す。（画面上のトレースの滑らかさを決めます。） 

RBW と組み合わせ、VBW は周辺ノイズや隣接ピー

クから目的の信号を選択する機能を定義していま

す。 

操作 1. > VBW[F2] 押し、VBW を Auto または Man

に設定します。. 

2. Man モードでは、ビデオ帯域周波数と単位を設定し

ます。 
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 モード： 

周波数範囲(-3dB): 

Auto または Man 

1Hz～1MHz (1-3-10 step)

アイコン表示 
  

VBW が Man モードのとき、BW アイコンが

画面下に表示されています。 

VBW/RBW レシオ 
 

概要 VBW/ RBW 機能は、ビデオ帯域幅（VBW と分解能

帯域幅（RBW）との比率を表示します。 

VBW/ RBW 比は、VBW を設定したり RBW を設定

したりすることによって変更されます。それぞれの

設定については 64 ページと 65 ページを参照してく

ださい。 

VBW/RBW レシオ

を見る 
1. .を押します 

2. VBW/RBW[F3] キーにレシオが表示されています。

表示 

ヒント 

ノイズフロアレベルによってマスクされた信号は、 

ノイズを平滑化するために、比率を 1 未満で使用

する必要があります。 

 

強い周波数成分の信号では、比率を 1 以上で使用

する必要があります。 

トレース平均：Average Trace 
 

VBW/RBW レシオ 



 トレース平均：Average Trace 
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概要 平均機能は、トレースを表示する前に設定された

回数トレースを平均します。 

この機能は、ノイズレベルを平滑化しますが、平均

回数により表示の更新速度が遅くなります。 

操作 1. > Average[F4] を押し平均のオン/オフを切

り替えます。 

2. 平均回数を設定します。 

 平均回数： 

初期値： 

4～200 回 

20 

アイコン表示 
  

平均機能がオンになると AVG アイコンが

画面下に表示されます。 
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例: 

 
平均：オフ 

 

平均化した
トレースの回数を表示

 
平均：オン (20) 

平均の種類 
 



 EMI フィルタ 
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説明 平均機能には、3 種類があります。 

LOG 平均：ログスケールでトレースポイントを平均

します。 

電圧平均：リニア電圧スケールでトレースポイント

の電圧を平均します。 

電力平均：電力ログスケールでトレースポイントを

平均します。 

操作 1. > Average Type[F5] を押し、平均の種類を

選択します。  

 範囲： 

 

初期値： 

LOG Power, Volt Average, 

Power Average 

LOG Power 

EMI フィルタ 
 

概要 内蔵の EMI フィルタは、標準的な構成と比較して

感度の高いレベルが必要とされるような EMI 平均

ディテクタなど、特定の測定状況に使用します。 

EMI フィルタをオンにすると、RBW が EMI フィルタ

が-6dB に設定され画面の RBW 表示の後ろにアス

タリスク（*）が表示されます。 

測定機能がオンになると（詳細は 121 ページを参

照）、EMI フィルタは自動的に無効になる場合があ

ります。 （EMI プリテストを除く） 

逆に EMI フィルタをオンにした場合、測定機能がオ

フになる場合があります。 

操作 1. > EMI Filter[F6] を押し EMI フィルタのオン/

オフを切り替えます。  
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 注意 
EMI フィルタの仕様については、333 ページを参照

してください。 



 スイープ時間 
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スイープ 
本器には、スイープ実行モード（連続、シングル）、スイープモード（Fast、

Normal）、掃引時間設定などスイープのオプションがあります。 

また、ゲートスイープモードをサポートしています。 

スイープ時間 
 

概要 スイープ時間は、現在の周波数スパンで掃引する

時間のことです。 

注意：ただし、掃引時間と RBW/ VBW はトレードオ

フの関係になっています。 

より速いスイープ時間では、より頻繁に表示を更新

しますが、RBW と VBW が広くなり近接する周波数

の信号を分離する能力が減少します。 

操作 1. > Sweep Time[F1] を押し、スイープ時間設

定の Auto と Man を切り換えます。. 

2. Man モードの場合、スイープ時間を設定します。 

 モード： 

範囲： 

 

分解能： 

Auto, Man 

1.14ms～1000s (span=100Hz, 

RBW=3kHz) 

46.6µs～1000s (span=0Hz, 

RBW= 1MHz) 

アイコン表示 
  

スイープを手動モードにすると SWT アイコ

ンが表示されます。 

シングルスイープ 
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説明 本器には、シングルと連続の 2 種類のスイープ実

行モードがあります：。 

シングルモードは、一度だけスイープを実行し停止

します。 

操作 1. > Sweep Single[F2] を押しシングルスイープ

モードにします。 

2. Sweep Single[F2] をもう一度押すと、シングルスイ

ープを実行します。 

シングルスイープを実行し"停止したトレース”の周波

数、スパン、振幅などを変更することができます。  

アイコン表示 スイープをシングルモードにするとスイープ

シングルのアイコンが表示されます。 

 注意 
再度シングルスイープを実行するには、実行中の

シングルスイープが終了するのを待つ必要があり

ます。 

 

スイープ中に設定が変更された場合、直ちにシン

グルスイープをやり直します。 

連続スイープ 
 

概要 本器には、シングルと連続の 2 種類のスイープ実

行モードがあります。 

連続モードは、スイープを連続して実行し更新しま

す。 

操作 1. > Sweep Cont[F3] を押し、連続スイープ 

モードに設定します。  



 ゲートスイープの概要 
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アイコン表示 

 

スイープが連続モードのときに Sweep 

Cont アイコンが画面の右側に表示されて

います。 

 注意 
現在のモードをシングルスイープモードに変更する

か、またはシステムがトリガ条件待ちに変更されな

い限り、連続でスイープします。 

ゲートスイープの概要 
 

概要 ゲートスイープモードは、トリガ信号によりスイープ

を開始させるモードです。 

このモードは、RF バースト送信信号や伝送バース

ト間のスプリアスノイズレベル測定など、オン/オフ

パルスのような特徴的な信号の観測に有効です。

概要 1. トリガ信号は、入力信号の周期に同期している必

要があります（以下の RF バーストのように）。 

2. ゲート時間の開始は、トリガ信号の正または負のエ

ッジ+遅延時間で決まります。 

3. ゲート時間の終了は、ゲート長の設定で決まりま

す。 

4. ゲートスイープは、送信の両端に設定してはいけま

せん。 
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遅延時間 ゲート長

ゲート

トリガ信号

RFバースト信号

周期

例：上図は、入力トリガ、入力信号と入力信号に連

動したゲートスイープの位置関係を示しています。

 注意 
本機能を使用する場合、RBW のセトリング時間を

考慮してください。遅延時間をあまりにも短い設定

すると、RBW フィルタが解決するのに十分な時間

がないことがあります。 

ゲートスイープモードを使用する 
 

接続方法 1. トリガ信号(3.3V CMOS レベル)を背面パネルの

GATE IN 端子へ接続します。 

トリガ信号

 注意 
RBW の設定は、ゲートスイープモード機能を使用

可能にするために 10kHz 以上である必要がありま

す。  



 ゲートスイープモードを使用する 
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操作 1. > GateDelay[F5] の順で押し、ゲート遅延時

間を設定します。 

2. > Gated Length[F6] の順で押し、ゲート時

間長を設定します。 

3. > Gated Sweep[F4] の順で押しモードをオン

にします。 

 ゲート遅延： 

ゲート長： 

0s～1000s  

58µs～1000s 

表示アイコン ゲートスイープがオンになるとスイープゲ

ートアイコンが表示されます。 
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例： 下図の例は、ゲートスイープモードがオフのときの

FSK 変調信号スペクトラムです。 

 
 

下図の例は、同じ信号で希望する信号周波数の場

合のみスイープするようにゲートスイープをした場

合をのスペクトラムです。 

ゲートスイープ
アイコン

 注意 
ゲートスイープをオンする前に、最初にゲート遅延

とゲート長を必ず設定しておいてください。 

スイープコントロール/スイープモード 
 



 スイープコントロール/スイープモード 
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概要 スイープコントロール機能とスイープモード

キーは、スイープモードを Normal または Fast を切

り換えできます。 

Fast(高速)設定は、信号処理を高速化し全体の 

スイープ時間の画面更新レートを早くします。 

このモードは、Span が 1MHz より大きい場合に、特

に有効です。 

このときディテクタは、Sample に固定されます。 

Normal,に設定すると信号処理と更新レートはノー

マル状態になります。 

操作 1. > Sweep Control [F7] の順で押し、スイープ

モードを Fast または Norm（al）に切り替えます。 

または 

2.   を押しスイープモードを Fast または Norm
（al）に切り替えます。 

アイコン表示 スイープが Norm. または Fast. モードどち

に設定されてがは、画面右側にスイープ 

アイコンで表示されています。 

スイープ時間 センター周波数= 

1.625GHz 

スイープモード 

 Span(Hz) RBW (Hz)  

AUTO 

Norm. Fast 

 3.25G 1M 169ms 84.8ms 

 2G 1M 104ms 52.2ms 

 1G 1M 52ms 31.1ms 

 500M 1M 31ms 16.8ms 

 200M 1M 13.4ms 6.72ms 

 100M 1M 6.7ms 3.36ms 

 50M 300k 10.7ms 716µs 

 20M 100k 23.4ms 573µs 
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 10M 100k 11.7ms 286µs 

 5M 30k 28.9ms 655µs 

 2M 10k 101ms 1.96ms 

 1M 10k 50.9ms 1.31ms 

 500k 3k 6.88ms 6.88ms 

 200k 1k 22.9ms 22.9ms 

 100k 1k 9.83ms 9.83ms 

 50k 300 76.4ms 76.4ms 

 20k 100 219ms 219ms 

 10k 100 109ms 109ms 

 5k 30 710ms 710ms 

 2k 10 1.98s 1.98s 

 1k 10 994ms 994ms 

 500 3 2.65s 2.65s 

 200 1 2.65s 2.65s 

 100 1 2.65s 2.65s 
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トレース 
本器は、最大 4 つの異なるトレースを同時に画面へ表示でき各トレース

に別々のパラメータを設定できます。各トレースは、異なる色で表示さ

れ、各スイープで更新されます。 

トレースの選択 
 

説明 各トレース（1、2、3、4）は、それぞれ別の色で表示

されます。トレースが有効になると、画面の左側に

各トレース色と機能アイコンが表示されます。 

トレースを選択すると、トレースメニューから設定/

パラメータの編集できます。 

 トレースの色 1：黄色 

2：ピンク 

3：青 

4：オレンジ 

トレースの種類 使用するトレースの種類は、トレースデータを表示

する方法を決定します。本器は、選択されたトレー

スの種類に応じて各トレースを更新します。 

 Clear and 

Write 

スイープ毎に連続してトレース更

新をします。 

 Max Hold / 

Min Hold 

選択したトレースの最大または最

小ポイントを維持します。 

新たに最大または最少が見つか

るとトレースポイントを更新しま

す。また、最大ホールド設定に

は、しきい値設定ができます。こ

の設定は、しきい値を超えた値の

みを対象として保持するようにな

ります。 
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 View ビューは、選択したトレースの更

新を停止しトレース表示を保持し

ます。 

View[F5] を押すと、Blank[F6] を
押して非表示にしたトレースデー

タが表示されます。 

 Blank 選択したトレースを非表示（クリ

ア）にしますがトレースデータは保

存します。 

保存したトレースは、View[F5]. を
押すことで再表示できます 

表示アイコン 

例 

操作 1. > Trace[F1] の順で押し、トレース番号を選

択します。 

 トレース： 1, 2, 3, 4 

 2. トレースのタイプを選択します： 

 Clear & Write[F2] 
Max Hold[F3] 
Min Hold[F4] 
View[F5] 
Blank[F6] 
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 3. Max Hold[F3] を選択した場合には、しきい値を設

定します。 

初期値：-130dB 

 注意 
トレース 2、3、4 の初期値は Blank です。 

トレース演算 
 

概要 2 つのトレース（TR1、TR2）からトレース演算を実行

し、現在選択されているトレースに結果を保存しま

す。また、トレースシフトも実行できます。 

演算機能 Power Diff TR2 の振幅データから TR1 の振

幅データを減算します。 TR1 デー

タ、TR2 データはワットに変換さ

れ、結果は dBm に再変換されま

す。 

 Log Diff TR2 振幅データから TR1 振幅 

データを減算してから、対数リファ

レンスを加算します。 

TR1、TR2 のデータは dBm です。

減算結果のトレースは dB です。

結果が対数リファレンスに追加さ

れたとき、得られたデータは dBm

です。 

 LOG Offset リファレンスを TR1 のトレースへ

追加します。 

操作 1. > More[F1]>Trace Math[F1]. の順で押しま

す。 

 2. TR1[F1] を押し、第 1 トレースソースを Trace1～4

から選択します：  
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 TR1： Trace 1,2, 3, 4* 

 3. TR2[F2] を押し、第 2 トレースソースを Trace1～4

から選択します：  

 TR2： Trace 1, 2, 3, 4* 

 注意 
*現在選択しているトレースを TR1 または TR2 とし

て選択することはできません。 

現在のトレースは、 > Select Trace>[F1].で
選択されています。 

 4. トレース演算機能を選択します： 

 PowerDiff[F3] 
LogDiff[F4] 
LogOffset[F5] 

 

 5. LogDiff をした場合には、リファレンスレベルと単位

を設定します。 

 LogDiff ref 範囲： 

LogDiff ref 範囲： 

-120dBm～30dBm 

dBm, W 

 6. LogOffset を選択した場合、オフセットレベルと単位

を設定します。 

 LogOffset 範囲： -50dB～+50dB 

 7. トレース演算を解除するには OFF[F6].を押します。

アイコン表示 
 

トレース演算をオンすると Math アイコンが

表示されます。 

トレース検出モード 
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概要 本器は、毎回トレース上の各ポイントのデータをサ

ンプルし、サンプル数は、通常サンプルバケットと

呼ばれる各ポイントとして取得されます。各ポイント

の実際の値は、各バケット内のサンプルからディテ

クタ（検出器）によって決定されます。 

各トレース(1、2、3、4)は、異なる検出モードを使用

できます。 

検出モード Auto 全てのサンプルの値に基づき、自

動的に適切なモードを選択しま

す。 

 Normal 信号レベルが、常に増減している

あいだ、正のピークを検出しま

す。それ以外の場合、検出モード

を正のピークと負のピークを切り

換えます。 

過度のノイズを回避しながら、 

バースト現象を検出するのに有

効です。 

 Peak+ 各バケットから各ポイントに対す

る最大ピーク値を選択することで

正のピーク信号を検出します。 

このモードは、正弦波信号に有効

です。 

 Peak- 各バケットから各ポイントに対して

最小ピーク値を選択することで、

負のピーク信号を検出します。 

このモードは、振幅測定には適切

ではありません。 

 Sample バケットサンプルからランダムに

値を選択します。 

ノイズ信号に有効です。  
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 RMS 

Average 

サンプルバケット内のすべてのサ

ンプルの RMS 平均電力を計算し

ます。 

 EMI> 

Quasi-peak 

準先頭値検波器は、CISPR16-1-

1 規格で規定されるように、信号

の継続と繰返しレートで重み付け

されたピーク検出器です。 

準先頭値検波器は、急速充電時

間と低速減衰時間によって特徴

付けられます。 

 EMI> 

Average 

サンプルバケット内の全サンプル

の平均電力を計算します。 
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Auto 検出器の選

択方法 

以下は、自動モードでの検出器の選択手順を示す

フローチャート図です。 

 

Maxホールドに設定されている
トレースはありますか？

AverageSample

Peak+

Peak-

Normal

Y

N

Y

N

Y

N

N Y

位相ジッタ測定がオンに
なっていますか？ SampleY

N

トポグラフィックに設定されている
ウィンドウがありますか？ Peak+Y

N

検出器
(Autoモード)

（トレース）平均はオンですか？

平均のタイプは電力ですか？

Minホールドに設定されている
トレースはありますか？

 

操作 1. > More[F7]>Detection[F2]. の順に押しま

す。 

2. 選択したトレースのトレース検出モードを選択しま

す：  
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 Auto[F1] 
Normal[F2] 
Peak+[F3] 
Peak-[F4] 
Sample[F5] 
RMS Average[F6] 
EMI[F7]>Quasi-peak[F1] 
EMI[F7]>Average[F2] 

 

 

 3. 画面は前のメニューへ戻ります。 

アイコン表示 Normal 

アイコン 

Peak+ 

アイコン 

 Peak-  

アイコン 

Sample 

アイコン 

 RMS Average 

アイコン 

Quasi-peak 

アイコン 

 Average 

アイコン 
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トリガ 
トリガ機能は、本器が周波数、振幅および遅延などを含んだ波形を取

得するためのトリガ信号条件を設定します。 

デフォルトは内部信号を使用していますが、特別な条件に必要とされる

場合には、代わりに外部トリガ信号を使用できます。 

 

Free Run モード →87 ページから 

ビデオトリガを有効にする →87 ページから 

外部トリガを有効にする →89 ページから 

トリガモードを選択する →90 ページから 

トリガ遅延時間を設定する →90 ページから 

トリガのタイプを選択する 

フリーラン（Free Run）モード 
 

概要 フリーランモードでは、全ての信号がキャプチャさ

れトリガ条件を使用しません。 

Free Run モード 1. > Free Run[F1] の順で押し、Free モードに

します。 

ビデオトリガを有効にする 
 

概要 ビデオ信号用にビデオトリガレベルを設定します。

ビデオ信号の電圧レベルがビデオトリガレベルを

超えた*とき、トリガ信号が発生します。 

*ポジティブビデオエッジ 
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パラメータ ビデオエッジ: ビデオトリガの極性（Positive、

Negative）を決定します。 

 

Positive：信号電圧が、トリガ周波

数でビデオレベルを超えた信号。

 

Negative：信号電圧がトリガ周波

数でビデオレベルよりも小さい。 

 ビデオ 

レベル： 

トリガ電圧レベル 

 トリガ周波数 トリガを開始する周波数を設定し

ます。 

操作 1. >Trigger Condition[F2]>Video[F1] の順に押

します。 

 2. Video Edge[F1] を押しビデオエッジを選択します。

 範囲： Positive または Negative 

 3. Video Level[F2] を押し、ビデオ電圧レベルを設定

します。 

 トリガレベル：  (-120dBm～+30dBm) +Ref 

レベルオフセット 

 4. Trigger Freq[F3] を押し、本器が、トリガ条件をチェ

ックする周波数を選択します。 

 周波数範囲： 0～3.25GHz 

+周波数オフセット 

アイコン表示 ビデオトリガが有効になるとビデオレベルト

リガが表示されます。 
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 注意 
トリガをフリーランに設定するとビデオトリガを解除

します。 

外部トリガを有効にする 
 

概要 外部トリガは、背面パネルの TRIG IN 端子に外部

トリガ信号が入力されたとき使用できます。 

外部トリガ信号には、正または負のエッジを選択で

きます。 

 トリガ： 3.3V, CMOS 

操作 1. >Trigger Condition[F2]>Ext.Edge[F2] を押し

トリガのエッジ形式を選択します： 

 Pos: 
Neg: 

正のエッジ 

負のエッジ 

 2. 外部トリガ信号を背面パネルの TRIG IN 端子に接

続します。 

トリガ信号

 3. Action Now[F5] を押し、外部トリガを有効にしま

す。 

 4. 本器は、スイープ待ち状態となりトリガ条件が一致

するのを待ちます。 

アイコン表示 外部トリガが有効になると EXT トリガアイ

コンが表示されます。 
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 注意 
スパンまたは振幅設定などのパラメータ設定が変

更された場合、トリガはフリーランモードに戻りま

す。 

トリガモードを選択する 
 

概要 フリーランモードでは、全ての信号が取得されトリ

ガ条件は使用されません。 

モード Normal： トリガ条件に一致したすべての信号

を取得します。 

 Single： トリガ条件に一致した最初の信号の

みを取得します。 

 Continuous： トリガ条件に一致した最初の信号を

取得し、その後はフリーランモードに

なります。  

操作 1. > Trigger Mode[F3] の順で押し、手動でトリ

ガを開始します： 

 Nor.: 

Sgl.: 

Cont.: 

Normal 

Single 

Continuous 

 2. Action Now[F5] 押し、手動でトリガを開始します。 

アイコン表示 Normal: Single: Continuous: 

 

 

トリガ遅延時間の設定 
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概要 本器にトリガがかかり、信号を取得し始めるまでの

遅延時間を設定します。  

 遅延時間範囲：1ns～1000s 

操作 1. >Trigger Delay[F4] の順で押し、トリガ遅延

時間を設定します。 

 遅延範囲： 0～1000s 
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マーカ 
マーカは、波形ポイントの周波数と振幅を表示します。 本器は、最大 6

個のマーカまたは 6 組のマーカペア（リファレンスマーカ+デルタマーカ）

を同時に有効にできます。 

また、ピークマーカの場合はマーカテーブルに最大 10 個のピークマー

カを有効にすることができます。 

マーカテーブルは、1 つの画面内に複数のマーカ情報を表示し編集が

できます。 

デルタマーカは、リファレンスマーカに対する周波数と振幅の差を表示

しています。 

ピークサーチ機能は、自動的にピーク信号の検索、センター周波数、ス

タート/ストップ周波数を含むさまざまな場所にピークマーカを移動する

ことができます。信号ピークに関するその他のマーカ操作は、ピーク 

サーチ機能で利用できます。 

 

マーカを有効にする →92 ページから 

マーカを手動で移動する →93 ページから 

マーカをプリセット位置へ移動します。 →94 ページから 

デルタマーカを有効にする →95 ページから 

デルタマーカを手動で移動する →95 ページから 

マーカ機能 →96 ページから 

トレースへマーカを移動する →98 ページから 

一覧表（テーブル）でマーカを表示する →99 ページから 

ピークサーチ →100 ページから 

ピークサーチの設定 →103 ページから 

ピークテーブル →104 ページから 

マーカを有効にする 

マーカには、ノーマルマーカとデルタマーカの二種類の基本的なマーカ

があります。ノーマルマーカは、トレース上のポイントの周波数/時間ま

たは振幅を測定するために使用します。 
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デルタマーカは、リファレンスマーカのポイントとトレース上の選択した

ポイントとの周波数と振幅の差を測定するのに使用します。  

ノーマルマーカを有効にする 
 

操作 1. > Select Marker[F1] の順に押しマーカ番号

Maker1（F1）～6（F6）を選択します。a 

 マーカ： 1～6 

 2. [F2] を押し、選択したマーカをオンにします。 

3. Normal[F3] を押し、選択したマーカをノーマルタイ

プに設定します。 

4. 画面のトレース上にマーカが表示され（初期値は画

面中央）、画面上部にマーカ測定値（周波数、振

幅）が表示されます。 

5.

マーカ

Maker番号、周波数、振幅

 

マーカを手動で移動する 
 

操作 1. > Select Marker[F1] の順で押し、マーカ番

号 Maker1（F1）～Maker6（F6）を選択します。 
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 2. 左右矢印キーを使用すると 1 目盛

（1div）分マーカを移動できます。 

 3. スクロールノブを使用するとマーカを

少しずつ移動できます。 

 4. または、F1～F7 キーとテンキー組み

合わせて直接マーカ位置の周波数を

入力することができます。 

マーカをプリセット位置へ移動します。 
 

概要  キーで選択したマーカをプリセット位置へ移

動できます。 

機能 Mkr>Center: 

Mkr>Start: 

Mkr>Stop: 

Mkr>CF Step: 

Mkr>Ref Lvl: 

センター周波数へ移動します 

スタート周波数へ移動します 

ストップ周波数へ移動します 

ステップ周波数へ移動します 

リファレンスレベルへ移動します 

 注意 
 キーを使用すると、スパンやその他の設定

が自動的に変わります。 

操作 1. > Select Marker[F1] を押し、マーカ番号

Maker1（F1）～Maker6（F6）を選択します。 

2.  を押し、マーカ位置を選択します。  

 Mkr>Center[F1] 
Mkr>Start [F2] 
Mkr>Stop[F3] 
Mkr>CF Step[F4] 
Mkr>Ref Lvl[F5] 
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デルタマーカを有効にする 
 

概要 デルタマーカは、リファレンスマーカとデルタマーカ

間の周波数差/時間差および振幅差を測定する 

マーカペアです。  

デルタマーカを有効にすると、選択したマーカの位

置にリファレンスマーカとデルタマーカが表示され

るか、選択したマーカがまだ有効でない場合、画面

中央に表示されます。 

マーカ測定値は、画面上部のノーマルマーカ Mk

測定値の下にΔMk で表示されます。 

デルタマーカ Ref： リファレンスマーカ, 表示例 . 

Delta： デルタマーカ, 表示例 . 

操作 1. > Select Marker[F1] の順で押し、マーカ

Maker1（F1）～Maker 6（F6）を選択します。 

2. [F2] を押し選択したマーカをオンします。 

3. Delta[F4]>Delta[F1] を押し、選択したマーカをデル

タマーカタイプに設定します。 

デルタマーカを手動で移動する 
 

デルタマーカまた

はリファレンス 

マーカを移動する

1. > Delta[F4]> MoveRef[F2] の順で押し、 

リファレンスマーカへ移動します。 

2. > Delta[F4]> MoveDelta[F3] の順で押し、 

デルタスマーカへ移動します。  

1. ノーマルマーカと同じ方法で選択したマーカを移動

します。93 ページを参照ください。 
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リファレンスとデ

ルタマーカを両方

移動する 

1. Move Pair Span[F4] または Move Pair Center[F5] 
を押し両方のマーカを同時に移動します。  

 Move Pair Span： 両マーカの周波数スパン

（周波数間隔）を設定しま

す。スパンは、正/負どちら

も可能です：: 

+span  

 

 -span  

 Move Pair Center： 両マーカ間のスパン（周波

数間隔）を維持したまま同

時に両マーカの位置を移

動します。  

 2. ノーマルマーカと同様の方法で両マーカを移動しま

す。93 ページを参照ください。 

マーカ機能 

ノイズマーカ 
 

概要 ノイズマーカ機能は、マーカ位置から参照した 1Hz

帯域幅の平均ノイズレベルを計算します。 
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操作 1. > Select Marker[F1] の順で押し、マーカ番

号 Maker1（F1）～6（F6）を選択します 

2. [F2] を押し、選択したマーカをオンします。 

3. Normal[F3] を押し、マーカを希望位置へ移動しま

す。  

4. Function[F5]>Marker Noise の順で押し、ノイズ 

マーカをオンします。 

5. 画面上部にノイズレベル測定値を dBm/Hz で表示

します。 

 
マーカ番号 , 周波数 , dBm/Hz

マーカ

 

周波数カウンタ 
 

概要 周波数カウンタ機能は、正確な周波数測定を行う

ために使用します。 

操作 1. > Select Marker[F1] を押し、マーカ番号

Maker1（F1）～Maker6（F6）を選択します。 

2. [F2] を押し、選択したマーカをオンします。 
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3. Normal[F3] 押し、希望する位置へマーカを移動し

ます。 

4. Function[F5]>Frequency Counter[F1] を押し、カウ

ンタ機能をオンします。 

5. Resolution[F2] を押し、周波数カウンタの分解能を

設定します： 

 Auto： 自動的に周波数カウンタ

の最適な分解能を選択し

ます。 

 Man： 手動で分解能を設定しま

す。  

 分解能設定の範囲 1Hz, 10Hz, 100Hz, 1kHz 

 

6. 画面上部に選択した分解能で周波数測定値を表

示します。 

トレースへマーカを移動する 
 

概要 マーカトレース機能は、現在アクティブなトレースへ

選択したマーカを移動します。 

操作 1. > Select Marker[F1] の順で押し、マーカ番

号 Maker1（F1）～Maker6（F6）を選択します。 

2. [F2] を押し、選択したマーカをオンします。 

周波数 

マーカ 
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 3. More 1/2[F7]>Marker Trace[F1] の順で押し、現在

選択されているマーカの移動先トレースを選択しま

す。 

 Auto[F1] 
Trace1[F2] 
Trace2[F3]  
Trace3[F4]  
Trace4[F5] 

オート 

トレース 1 

トレース 2 

トレース 3 

トレース 4 

 

4. 下の例は、マーカ 1 をトレース 1 へ設定しマーカ 2

をトレース 2 へ設定しています。 

マーカ1 ,トレース1

マーカ2 ,トレース2

一覧表（テーブル）でマーカを表示する 
 

概要 全てのアクティブなマーカとその測定値を表示する

マーカテーブル機能があります。 

操作 1. > More[F7]>Marker Table[F2] の順で押し、

マーカテーブルをオンします。 
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2. 画面表示を上下 2 分割にし、下側にマーカ ID(ノー

マルまたはリファレンスとデルタ)、トレース番号、X

軸位置（周波数/時間）とマーカの振幅値を表示し

ます。 

マーカテーブル

ピークサーチ 

マーカをピークレベルへ移動する 
 

説明  キーでトレースのピークを検索しマーカを移

動します。 

操作 1. > Select Marker[F1] を押し、ピーを検索する

マーカ番号 Maker1（F1）～Maker6（F6）を選択しま

す。  

2. >Peak Search[F1].を押しすと、 選択したマー

カが最も大きな信号ピークへ移動します。 

3. 各スイープのピークを連続的にサーチするには、 

>More [F7]>Peak Track[F1] の順で押し 

Peak Track をオンにします。 
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マーカとマーカ位置信号を画面中央へ移動する 
 

概要 マーカセンター機能は、マーカ位置の周波数をセン

ター周波数（画面中央）にします。 

この機能は、Next Peak, Next Peak Right, Next 
Peak Left と Min Search ピーク機能を一緒に使用

できます。 

ピークサーチの詳細は、101 ページを参照くださ

い。  

操作 1. > Select Marker[F1] を押し、マーカ番号

Maker1（F1）～Maker6（F6）を選択します。 

2. を押します。マーカは、信号ピークへ移動し

ます。 

3. Mkr>Center[F2].の順で押すとマーカと信号ピーク

はセンターへ移動します。 

 注意 
上記手順の場合、Span は変更されません。 

ピークを検索する 
 

概要  キーは、画面何の異なるピークの検索に使

用します。 

ピークサーチ Next Peak： 画面上の最大ピークの次に最

も大きなピークを検索します。 

 Next Peak Right： マーカの右にある次のピークを

検索します。 

 Next Peak Left： マーカの左にある次のピークを

検索します。  
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 Min Search： 画面内の最も小さなピークを検

索します。 

操作 1. > Select Marker[F1] を押し、マーカ番号

Maker1（F1）～Maker6（F6）を選択します。 

2.  を押し、検索したいピークの種類を選択しま

す。  

例： 

Next Peak 

例： 

Next Peak Right 
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例： 

Next Peak Left 

ピークサーチの設定 
 

概要 ピーク検索には、2 種類の設定をすることができま

す： 

Peak Excursion と Peak Threshold 

 Peak Excursion： ピーク偏差は、ピーク検出する

ために、ピークしきい値以上の

最小値を設定します。 

 Peak Threshold： ピークしきい値は、ピークを検

索するためのしきい値レベルを

設定します。 

ピークしきい値＋ピーク偏差を

超えた値は、ピークとして検出

されます。 
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操作 1. >More [F7]. を押します。 

2. Peak Excursion[F2] を押し、偏差レベルを設定しま

す。 

3. Peak Threshold[F3] を押し、ピークしきい値を設定

します。 

 Peak Excursion： 0～100dB 

Peak Threshold： -120dB～+30dB  

ピークテーブル 
 

概要 ピークテーブル機能は、ピーク設定に合致した全て

のピーク（最大 10 個）を一覧表示します。 

各ピークの振幅と周波数が一覧に表示されます。 

操作 1. >More[F7]>Peak Table[F5]. を押します。 

 2. Peak Sort[F2] を押し、並べ替えの種類（周波数ま

たは振幅）を設定します： 

 Freq： 

 

Amp： 

周波数の昇順で並べ替え

振幅の昇順で並べ替え 

 3. Peak Table[F1] を押し、ピークテーブルを表示させ

ます。 
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 4. 画面が上下に 2 分割されます。 

下の画面にはピークマーカ ID、X 軸位置と振幅の

ピークテーブルが表示されます。 

ピークテーブル

ピークマーカ

 注意 
ピークテーブル機能のマーカは全て“P”と表示され他

のマーカと区別するため紫色 で表示されます。 
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ディスプレイ 
Display キーは、表示モード（スペクトラム、スペクトラムグラフィック、ト

ポグラフィック）と分割画面モードを設定と、LCD の輝度など基本的な表

示設定をします。 

LCD 画面の輝度を調整する 
 

概要 LCD 画面の輝度を 3 段階で調整できます。  

操作 1. > LCD Brightness[F2] を押し画面の輝度を

切り換えます：  

 Hi： 

Mid： 

Lo： 

高輝度 

中間輝度 

低輝度 

LCD 画面のバックライトをオフにする 
 

説明 電力消費を少なくしたり、LCD 表示が不要で LCD

の寿命を延したりするために、LCD 表示をオフする

ことができます。  

操作 1. > LCD Backlight[F3] を押し LCD バックライ

トをオフします。  

2. LCD バックライトをオフしたとき、任意のファンクショ

ンキーを押すことでバックライトがオンします。 

ディスプレイラインを設定する (リファレンスレベルライン) 
 

概要 ディスプレイライン機能は、画面上にトレースと重

ねてリファレンスレベル線を青色で表示します。 
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操作 1. > Display Line[F4] を押し、ディスプレイライ

ンをオンします。 

2. ディスプレイラインのレベルと単位を設定します。 

例： 

 

ディスプレイ
ライン

ディスプレイラインを-50dBm に設定 

ビデオ出力端子を使用する 
 

概要 本器は、外部モニタへ画面表示を出力するための

専用 DVI 端子を装備しています。 

ビデオ出力は、常にオンです。 

 出力解像度 800 x 600 (固定) 

操作 1. 背面パネルの DVI 端子へ外部モニタを接続しま

す。 

ディスプレイモードの設定 
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概要 本器は、スペクトラムを観測するために 3 種類の 

ディスプレイモードがあります： 

スペクトラム、スペクトログラム、トポグラフィック。 

 

画面分割機能を使用することでスペクトラムとスペ

クトログラムまたはスペクトルとトポグラフィクを同

時に観測することが可能です。  

 スペクトラム デフォルト表示モード 

 スペクトログラム 時間ドメインで周波数また

は電力を観測するのに使

用します。 

 トポグラフィック トレースがサーマルカラー

で表示されトレース上のイ

ベント頻度を観察するのに

便利です。 

操作 1. >Window Setup[F1] を押しディスプレイモー

ドを選択します： 

 Spectrum[F1]: 
Spectrogram[F3]: 
Topographic[F4]: 
Spectrogram+Spectrum[F5]: 
Topographic+Spectrum[F6]: 

 注意 
スペクトラム＋スペクトログラム、スペクトル＋トポ

グラフィックモードでは、上下分割画面で同じトレー

スが使用されています。 
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例： 

スペクトログラム 

  

スペクトログラム表示は、周波数ドメインと時間ドメ

インの両方における信号を表示します。  

X 軸は周波数、Y 軸は時間を表示し、各ポイントの

色は、特定の周波数と時間における振幅を表示し

ます（赤色＝レベルが高い、濃い青色＝レベルが

低い）。 

 

新しいトレースは、画面下部に表示され、過去のト

レースは、削除されるまで画面上部に向かって押し

上げられます。 
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トポグラフィック  

 

 

 

 

 

トポグラフィック表示は、イベントの頻度を表示して

います。トポグラフィック表示は、より強い信号によ

って観測しずらい微小な信号や、断続的に発生す

る事象を簡単に観測するのに便利です。 

色でイベントの頻度を表します。青色は、頻度が少

ない事象を表し、赤色は、頻度の高い現象を表しま

す。 

スペクトログラム 

+スペクトラム 

  

信号のスペクトラムとスペクトログラム両方を表示

します。 
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トポグラフィック 

+スペクトラム 

 

 

 

 

 

 

トポグラフィックとスペクトラム両方を表示します。 

スペクトログラムとトポグラフィックのマーカ 
 

概要 スペクトログラムとトポグラフィック表示には、マー

カとデルタマーカを使用して指定したポイントの周

波数と振幅を表示できます。 

この機能は、周波数ドメインと時間ドメイン両方の

デルタ測定に特に有効です。 
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操作 1. トポグラフィック表示（単一または分割表示）のと

き、Topographic Marker [F1]を押しマーカ表示を 

オンにします。 

2. スペクトログラフ（単一または分割表示）のとき、

Spctrogram Marker [F1]を押しマーカ表示をオンし

ます。 

3. リファレンスマーカを移動するために Ref.[F2]>X 
Axis[F1] を押し X 軸位置（周波数）を設定します。 

4. Y Axis[F2] を押し、Y 軸位置（振幅）を設定します。

周波数、振幅と時間またはパーセントがファンクション

ニューキー（F3～F5）に表示されます：  

 Frequency[F3] マーカ位置の周波数 

Amplitude[F4] マーカ位置の振幅 

Time[F5]  スイープのスタートからの

相対時間 

 5. デルタマーカを設定するには、Return[F7] 
>Delta[F3]>X Axis[F1] を押し、デルタマーカの 

X 軸位置（周波数）を設定します。 

6. Y Axis[F2] を押しデルタマーカの Y 軸位置（振幅）

を設定します。 

周波数と振幅のデルタ値が残りのファンクションキー

（F3～F6）に表示されます：  

 ΔFrequency[F3] デルタマーカ位置の周波

数 

ΔAmplitude[F4] デルタマーカ位置の振幅 

ΔTime[F5] デルタ時間 

 1/ΔTime[F6] デルタ周波数（1/ΔT） 
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例 リファレンスマーカ

Ref. マーカとデルタマーカ
位置と測定値

デルタマーカ

 

スペクトログラムの表示例 

スペクトラム表示の分割 
 

概要 分割スペクトラム表示は、分割画面表示を使用し

同時に画面上に 2 つの異なるスイープレンジのス

ペクトラムを観測できます。画面上部と画面下部の

表示には、別々にスイープレンジ、振幅、スパン、

その他の設定することができます。 

しかし、分割画面（上部または下部）は、交互に各

スイープを実行します。 
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操作 1. >Window Setup[F1]>Split Spectrum[F2] 
>Active Win[F1] の順に押し Upper で、上部画面を

アクティブにします。 

2. Active Win.[F1] を押し、Upper（画面上部）と下部

（Lower）間のスイープ実行を切り換えます。 

3.  Alternate Sweep[F2] を押すと、画面上部と下部の

各スイープを交互に実行します。 

 注意 
交互スイープモードでは、設定操作はできません。

分割スペクトルビューを解除したとき、本器の表示

は、アクティブなウィンドウの設定を使用します。 

非アクティブな画面設定は、次に分割表示を使用

するときまでスペクトルビューを保持されます。 

 

例： 
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システム設定 

システム情報 
 

概要 システム情報には、以下の内容が表示されます。 

 
 

シリアル番号： 

 

インストールされたオプ

ション 

バージョン： Calibration Date: 

ソフトウェア LOI 

ファームウェア RF 

ファイルシステム TG 

RF DNS ホスト名 

TG MAC アドレス 

DSP LXI パスワード 

Wordlist  

Core  

操作 1. >System Information[F1] 押し、システム情

報を画面に表示させます。  

エラーメッセージ表示 
 

概要 エラーメッセージをメッセージ番号、説明、時間など

エラーキューにある内容が表示されます。本器操

作時、システムエラーキューの全てのエラーをログ

します。エラーメッセージのリストについては、プロ

グラミングマニュアルを参照ください。  

操作 1. >Error message[F2] を押し、エラーメッセー

ジテーブルを表示させます。 

2. Prev Page[F2] と Next Page[F3] を押し、エラー 

リストのページ間の移動操作をします。 
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3. Clear Error Queue[F6] を押し、リストからエラーメッ

セージを削除します。 

システム言語の設定 
 

説明 本器は、メニュー表示などのためにいくつかの言語

をサポートしています。システム言語を選択すると

ソフトキーは選択した言語に設定されます。 

操作 1. >Language[F3] の順に押し、システム言語を

選択します。 

日付と時間の設定 
 

操作 1. >Date/Time[F4].の順に押します。 

 2. Set Date[F1] を押し日付設定にします： 

 Year[F1] 年を設定します。 

Month[F2] 月を設定します。 

Day[F3] 日を設定します。 

 3. Set Time[F2] を押し、システム時間を設定します：

 Hour[F1] 時間を設定します（24 時

間） 

Minute[F2] 分を設定します。 

Second[F3] 秒を設定します。 

 4. システム時間と日付は画面上部に表示されます。 

日付と時間 
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画面に日付と時間を表示する 
 

説明 画面上の「日付と時間」表示をオン/オフします。 

操作 1. >Date/Time[F4]>Clock[F4] の順で押し、 

時計・日付表示のオン/オフを切り替えます。 

Wake-Up Clock（起動時間設定）を使用する 
 

概要 本器は、説定した曜日と時間になると自動的に起

動（電源をオンに）するウェイクアップクロックの機

能をサポートしています。  

操作 1. >Date/Time[F4]>Wake-Up Clock[F3] の順で

を押し、以下のパラメータを設定します。 

 Select Clock[F1] Wake-Up Clock 番号 (1～

7)を選択する。 

 State[F2] 選択したクロックのオン/オ

フを切り替える。 

 Hour[F3] 起動の時間を設定する。 

 Minute[F4] 起動の分を設定する。 

 Repeat Single[F5] Wake-Up Clock を繰り返

すか、一回のみかを設定

する。 

注意 
1 つのウェイクアップクロックに設定できる曜日（日

付）は、1 日のみです。 

複数曜日を設定することはできません。 

アラーム出力 
 

概要 背面パネルの ALARM 出力 BNC 端子から

Pass/Fail の結果を出力できます。 
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 出力：オープンコレクタ 

Vo

R
アラーム出力

BNC端子

+V

操作 1. >Alarm Output[F6] を押し、ALARM OUT 端

子出力のオン/オフを切り替えます。 
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プリセット 
プリセット機能は、工場出荷時のパネル初期設定またはユーザー定義

（プリセット設定に依存）のいずれかを呼び出すことが可能です。 

 

エラー! 参照元が見つかりません。 →エラー! ブックマークが定義され

ていません。ページから 

ユーザー定義プリセットの保存→119 ページから 

プリセットタイプを設定→120 ページから 

電源オン時のプリセット設定 →120 ページから 

プリセットキーを使用する 
 

概要 キーは、工場出荷時の状態またはユーザー

定義プリセット状態を呼び出すことが可能です。 

プリセットキーで呼び出すプリセットの種類につい

ては 119 ページを参照ください。 

工場出荷時 

プリセット 

工場出荷時の初期設定状態については、287 ペー

ジを参照ください。 

操作 を押し、プリセット状態にします。  

ユーザー定義プリセットの保存 
 

概要 ユーザー定義プリセットは、現在のパネル設定情

報をユーザー定義プリセットとして保存することで

作成できます。 

操作 >Pwr On/Preset[F5]>Save User Preset[F3] 
を押し User Preset 設定として現在の状態を保存し

ます。 
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プリセットタイプを設定 
 

概要  キーを押す度に、プリセットに設定された 

パネル設定を呼び出します。 

プリセットの内容は、工場出荷時またはユーザー

定義のいずれかを選択可能です。  

操作 1. >Pwr On/Preset[F5]>Preset Type[2] を押

し、プリセットタイプを選択します：  

 User Preset[F1] ユーザー定義プリセット 

Factory Preset[F2] 工場出荷時設定 

電源オン時のプリセット設定 
 

説明 本器の電源をオンしたとき、プリセットに設定した 

内容（初期設定またはユーザー定義設定）または

最後に電源オフしたときの設定のいずれかで起動

することができます。 

操作 1. >Pwr On/Preset[F5]>Power On[F1] の順で

を押し、電源オン時の呼出設定を選択します：  

 Power On： Last, Preset  

 注意 
プリセット状態についての詳細は、287 ページの 

プリセットタイプ設定を参照ください。 

最後のプリセット状態は、電源オフ時に正常に終了

しなかったときには呼び出しができません。 

詳細については 27 ページを参照ください。 
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測定 
この章では、自動測定モードの使用方法について説明します。 

本器は、以下の測定機能をサポートしています： 

 

ACPR  →124 ページから 

OCBW →127 ページから 

AM 解析→129 ページから 

FM 解析 →134 ページから 

AM/FM 復調 →139 ページから 

ASK 測定→140 ページから 

FSK 測定→148 ページから 

2FSK 測定 →155 ページから 

位相ジッタ測定→159 ページ 

Spectrum Emission Mask（SEM）の概要→ f 161 ページから 

3 次相互変調歪み (TOI) →182 ページから 

CNR/CSO/CTB 測定→  185 ページから 

高調波測定→191 ページから 

N dB 帯域幅→193 ページから 

P1dB 測定(トラッキングジェネレータ付きモデル) → 195 ページから 

チャンネル解析の概要 
 

概要 チャンネル解析測定には、ACPR (Alternate-

Channel Power Ratio：隣接チャネル電力比)と

OCBW (occupied bandwidth：占有周波数帯域幅)

測定を含みます。 
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パラメータ チャンネル帯域幅 ターゲットチャンネルが 

占有する周波数帯域幅： 

0Hz～3.25GHz  

(0Hz を除く) 

チャンネルスペース 各メインチャンネル間の周

波数差 

範囲： 

0Hz～3.25GHz 

隣接チャンネル帯域幅

1 と 2 

隣接チャンネルが占有す

る周波数帯域幅 

範囲： 

0Hz～3.25GHz 

(0Hz を除く) 

隣接チャンネル 

オフセット 1～3 

隣接チャンネルとメインチ

ャンネル間の周波数差 

範囲：1 

0Hz～3.25GHz 

(0Hz を除く) 

OCBW％ 消費電力量に対する占有

帯域幅比.  

範囲：0％ ～100％, 

分解能 0.1% 

ACPR 
 

説明 隣接チャネル電力は、メインチャンネルから隣接チ

ャネルへの漏洩電力量を意味します。 

この測定は、隣接チャネルにおける電力に対する

メインチャネル電力の比です。 
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例 

Main
CHBW

ADJ
CH1

ADJ
CH2

ADJ
CH3

ADJ
CH1

ADJ
CH2

ADJ
CH3

Offset 1
Offset 2
Offset 3

Channel spacing
次のmain channel

 

操作： 

メインチャンネル

の設定 

1. > Channel Analysis[F1]>ACPR[F2] を押し、

ACPR 測定をオンにします。 

その他の測定モードは自動的に無効になります。 

2. 画面が上下に 2 画面に分割されます。 

画面上部は、メインチャンネル、隣接するチャネル

とそれに対応するリミットを表示します。 

画面下部には、リアルタイムで ACPR 測定の結果

を表示します。 
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ADJCH2

チャンネルパワーの
測定結果

ADJCH3

ADJCH1
Main CH

 3. > Channel Analysis[F1]>ACPR Setup[F1]> 

の順で押し、以下の項目を設定します： 

 Main CHBW[F1] メインチャンネルの帯域幅

を設定します。［Hz］ 

 Main CH H Limit[F2] メインチャンネルの下限リ

ミットを設定します。［dBm］

 Main CH Limit[F3] メインチャンネルの上限リ

ミットを設定します。［dBm］

 CH SPC[F4] チャンネル間隔を指定しま

す。［Hz］ 

操作： 

隣接チャンネルの

設定をする 

1. ADJCH Setup[F5] を押し、隣接チャンネルを設定

します： 

Select AdjCh[F1] 隣接チャンネル番号を選

択します：1, 2, 3 

 [F2] 選択したチャンネルのオン

/オフを切り替えます。 
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 ADJCHBW[F3] 選択したチャンネルの帯域

幅を選択します。 

 ADJCH Offset[F4] 隣接チャンネルオフセット

を設定します。 

 ADJCH HLimit[F5] 隣接チャンネルの上限値

を設定します。 

 ADJCH LLimit[F5] 隣接チャンネルの下限値

を設定します。 

 2. 必要であれば、その他の隣接チャンネルに対して

上記手順を繰り返します。 

チャンネルを上下

へ移動する 
1. > Channel Analysis[F1] を押し、その他の 

チャンネルへ移動するために以下のキーを押しま

す： 

Channel Move Up[F5] 上のメインチャンネルへ 

Channel Move 
Down[F6] 

下のメインチャンネルへ 

 注意 
チャンネルスペース（CH SPC）パラメータは、次の

メインチャンネルの位置を決定します。 

定義ヘルプを非

表示にする 
1. > Channel Analysis[F1]>ACPR Setup[F1]> 

Def. Help 押し、Definitions Help 表示のオン/オフを

切り替えます。 

OCBW 
 

概要 占有帯域幅測定は、チャネルの電力に占有チャネ

ルの電力をパーセンテージで測定するのに使用し

ます。 
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例 

CH BW

OCBW

操作： 

メインチャンネル

の設定 

1. > Channel Analysis[F1]>OCBW[F4] の順に

押し、OCBW をオンします。 

その他の測定モードは自動的に無効になります。 

2. 画面が上下 2 分割表示になります。 

画面上部は、チャンネル帯域を表示します。 

画面下部はリアルタイムで OCBW 測定結果を表示

します。 

チャンネルパワーと
トータルパワー値

CH BW



 AM/FM 解析 

129 

 3. OCBW Setup[F3] を押し OCBW 設定に移動しま

す： 

CHBW[F1] チャンネル帯域幅を設定し

ます。 

 CH SPC[F2] メインチャンネル間の 

スペースを設定します。 

 OCBW%[F3] OCBW に対する CHBW の

％を設定します。 

チャンネルを上下

に移動する 
1. > Channel Analysis[F1] を押します： 

Channel Move Up[F5] 次のメインチャンネルへ移

動します。 

Channel Move 
Down[F6] 

前のメインチャンネルへ移

動します。 

 注意 
チャンネルスペース（CH SPC）パラメータは、次の

メインチャンネル位置を決定します。 

ACPR と OCBW セットアップから CH SPC パラメー

タは、独立しています。 

AM/FM 解析 

AM 解析 
 

概要 AM Analysis（AM 変調解析）がオンになると、入力

信号はセンター周波数を中心とし、スパンは自動

的にゼロスパンに設定されます。 

測定項目 AM Depth： 現在値, Min, Cent, Max 

Mod. Rate： 現在値, Min, Cent, Max 

Carrier Pwr： 現在値, Min, Cent, Max 

Carrier Freq Offset： 現在値, Min, Cent, Max 
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SINAD: 現在値, Min, Cent, Max 

操作： 

設定 

1. センター周波数をキャリア周波数に設定する。 (40

ページ) 

2. > Demod[F2]>AM Analysis[F1]>AM 
Analysis[F1] の順で押し、AM 解析をオンします。 

その他の測定モードは、自動的に無効になります。 

3. 画面が上下 2 分割されます。 

画面上部は、時間ドメインで AM 波形を表示しま

す。 

画面下部は、AM 測定値を表示します。 

AM変調の測定値

AM復調波形

 4. Setup[F2]>IF Bandwidth[F1] を押し、中間周波数

帯域幅（IF Bandwidth）を設定します。 

キャリアに含まれるスペクトラムに対応するために十
分な帯域幅を設定してください。 

 5. LPF[F2] を押し、ローパスフィルタを設定するか、 

またはバイパスに設定します： 

 

AM 信号周波数 (Hz) 

 選択可能な LPF の帯域幅（Hz） 
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 ≧78,125 156,250 78,125 52,083 39,063 31,250 
 ≧39,063 78,125 39,063 26,042 19,531 15,625 
 ≧19,531 39,063 19,531 13,021 9,766 7,813 
 ≧7,813 15,625 7,813 5,208 3,906 3,125 
 ≧3,906 7,813 3,906 2,604 1,953 1,563 
 ≧1,953 3,906 1,953 1,302 977 781 
 ≧781 1,563 781 521 391 313 
 ≧391 781 391 260 195 156 
 ≧195 391 195 130 98 78 
 ≧78 156 78 52 39 31 
 ≧39 78 39 26 20 16 
 ≧20 39 20 13 10 8 
 ≧8 16 8 5 4 3 

 6. Time Axis [F3] を押し水平軸パラメータを設定しま

す： 

 Ref. Value[F1] 時間軸のスタート時間を設

定します。 

 Ref. Pos[F2] グリッド目盛の X 番目へ

波形をシフトします。 

 Scale/Div[F3] オートスケールがオフの

時、時間目盛の値を設定

します。 

 Auto Scale[F4] オートスケールのオン/オ

フを切り替えます。 

 7. Depth Axis[F4] を押し、変調度（垂直）パラメータを

設定します： 

 Ref.Value[F1] 垂直スケール/div に対す

るパーセンテージでリファ

レンス位置をオフセットしま

す。 

 Ref.Pos[F2] 垂直目盛(1：10)上の波形

のリファレンス位置を設定

します。 
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 Scale/Div[F3] オートスケールがオフのと

き、垂直目盛の数値を 

パーセンテージで設定しま

す。 

 Auto Scale[F4] オートスケールのオン/オ

フを切り替えます。 

 8. Squelch[F6] を押し、キャリアスケルチレベルを設

定します。 

スケルチ設定は、一定レベルの不要なノイズを抑

制します。 

操作： 

トリガ設定 

9. AF Trigger[F5]>Trigger Setup[F2] を押し、トリガ条

件を設定します： 

Edge Slope[F1] トリガを立ち上がりエッジま

たは立下りエッジに設定し

ます。 

 Trigger Mode[F2] トリガモードを設定します：

Nor.：ノーマルトリガ 

Sgl.：シングルトリガ 

Cont.：連続トリガ 

 Trigger Level[F3] トリガレベルをへ Depth の

パーセンテージで設定しま

す 

(表示レベルが、少しの間

のこります。)  

 Trigger Delay[F4] トリガ遅延時間を設定しま

す： 

0 ～ 1ks 

 10. Return[F7] を押し、AF トリガメニューへ戻り残りの

トリガオプションを設定します： 

 
FreeRun[F1] トリガは無効です。 

初期設定はこの設定で

す。 
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 Start Time[F3] 画面上部の AM 波形の X

軸のスタート時間を設定し

ます。 

 Stop Time[F4] 画面上部の AM 波形の X

軸のストップ時間を設定し

ます。 

 Action Now[F5] FreeRun モードをオフにし

ユーザー定義のトリガ設定

を有効にします。 

 注意 
MAX と MIN 測定値は、より高いかより低い値が見

つかるまで値を保持します。 

 MAX と MIN の測定値をリセットするには、 

>Demod[F2]>AM Analysis[F1]> 
Min/Max Reset[F3]. を押します。  

AM Pass Fail テスト 
 

概要 リミット編集機能は、AM 変調度、キャリアオフセット

とキャリアパワーの PASS 判定リミットを設定しま

す。 

測定範囲 AM Depth： 5％～95％ 

Carr. Offset： 1Hz～400kHz 

Carrier Power： -120dBm～30dBm 

操作： 

設定 
1. > Demod[F2]>AM Analysis[F1]> Limit 

Edit[F5] の順で押し、リミットを設定します。 

 AM Depth[F1] 測定した変調度がこの 

リミット値を超えたら Fail と

判定します。 

 Carr. Offset[F2] 測定したキャリアオフセット

がこのリミット値を超えたら

Fail と判定します。 
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 Carr. Power[F3] 測定したキャリア電力がこ

のリミット値を超えたら Fail

と判定します。 

 2. Pass/Fail Test を押し Pass/Fail のオン/オフを切り

替えます。 

 3. Paｓｓ/Fail がオンになると、画面下部の AM 測定エ

リアに現在の AM 変調度、キャリアオフセットおよ

びキャリア電力とそれらのパス/フェイル表示も含

みます。 

 Pass：  Fail：  

例 

Pass/Fail 判定

FM 解析 
 

概要 周波解析をオンにすると、入力信号のキャリア周波

数をセンター周波数とし、スパンは自動的にゼロス

パンに設定されます。 

測定項目 Freq. Deviation： 現在値, 最小, 中心値, 最大

Mod. Rate： 現在値, 最小, 中心値, 最大

Carrier Pwr： 現在値, 最小, 中心値, 最大

Carrier Freq Offset： 現在値, 最小, 中心値, 最大
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SINAD: 現在値, 最小, 中心値, 最大

操作： 

設定 

1. センター周波数をキャリア周波数に設定します。

(40 ページ) 

2. > Demod[F2]>FM Analysis[F2]>FM 
Analysis[F1] の順に押し FM 解析をオンします。 

その他の測定モードは、自動的に無効になります。 

3. 画面が上下 2 画面に分割されます。 

画面上部は、時間ドメインで FM 復調波形を表示し

ます。 

画面下部は、FM 測定値を表示します。  

FM変調の測定値

FM復調波形

 4. Setup[F2]>IF Bandwidth[F1] の順で押し IF(中間)

周波数帯域幅を設定します。 

(10kHz, 30kHz, 100kHz, 300kHz, 1MHz) 

キャリアに含まれるスペクトラムに対応するために十
分な帯域幅を設定してください。  

 5. LPF[F2] を押し、ローパスフィルタの周波数を設定

するか、あるいはバイパスに設定します： 
 FM 信号周波数 (Hz) 

 選択可能な LPF (Hz)の帯域幅 
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 ≧78,125 156,250 78,125 52,083 39,063 31,250 
 ≧39,063 78,125 39,063 26,042 19,531 15,625 
 ≧19,531 39,063 19,531 13,021 9,766 7,813 
 ≧7,813 15,625 7,813 5,208 3,906 3,125 
 ≧3,906 7,813 3,906 2,604 1,953 1,563 
 ≧1,953 3,906 1,953 1,302 977 781 
 ≧781 1,563 781 521 391 313 
 ≧391 781 391 260 195 156 
 ≧195 391 195 130 98 78 
 ≧78 156 78 52 39 31 
 ≧39 78 39 26 20 16 
 ≧20 39 20 13 10 8 
 ≧8 16 8 5 4 3 

 6. Time Axis[F3] 押し水平軸パラメータを設定します：

 Ref. Value[F1] 時間軸のスタート時間を設

定します。 

 Ref. Pos[F2] X 軸方向の位置を X 目盛の

分だけ波形を移動します。 

 Scale/Div[F3] オートスケールがオフの時

の目盛スケールを設定しま

す。 

 Auto Scale[F4] オートスケールをオン/オフ

を切り替えます。 

 7. Deviation Axis[F4] を押し、水平軸パラメータを設

定します： 

 Ref.Value[F1] 時間軸の開始時間を設定し

ます。 (周波数にて) 

 Ref.Pos[F2] Y 軸方向に X 目盛分だけ波

形を移動します。(1:10) 

 Scale/Div[F3] オートスケールがオフの時

の垂直軸の目盛スケールを

設定します。 

 Auto Scale[F4] オートスケールをオン/オフ

を切り替えます。 
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操作： 

トリガ設定 

8. AF Trigger[F5]>Trigger Setup[F2] の順で押し、トリ

ガ条件を設定します： 

Edge Slope[F1] トリガを、立ち上がりエッジま

たは立下りエッジに設定しま

す。 

Trigger Mode[F2] トリガモードを設定します： 

 

Norm.：ノーマルトリガ 

Sgl.：シングルトリガ 

Cont.：連続トリガ 

 Trigger Level[F3] トリガレベルを周波数で設定

します。（表示レベルが少し

の間、残ります。) 

 Trigger Delay[F4] トリガ遅延時間を設定しま

す：0 ～1ks 

 9. Return[F7] を押し、AF トリガメニューへ戻り、残り

のトリガオプションを設定します： 

 
FreeRun[F1] トリガを無効にします。 

初期設定です。  

 Start Time[F3] 画面上部の FM 波形 X 軸の

スタート時間を設定します。  

 Stop Time[F4] 画面上部の FM 波形 X 軸の

ストップ時間を設定します。 

 Action Now[F5] フリーランモードをオフにし、

ユーザー定義のトリガ設定を

有効にします。 

 注意 
MAX と MIN 測定は、検出した信号より高いまたは

低い値を保持します。 

MAX/MIN 測定をリセットするには > 

Demod[F2]>FM Analysis[F1]>Min/Max Reset[F3]. 
の順で押します。  

FM Pass Fail テスト 
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概要 リミット編集機能は、FM 変調、キャリアオフセットと

キャリア電力の PASS リミットを設定します。 

測定範囲 Frequency Deviation： 40Hz～400kHz, 1Hz 測定

可能 

Carr. Offset: 1Hz～400kHz 

Carrier Power： -120dBm～30dBm 

操作： 

設定 
1. > Demod[F2]>FM Analysis[F2]>Limit 

Edit[F5] の順で押し、リミットを設定します。 

 FM Deviation[F1] 測定した変調度がこのリミ

ットを超えた場合、Fail と判

定します。 

 Carr. Offset[F2] 測定したキャリアオフセット

がこのリミットを超えた場

合、Fail と判定します。 

 Carr. Power[F3] 測定したキャリア電力がこ

のリミットを超えた場合、

Fail と判定します。 

 2. Pass/Fail Test[F6] を押し Pass/Fail をオンします。
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 3. 画面下部の FM 測定エリアは、現在の FM 変調

度、キャリアオフセット、キャリアパワーの

Pass/Fail 判定を含んでいます。  

 Pass：  Fail：  

例 

Pass/Fail判定

AM/FM 復調 
 

概要 本器は、AM や FM 放送を受信するのに便利な AM 

/ FM 復調機能があり、イヤフォン出力端子を使用

して復調したベースバンド信号を聞くことができま

す。 （モノラル） 



  GSP-9330 ユーザーマニュアル 

140 

操作： 

設定 

1. センター周波数を希望する FM/AM キャリア周波数

に設定します。 

詳細は、40 ページを参照ください。 

2. スパンをゼロスパンに設定します。 

詳細は 45 ページを参照ください。  

3. プリアンプをオートに設定してください。 

詳細は、60 ページを参照してください。 

4. RF 入力へアンテナを接続します。 

接続 ヘッドフォンまたはスピーカーをイヤ

フォン出力端子へ接続します。 

操作 1. > Demod[F2]>Sound[F3]>Ear Phone 
Out[F1] の順で押し、イヤフォン出力をオンします。

 2. Volume[F2] を押し、出力ボリュームを設定します：

 Volume： 0～15, 初期値 7 

 3. Digital Gain Control[F3] を押し、ゲインを変更しま

す：t 

 Gain: 0～18dB, 6dB ステップ 

 4. Demod Type[F4] を押し、AM または FM 復調を選

択します。 

ASK 測定 
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概要 ASK 機能は、ASK 信号を解析するために使用しま

す。 

ASK 機能は、復調した波形の表示または信号のエ

ンコードされたシンボルを表示することができます。 

マンチェスター符号またはミラー符号を復調するこ

とが可能です。  

測定項目 AM Depth： 現在値, 最小, センター, 最大 

Mod. Rate： 現在値, 最小, センター, 最大 

Carrier Pwr： 現在値, 最小, センター, 最大 

Carrier Freq Offset： 現在値, 最小, センター, 最大 

SINAD： 現在値, 最小, センター, 最大 

操作： 

設定 

1. センター周波数をキャリア周波数に設定します。

(40 ページ) 

2. > Demod[F2]>ASK[F4]>ASK Analysis[F1] 
の順で押し ASK 解析をオンします。  

その他の測定モードは、自動的に無効になります。 

3. 画面が上下 2 分割されます。 

画面上部には、波形表示（時間ドメイン）またはシ

ンボル表示で ASK 波形を表示します。 

画面下部は、ASK 測定値を表示します。
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ASK測定値とPass/Fail判定

復調波形表示

シンボル表示

 4. Bit Rate[F2] を押し、ASK 信号のビットレートを設

定します。 

シンボルレートは、時間単位のシンボル数を決定しま
す。  

画面表示 5. 画面上部の表示を、シンボル表示または波形表示

に切り替えるには 

More[F6]>View[F1]>Symbol[F1]  
または More[F6]>View[F1]>Wave[F2]  
を押します。 

 6. 画面表示を Waveform（波形表示）に設定した場

合、Axis[F4]>Time Axis [F1]で水平軸パラメータを

設定します：  

 Ref. Value[F1] 時間軸のスタート時間を設

定します。 

 Ref. Pos[F2] 波形位置を X 軸方向へ目盛

数 X だけ移動します。  
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 Scale/Div[F3] オートスケールがオフのと

き、グリッド目盛のスケール

を設定します。 

 

 
注意 

スクロールノブでは画面数は

変わりますが、変更できませ

ん。 

 7. Time Axis[F4]>Depth Axis[F2] の順で押し、変調度

（垂直軸）パラメータを設定します。： 

 Ref.Value[F1] 垂直軸 scale/div 設定の 

パーセンテージでリファレン

ス位置をオフセットします。  

 Ref.Pos[F2] 垂直目盛（1：10）上の波形の

リファレンス位置を設定しま

す。 

 Scale/Div[F3] オートスケールがオフの時、

垂直目盛のスケールを設定

します。 

 Auto Scale[F4] オートスケールのオン/オフ

を切り替えます。 

操作： 

Preamble/Sync 

8. Preamble または sync ビットまたは Words が設定さ

れている場合は、 Preamble/Sync[F5] を押しま

す。 

 Preamble/Sync[F1] preamble/sync 機能をオン

にします。 

 Preamble Bits[F2] Preamble ビットの数値を

整数 0～16 で入力します。 

 Sync Bits[F3] sync ビットの数値を整数 0

～16 で入力します。 

 Sync Words[F4] sync word を 16 進数 0000 

～FFFF で入力します。  

操作： 9. More[F6]>AF Trigger[F2]> を押し、トリガ条件を設
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AF トリガの設定 定します： 

Free Run[F1] トリガを無効にします。 

初期設定はこの状態です。 

 Trigger Condition[F2] 
> RF Trigger[F1] 

RF トリガレベルを設定しま

す：-80～+16dBm 

 Trigger Condition[F2] 
> Ext.Edge[F2] 

外部トリガのトリガスロープ

を設定します： 

Pos, Neg. 

 Trigger 
Condition[F2]> Video 
Edge[F3] 

トリガスープを設定します： 

Off, Pos, Neg. 

 Trigger Mode[F3] トリガモードを設定します： 

Norm.：ノーマルトリガ 

Sgl.：シングルトリガ 

Cont.：連続トリガ 

 Trigger Delay[F4]> トリガ遅延時間を設定しま

す： 

0～1ks 

 Action Now[F5] フリーランモードを無効にし

ユーザー定義の AF トリガ設

定を有効にします。  

Action Now[F5] を押し、 

マニュアルトリガにします。 

 Trigger Setup[F6] シングルトリガモードにした

時、このメニューが有効にな

ります。 

 Trigger 
Setup[F6]>Start Bits

スタートビット位置を 0～400

の整数で入力します。 
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 Trigger Setup[F6]> 
Stop Bits 

ストップビット位置を 0～400

の整数で入力します。 

 注意 
AF トリガが使用されたとき、トリガア

イコンが AF トリガアイコンに変わり

ます。  

シンボル設定 10. More[F5]>View[F1]>Symbol Setup[F3]> 
Decoding[F1] の順で押し、ライン復号化の方法を

設定します。シンボル表示または波形表示ビュー

でデコードされたデータを見ることができます：  

None[F1] データのデコードはしませ

ん。 

Miller[F2] ミラーデコード (aka. Delayed 

Encoding).   

 
Manchester 
Encoding[F3] 

マンチェスター符号 (aka. 

Phase Encoding).  

 
D_Manchester 
Encoding[F4] 

D_Manchester 符号(aka. 

Phase Encoding). 

 
Bi-Phase[F5] Bi-Phase 符号(aka. Phase 

Encoding) 

 注意 
ミラーエンコードの定義： 

ミラー符号化は、データ区間の途中で相転移として

「1」をコード化します。 「0」は、前ビットと同じとして

符号化されます。つまり、「1」はハイまたはローの

遷移データを引き起こすことを意味します。 
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L

データ周期例：

元データ

ミラー符号化
データ

 

マンチェスターエンコーディングの定義： 

マンチェスター符号化は、データ区間中の各遷移

の「1」または「0」を符号化します。  

本器に使用されるマンチェスターの定義は、Low か

ら High への遷移を「0」を表示し、ハイからローへの

遷移は「1」を表示します。 

1

0

H

L

データ周期例：

元データ

マンチェスター
符号化データ

 
11. View[F1]>Symbol Setup[F3]>Decode invert[F2] を

押し、符号のデコードを反転させます。 

 
12. View[F1]>Symbol Setup[F3]>Format[F3] を押し、

デコードデータの表示形式を Bin（2 進）または

Hex(16 進)にします。 

ASK Pass Fail テスト 
 

概要 リミット機能は、AM 変調度、キャリアオフセットおよ

びキャリアパワーの Pass リミット値を設定します。

測定範囲 AM Depth： 5%～95% 

Carr. Offset： 1Hz～400kHz 

Carrier Power： -120dBm～30dBm 
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操作： 

設定 
1. >Demod[F2]>ASK[F4]> More[F6]>Limit 

Edit[F4] の順で押し、リミットを設定します。 

 AM Depth[F1] 測定した変調度がこの 

リミットを超えた場合、Fail

と判定します。  

 
Carr. Offset[F2] 測定したキャリアオフセット

値がこのリミットを超えた

場合、Fail と判定します。 

 
Carr. Power[F3] 測定したキャリア電力がこ

のリミットを超えた場合 Fail

と判定します。 

 
Compare. Values[F4] 入力値を比較します。 

 
Compare Number[F5] 連続して比較する数を入

力します。 

 2. Return[F7] を押し、前のメニューへ戻ります。 

3. Pass/Fail Test[F5] を押し、Pass/Fail テストのオン

/オフを切り替えます。 

 

4. Pass/Fail テストのオンにすると、画面下の ASK 測

定エリアに現在の AM 変調度、キャリアオフセット、

キャリア電力の PASS/FAIL 表示を含みます。 
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 Pass:  Fail:  

例 

Pass/Fail判定

FSK 測定 
 

概要 FSK 機能は、FSK 信号を解析するのに使用しま

す。 

復調波形または信号内のエンコードされたシンボ

ルのいずれかを画面上部に表示します。 

マンチェスター符号またはミラー符号を復調するこ

とが可能です。  

測定項目 Freq Deviation： 現在値, 最小, センター, 最大

Mod. Rate： 現在値, 最小, センター, 最大

Carrier Pwr： 現在値, 最小, センター, 最大

Carrier Freq Offset： 現在値, 最小, センター, 最大

SINAD： 現在値, 最小, センター, 最大

操作： 

設定 

1. センター周波数をキャリア周波数に設定します。

（40 ページ 

2. > Demod[F2]>FSK[F5]>FSK Analysis[F1] 
の順で押し、FSK 解析をオンにします。  

その他の測定モードは、自動的に無効になります。 
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3. 画面が上下 2 分割されます。 

画面上部に復調した FSK 波形を波形表示（時間ド

メインの波形）またはシンボル表示で表示します。 

画面下部には、FSK の仕様測定と Pass/Fail 結果

が表示されます。 

FSK復調測定

復調波形表示

シンボル表示

 

 4. Bit Rate[F2] を押し、FSK 信号のビットレートを設

定します。  

IF 帯域幅 5. IF Bandwidth[F3] を押し、FSK 信号の周波数偏移

幅を設定します：  

 IF Bandwidth[F1] 10kHz, 30kHz, 100kHz, 

300kHz, 1MHz. 

画面表示 6. 画面上部の表示をシンボル表示または波形表示

に切り替えるには、

More[F6]>View[F1]>Symbol[F1] または 

More[F6]>View[F1]>Waveform[F2] 
を押します。 
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 7. 画面表示を Waveform に設定した場合、Axis[F4] 
>Time Axis [F1] を押し、水平軸のパラメータを設

定します： 

 Ref. Value[F1] 時間軸のスタート時間を設

定します。 

 Ref. Pos[F2] 波形を X 軸方向にグリッド目

盛 X 移動します。 

 Scale/Div[F3] Auto スケールがオフの時、X

軸グリッド目盛のスケールを

設定します。 

 8. Deviation Axis[F2] を押し、目盛（垂直）パラメータ

を設定します： 

 Ref.Value[F1] リファレンス位置をオフセット

します（単位は周波数）  

 Ref.Pos[F2] 垂直グリッド目盛の波形のリ

ファレンス位置を設定しま

す。（1：10） 

 Scale/Div[F3] オートスケールがオフのと

き、垂直グリッド目盛スケー

ルを設定します。（単位は周

波数） 

 Auto Scale[F4] オートスケールを押したとき

スケールを自動で設定しま

す。 

操作：: 

Preamble/Sync 

9. Preamble、sync bits または words を設定した場

合、Preamble/Sync[F5] を押します。 

 Preamble/Sync[F1] preamble/sync 機能をオン

にします。 

 Preamble Bits[F2] Preamble ビットの数値を

整数 0～16 で入力します。



 FSK 測定 

151 

 Sync Bits[F3] sync ビットの数値を整数 0

～16 で入力します。 

 Sync Words[F4] sync word を 16 進数 0000 

～FFFF で入力します。 

操作： 

AF トリガ設定 

10. More[F6]>AF Trigger[F2] の順で押し、AF (ASK 

/FSK) トリガ条件を設定します： 

Free Run[F1] トリガを無効にします。 

初期設定です。  

Trigger 
Condition[F2]> RF 
Trigger[F1] 

RF トリガレベルを設定する：  

-80～+16dBm 

Trigger 
Condition[F2]> 
Ext.Edge[F2] 

外部トリガのスロープを設定

する： 

Pos, Neg. 

 Trigger 
Condition[F2]> Video 
Edge[F3] 

ビデオトリガのスロープを設

定します：S 

Off, Pos, Neg. 

 Trigger Mode[F3] トリガモードを設定します： 

Norm.: ノーマルトリガ 

Sgl.: シングルトリガ 

Cont.: 連続トリガ 

 Trigger Delay[F4] トリガ遅延時間を設定しま

す： 

0～1ks 

 Action Now[F5] フリーランモードをオフにし、

ユーザー定義のトリガ設定を

有効にします。 

Action Now[F5] を押し 

マニュアルトリガにします。 

 
Trigger Setup[F6] シングルトリガモードが成立

したとき、有効になります。 
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Trigger Setup[F6] 
>Start Bits 

スタートビット位置を 0～400

の整数で入力します。 

 
Trigger Setup[F6]> 
Stop Bits 

ストップビット位置を 0～400

の整数で入力します。 

 注意 
AF トリガを有効にするとトリガアイコ

ンが AF トリガアイコンに変わります：

シンボル設定 11. View[F1]>Symbol Setup[F3]>Decoding[F1]  の順

で押し、デコード方式を設定します。 

Symbol または Waveform 表示でデコードされた 

データが表示されます： 

None[F1] データをデコードしません。 

Miller[F2] Miller decoding (aka. Delayed 

Encoding).   

 
Manchester 
Encoding[F3] 

Manchester 符号(aka. Phase 

Encoding).  

 
D_Manchester 
Encoding 

D_Manchester 符号(aka. 

Phase Encoding). 

 
Bi-Phase Bi-Phase 符号(aka. Phase 

Encoding) 

 ミラーエンコードの定義： 

ミラー符号化は、データ区間の途中で相転移として

「1」をコード化します。 「0」は、前ビットと同じとして

符号化されます。つまり、「1」はハイまたはローの

遷移データを引き起こすことを意味します。 
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データ周期例：

元データ

ミラー符号化
データ

 

マンチェスターエンコーディングの定義： 

マンチェスター符号化は、データ区間中の各遷移

の「1」または「0」を符号化します。  

本器に使用されるマンチェスターの定義は、Low か

ら High への遷移を「0」を表示し、ハイからローへの

遷移は「1」を表示します。 

1
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L

データ周期例：

元データ

マンチェスター
符号化データ

 注意 
ミラーエンコードの定義： 

ミラー符号化は、データ区間の途中で相転移として

「1」をコード化します。 「0」は、前ビットと同じとして

符号化されます。つまり、「1」はハイまたはローの

遷移データを引き起こすことを意味します。 
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データ周期例：

元データ

マンチェスター
符号化データ

 

マンチェスターエンコーディングの定義： 

マンチェスター符号化は、データ区間中の各遷移

の「1」または「0」を符号化します。  
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本器に使用されるマンチェスターの定義は、Low か

ら High への遷移を「0」を表示し、ハイからローへの

遷移は「1」を表示します。  

1

0

H

L

データ周期例：

元データ

マンチェスター
符号化データ

 12. View[F1]>Symbol Setup[F3]>Decode invert[F2] の
順で押し、デコードの反転をします。 

 13. View[F1]>Symbol Setup[F3]>Format[F3] を押し、

デコードデータの形式を Bin（2 進）または Hex(16

進)にします。 

FSK Pass Fail テスト 
 

概要 リミット編集機能は、FSK 周波数偏差、 

キャリアオフセットおよびキャリアパワーの Pass 

リミットを設定します。 

測定範囲 Freq. Deviation： 40Hz～400kHz, 1Hz 測定

可能 

Carr. Offset： 1Hz～400kHz 

Carrier Power： -120dBm～30dBm 

操作： 

設定 
1. > Demod[F2]>FSK[F5]>More[F6]> Limit 

Edit[F4] の順で押し、リミットを設定します。 

 Freq. Deviation[F1] 測定した偏移がリミットを

超えたとき、FailL と判定し

ます。  
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 Carr. Offset[F2] 測定したキャリアオフセット

がリミットを超えたろき、

Fail と判定します。 

 Carr. Power[F3] 測定したキャリア電力がリ

ミットを超えたとき、Fail と

判定します。 

 Compare Value[F4] 入力値を比較します。 

 Compare Number[F5] 連続比較する数を設定し

ます。 

 2. Return[F7] を押し、前のメニューへ戻ります。 

 3. Pass/Fail Test[F5] を押し、Pass/Fail テストのオン

/オフを切り替えます。 

 4. 画面下部の FSK 測定エリアに、現在の周波数偏

差、キャリアオフセットおよびキャリア電力のパス/

フェイルが表示されます。 

 Pass：  Fail：  

例 

Pass/Fail判定表示

2FSK 測定 
 



  GSP-9330 ユーザーマニュアル 

156 

概要 2FSK 変調は、バイナリ FSK（周波数偏移変調）変

調形式です。 2FSK は、一般的に一つの周波数が

データ "1"を表し、もう一方の周波数がデータ”0”

を表す二つの異なる周波数で構成た信号をデータ

送信するために使用されます。 

2FSK 測定は 2 トレースで作成され、一つのトレー

スは、2FSK スペクトラム（トレース 1、黄色）を表示

し、もう一方のトレース（トレース 2、パープル）は、

FSK キャリアとホップ周波数をピークマーカーと

MAX HOLD で表示します。  

測定項目 Peak 1, Peak 2： 周波数, 振幅 

Frequency Deviation： Hz 

 
Carrier Offset: 周波数 

Carrier Freq Offset: 周波数 

Peak Threshold: dBm 

Max Hold: dBm 

例 

Freq. 1 Freq. 2

Peakしきい値リミット

Max Holdリミット

2FSKトレース
Max Holdトレース

操作 1. 2FSK キャリアとホップ周波数をカバーするように周

波数スパンを設定します。 

40 ページを参照してください。 

2. > 2FSK[F3]>2FSK[F1] の順で押し、2FSK

測定をオンにします。 

• その他の測定モードは、自動的に無効になります。

3. ディスプレイが上限に 2 画面に分割されます。 

画面上部には、第 1 および第 2FSK 周波数（キャリ

アとホップ周波数）のトレースをピークマーカ付きで
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表示します。 

画面下部には、2FSK の測定結果をリアルタイムで

表示します。 

2FSK測定

Peak 1, Peak 2

 

4. ピークしきい値ラインを設定するには、Peak 
Threshold[F2]を押します。  

 しきい値の範囲： -120dBm～30.0 dBm 

 5. 最大値ホールドリミットを設定するには、 

Max Hold[F3]を押します：  

 Max Hold 範囲： -130dBm～30.0 dBm 

 注意 
ピークしきい値と Max ホールドのパラメータについ

ての詳細な情報については、79 ページのトレース

を参照ください。 

2FSK Pass Fail テスト 
 

概要 リミット編集機能は、周波数偏差、キャリア オフセッ

トおよび各ピークの振幅のハイ/ローリミットの Pass

リミットを設定します。  
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測定範囲 Freq. Deviation： 1Hz～400kHz 

Carr. Offset： 1Hz～400kHz 

High Limit： -120dBm～30dBm 

Low Limit： -120dBm～30dBm 

操作： 

設定 
1.  > 2FSK[F3]>Limit Edit[F5] の順で押し、 

リミットを設定します。 

 Freq. Deviation[F1] 測定した偏移がこのリミッ

トを超えたとき、Fail と判定

します。  

 Carr. Offset[F2] 測定したキャリアオフセット

がこのリミットを超えたと

き、Fail と判定します。 

 High Limit[F4] 測定したピークのいずれ

かの振幅がハイリミットを

超えたとき、Fail と判定し

ます。 

 Low Limit[F5] 測定したピークのいずれ

かの振幅がローリミットよ

り小さいとき、Fail と判定し

ます。 

 2. Pass/Fail Test[F6] を押し、Pass/Fail のオン/オフ

を切り替えます。 
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 3. 画面下部の 2FSK エリアに、周波数偏移、キャリア

オフセットの測定値に、パス/フェイルが表示されま

す。 

 Pass：  Fail：  

例 

Pass/Fail判定表示

位相ジッタ測定 
 

概要 位相ジッタ測定は、位相変動の量を参照して時間

ドメインにおける信号の安定性を評価するために

用いることができます。 

パラメータ Start Offset:  

 

センター周波数に対する 

スタート周波数。 

Stop Offset:  センター周波数に対する 

ストップ周波数。 
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測定項目 Carrier Power：  dBm 

Jitter in phase：  rad 

Jitter in time： ns 

例 

Stop Offset
Start Offset

操作： 

メインチャンネル

の設定 

1. > Phase Jitter[F4]>Phase Jitter[F1] の順で

押し、位相ジッタをオンにします。a  

その他の測定モードは、自動的に無効になります。 

2. 画面が上下 2 画面に分割されます。 

画面上部は、スタートとストップオフセット表示付き

でトレースを表示します。 

画面下部には、位相ジッタの測定値を表示します。

位相ジッタ測定

Start offset Stop offset

 3. Start Offset[F2] を押し、スタートオフセットを設定
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します： 

 オフセット範囲： (0Hz～Span 周波数の 1/2) 

 4. Stop Offset[F3] ストップオフセットを設定します：  

 オフセット範囲： (0Hz ～Span 周波数の 1/2) 

 注意 
位相ジッタ測定は、RBW と VBW 設定に大きく関連

付けられています。 

Spectrum Emission Mask（SEM）の概要 
 

概要 SEM 測定は、チャネル内電力と比較したチャネル

外漏えいを測定するために使用します。通常、SEM

測定はキャリア周波数と異なるオフセットの数で指

定されたパワーバンドに対して計算されます。 

SEM 測定は、しばしば異なる無線規格に対して実

行されます。 

3GPP の場合は、本器は FDD（周波数分割複信）と

TDD（時分割複信）モードの両方の BS（基地局）と

UE（ユーザ機器）試験規格をサポートしています。

また、本器は IEEE802.11b、802.11g、802.11n と

802.16 の SEM テストとユーザ定義のエミッションマ

スクテストをサポートしています。  
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例 

Channel integrated BW
Offset1

Offset2
Offset3

Chan
span

Absolute mask

Relative mask

パラメータ ChanIntegBW： 積分チャンネル幅 

.ChanIntegBW は、チャンネル

内電力を測定するのに使用し

ます。（Channel Integration 

Bandwidth） 

Chan Span： チャンネルパワーを測定すると

き、メインチャンネルのスパンを

定義するのに使用します。 

RBW： チャンネル内電力を測定すると

き、メインチャンネルの分解能

帯域幅を設定します。  

Total Pwr Ref:： 

 

電力オフセットを計算するため

のリファレンスとして使用される

キャリアのトータル電力。 

PSD Ref： 

 

電力オフセットを計算するため

のリファレンスとして使用される

キャリアの平均パワースペクト

ル密度。 

Select Offset： 設定に使用されるオフセットペ

ア（1～5）を選択します。 

Start Freq： 

 

選択したオフセット番号の 

スタート周波数オフセットを設

定します。 

Stop Freq：  

 

選択したオフセット番号の 
ストップ周波数オフセットを設定
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します。 

RBW： 

 

選択したオフセット番号の分解

能帯域幅（RBW）を設定しま

す。 

Abs Start： 選択したオフセット番号の 

スタート周波数での絶対リミット

レベルを設定します。 

Abs Stop： 

 

選択したオフセット番号のストッ

プ周波数での絶対レベルのリミ

ットを設定します。Abs ストップ

レベルのリミットは、カップルま

たは個別（Man）に設定できま

す。 

Man は、Abs ストップレベルを、

ユーザ定義にすることができま

す。 

カップルは、ABS スタートレベ

ルリミットまでで Abs ストップ 

レベルのリミットを制限します。 

Rel Start： 選択したオフセット番号の 

スタートす波数での相対的な 

レベルリミットを設定します。 

Rel Stop： 選択したオフセット番号のストッ

プ周波数での相対的なレベル

リミットを設定します。  

Rel ストップは、カップルや個別

（Man）に設定できます。 

Man は、Rel ストップをユーザ

定義できます。 

カップルは、Rel ストップレベル

のリミットを Rel スタートレベル

リミットで制限します。 

Fail Mask： レベルリミットに対して、測定の

ための Fail 条件を設定します： 

Absolute, Relative、 

Absolute & Relative、 

Absolute or Relative. 
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測定項目 Main Channel 

Bandwidth： 

単位： Hz 

Total Power： 単位： dBm 

PSD (Power 

Spectral Density)：

単位： dBm/Hz 

Offset 1～5： Lower dBm, Upper dBm 

3GPP Operating Bands* 

 
Operating 

Band 
UL Frequencies 

UE transmit, Node B receive 

DL Frequencies 

UE receive, Node B transmit

I 1920～1980MHz 2110～2170MHz 

II 1850～1910MHz 1930～1990 MHz 

II 1710～1785MHz 1805～1880MHz 

IV 1710～1755MHz 2110～2155MHz 

V 824～849MHz 869～894MHz 

VI 830～840MHz 875～885MHz 

VII 2500～2570MHz 2620～2690MHz 

VIII 880～915MHz 925～960MHz 

IX 1749.9～1784.9MHz 1844.9～1879.9MHz 

X 1710～1770MHz 2110～2170MHz 

XI 1427.9～1452.9MHz 1475.9～1500.9MHz 

XII 698～716MHz 728～746MHz 

XIII 777～787MHz 746～756MHz 

XIV 788～796MHz 758～768MHz 

XV Reserved Reserved 

XVI Reserved Reserved 

XVII Reserved Reserved 

XVIII Reserved Reserved 

XIX 830～845MHz 875～890MHz 
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XX 832～862MHz 791～821MHz 

XXI 1447.9～1462.9MHz 1495.9～1510.9MHz 

XXV 1850～1915MHz 1930～1995MHz 

*for FDD, ETSI（欧州電気通信標準化機構：European 

Telecommunications Standards Institute）から参照： 

3GPP TS 25.101 version 10.2.0 Release 10 

3GPP TS 25.104 version 10.2.0 Release 10 
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3GPP-FDD BS FDD 構成の場合、異なるリミットをトータルチャンネル

パワーP に基づいて選択することでできます。 

Δfmax の初期値は、12.5MHz です。 

Δfmax は、ユーザー定義可能です。 

チャネルスパンは、5MHz に設定されています。 

注意：A, B, C, D, E は、それぞれオフセット 1 か

ら 5 を表します。 

 P≧43 
単位：MHz Abs[1] RBW 

2.5≦A<2.7 -14dBm 30kHz 

2.7≦B<3.5 -14～-26dBm 30kHz 

3.5≦C<Δfmax -13dBm 1MHz 

 39≦P<43 
単位：MHz Abs[1] RBW 

2.5≦≤A<2.7 -15dBm 30kHz 

2.7≦B<3.5 -14～-26dBm 30kHz 

3.5≦C<7.5 -13dBm 1MHz 

7.5≦D<Δfmax P-56dB 1MHz 

 31≦P<39 
単位： MHz Abs[1] RBW 

2.5≦A<2.7 P-53dB 30kHz 

2.7≦B<3.5 P-53dB~ 

P-56dB 

30kHz 

3.5≦C<7.5 P-52dB 1MHz 

7.5≦D<Δfmax P-56dB 1MHz 

 P<31 
単位： MHz Abs[1] RBW 

2.5≦A<2.7 -22dBm 30kHz 

2.7≦B<3.5 -22～-34dBm 30kHz 

3.5≦C<7.5 -21dBM 1MHz 

7.5≦D<Δfmax -25dBm 1MHz 
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 P<31 の場合、2 つの追加電力リミット（以下に示す）

は、ホーム基地局（BS）アプリケーションの Additional 
Max Out. Pwr オプションで選択できます： 

(Δfmax の初期値は、14.5MHz です。  Δfmax は、ユー

ザー定義可能です。) 

 6≦P≦20
単位： MHz Abs[1] RBW 

12.5 ≦E< Δfmax P- 56dB 1MHz 

 P<6 
単位：MHz Abs[1] RBW 

12.5≦E<Δfmax -50dBm 1MHz 

3GPP-FDD BS 

追加要件 

バンド II、IV、V、X、XII、XIII、XIV および XXV の操作の

場合、追加要件（下記参照）は、上記の最小要件に加

えて適用されます。 

 Bands:  

II, IV, X 

単位：MHz Additional[3] RBW 

2.5≦A<3.5 -15dBm 30kHz 

3.5≦B< Δfmax -13dBm 1MHz 

 Bands: V 
単位： MHz Additional[3] RBW 

2.5 ≤A<3.5 -15dBm 30kHz 

3.5≦B< Δfmax -13dBm 100kHz

 Bands:  

XII, XIII, 

XIV 

単位： MHz Additional[3] RBW 

2.5≦A<3.5 -13dBm 30kHz 

3.5≦B< Δfmax -13dBm 100kHz

3GPP-FDD UE チャネルスパンは、5MHz に設定されています。 

注意：A, B, C, D, E は、それぞれオフセット 1 か

ら 5 を表します。 

 単位：MHz 
Rel Abs[1] RBW 

2.5≦A<3.5 -35～-50dBc -71.1dBm 30kHz 
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3.5≦B<7.5 -35～-39dBc -55.8dBm 1MHz 

7.5≦C<8.5 -39～-49dBc -55.8dBm 1MHz 

8.5≦

D<12.5 

-49～-49dBc -55.8dBm 1MHz 

3GPP-FDD UE 

追加要件 

3GPP-FDD UE のための追加要件 

Bands  

II, IV, X 

単位：MHz Additional[3] RBW 

2.5≦A<3.5  -15dBm 30kHz 

3.5≦B<12.5 -15dBm 1MHz 

 Band V 
単位：MHz Additional[3] RBW 

2.5≦A<3.5  -15dBm 30kHz 

3.5≦B<12.5 -13dBm 100kHz

 Bands  

XII, XIII, 

XIV 

単位：MHz Additional[3] RBW 

2.5≦A<3.5  -13dBm 30kHz 

3.5≦B<12.5 -13dBm 100kHz

3GPP-TDD BS 

3.84Mcps* 

TDD 構成の場合、異なるリミットがトータルチャンネル

電力に基づいて選択できます。 

チャンネルスパン： 

3.84Mcps：5MHz. 

注意：A, B, C, D, E は、それぞれオフセット 1 か

ら 5 を表します。 

 P≧43 
単位：MHz Abs[1] RBW 

2.5≦A<2.7 -14dBm 30kHz 

2.7≦B<3.5 -14～-26dBm 30kHz 

3.5≦C<12 -13dBm 1MHz 

 39≦P<43
単位：MHz Abs[1] RBW 

2.5≦A<2.7 -14dBm 30kHz 
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2.7≦B<3.5 -14～-26dBm 30kHz 

3.5≦C<7.5 -13dBm 1MHz 

7.5≦D<12 P-56dB 1MHz 
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 31≦P<39
単位：MHz Abs[1] RBW 

2.5≦A<2.7 P-53dBm 30kHz 

2.7≦B<3.5 P-53～P-65dBm 30kHz 

3.5≦C<7.5 P-52dBm 1MHz 

7.5≦C<12 P-56dBm 1MHz 

 P≦31 
単位：MHz Abs[1] RBW 

2.5≦A<2.7 -22dBm 30kHz 

2.7≦B<3.5 -22～-34dBm 30kHz 

3.5≦C<7.5 -21dBm 1MHz 

7.5≦D<12 -25dBm 1MHz 

*referenced from ETSI: 

3GPP TS 25.102 version 10.2.0 Release 10 

3GPP TS 25.105 version 10.3.0 Release 10 

3GPP-TDD BS 

1.28Mcps 

チャンネルスパン： 

1.28Mcps：1.6MHz. 

 P≧34 
単位：MHz Abs[1] RBW 

0.8≦A<1 -20dBm 30kHz 

1≦B<1.8 -20～-28dBm 30kHz 

1.8≦C<3.5 -13dBm 1MHz 

 26≦P<34
単位：MHz Abs[1] RBW 

0.8≦A<1 P-54dB 30kHz 

1≦B<1.8 P-54～P-62dB 30kHz 

1.8≦C<3.5 P-47dB 1MHz 

 P<26 
単位：MHz Abs[1] RBW 

0.8≦A<1 -28dBm 30kHz 

1≦B<1.8 -28～-36dBm 30kHz 

1.8≦C<3.5 -21dBm 1MHz 
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3GPP-TDD BS 

7.68 Mcps 

チャンネルスパン： 

7.68Mcps: 10MHz. 

 P≧43 
単位：MHz Abs[1] RBW 

5≦A<5.2 -17dBm 30kHz 

5.2≦B<6 -17～-29dBm 30kHz 

6≦C<24.5 -16dBm 1MHz 

 39≦P<43
単位： MHz Abs[1] RBW 

5≦A<5.2 -17dBm 30kHz 

5.2≦B<6 -17～-29dBm 30kHz 

6≦C<15 -16dBm 1MHz 

15≦D≤24.5 P-59dB 1MHz 

 31≦P<39
単位：MHz Abs[1] RBW 

5≦A<5.2 P-56dB 30kHz 

5.2≦B<6 P-56～P-68dB 30kHz 

6≦C<15 P-55dB 1MHz 

15≦D≦24.5 P-59dB 1MHz 

 P<31 
Unit: MHz Abs[1] RBW 

5≦A<5.2 -25dBm 30kHz 

5.2≦B<6 -25～-37dBm 30kHz 

6≦C<15 -24dBm 1MHz 

15≦D≦24.5 -28dBm 1MHz 
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3GPP-TDD UE チャンネルスパン： 

3.84Mcps: 5MHz. 

1.28Mcps: 1.6MHz. 

7.68Mcps: 10MHz. 

注意：A, B, C, D, E は、それぞれオフセット 1 か

ら 5 を表します。 

 3.84Mcps 
単位：MHz Rel[2] RBW 

2.5≦A<3.5 -35～-50dBc 30kHz 

3.5≦B<7.5 -35～-39dBc 1MHz 

7.5≦C<8.5 -39～-49dBc 1MHz 

8.5≦D<12.5 -49dBc 1MHz 

 1.28Mcps 
単位：MHz Rel[2] RBW 

0.8≦A<1.8 -35～-49dBc 30kHz 

1.8≦B<2.4 -49～-59.2dBc 30kHz 

2.4≦C<4 -44dBc 1MHz 

 7.68Mcps 
単位：MHz Rel[2] RBW 

5≦A<5.75 -38～-46dBc 30kHz 

5.75≦B<7 -46～-53dBc 30kHz 

7≦C<15 -38～-42dBc 1MHz 

15≦D<17 -42～-52dBc 1MHz 

17≦E<25 -53dBc 1MHz 

802.11b* チャンネルスパン：22MHz 

注意：「A」は、「B」は、オフセット 1、オフセット 2

を表します。 

ここで、「f」の初期値は、24MHz です。 

この値は、ユーザー定義が可能です。 
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Unit: MHz Rel[2] RBW 

11≦A<22 -30dBc 100kHz

22≦B<f -50dBc 100kHz

*リファレンス：IEEE Std 802.11b-1999 

802.11g チャンネルスパン： 

ERP-OFDM/DSSS-OFDM ：18MHz  

ERP-DSSS/ERP-PBCC/ERP-CCK：22MHz 

注意：A, B, C, D は、それぞれオフセット 1 から 4

を表します。 

“f”の初期値は、40MHz (ERP-OFDM/ DSSS-OFDM)

または 25MHz (ERP-DSSS/ ERP-PBCC/ ERP-CCK)

です。この値は、ユーザー定義可能です。 

 ERP-

OFDM/ 

DSSS-

OFDM 

単位：MHz Rel[2] RBW 

9≦A<11 -0～-20dBc 100kHz

11≦B<20 -20～-28dBc 100kHz

20≦C<30 -28～-40dBc 100kHz

30≦D<f -40dBc 100kHz

 ERP-DSSS/ 

ERP-

PBCC/ 

ERP-CCK 

単位：MHz Rel[2] RBW 

11≦A<22 -30dBc 100kHz

22≦B<f -50dBc 100kHz

*reference: IEEE Std 802.11a-1999 

802.11n チャンネルスパン： 

CH BW 20MHz：18MHz  

CH BW 40MHz：38MHz 

注意：A, B, C, D は、それぞれオフセット 1 から 4

を表します。 

“f”の初期値は、40MHz(CHBW 20MHz)または
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70MHz(CHBW 40MHz)です。 

この値は、ユーザー定義可能です。 

. 

 CH BW 

20MHz 

単位：MHz Rel [2] RBW 

9≦A<11 -0～-20dBc 100kHz

11≦B<20 -20～-28dBc 100kHz

20≦C<30 -28～-45dBc 100kHz

30≦D<f -45dBc 100kHz
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 CH BW 

40MHz 

単位：MHz Rel[2] RBW 

19≦A<21 0～-20dBc 100kHz

21≦B<40 -20～-28dBc 100kHz

40≦C<60 -28～-45dBc 100kHz

60≦D<f -45dBc 100kHz

*reference: IEEE Std 802.1n-2009 

802.16* チャンネルスパン： 

CH BW 20MHz：19MHz  

CH BW 10MHz：9.5MHz 

注意：A, B, C, D は、それぞれオフセット 1 から 4

を表します。 

“f”の初期値は、16.75MHz(CHBW 20MHz)または

31.5MHz(CHBW 10MHz)です。 

この値は、ユーザー定義可能です。 

 CH BW 

20MHz 

単位：MHz Rel[2] RBW 

9.5≦A<10.9 0～-25dBc 100kHz

10.9≦B<19.5 -25～-32dBc 100kHz

19.5≦C<29.5 -32～-50dBc 100kHz

29.5≦D<f -50dBc 100kHz

 CH BW 

10MHz 

Unit: MHz Rel[2] RBW 

4.75≦A<5.45 0～-25dBc 100kHz

5.45≦B<9.75 -25～-32dBc 100kHz

9.75≦C<14.75 -32～-50dBc 100kHz

14.75≦D<f -50dBc 100kHz

*reference: IEEE Std 802.16-2009 

 注意 

[1] Abs: 絶対リミット 
[2] Rel: リファレンスリミット(メインチャンネルのコン

プライアンスに応じた、トータル電力または電力ス
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ペクトル密度) 
[3] Additional：追加絶対リミット 

Pass Fail 基準： 

Case 1：ABS と Rel 両方が使用されるとき、最

高値（abs または Rel）は、Pass / Fail 判定と

して使用されます。リミット未満のトレースポイ

ントは、PASS です。 

Case2：追加のリミットが使用されたとき、

Case1 より高い値は、追加リミットと比較され

ます。最小値が PASS/FAIL 判定に使用され

ます。 

Spectrum Emission Mask テスト 
 

概要 スペクトラムエミッションマスクテストのために、本

器には、3GPP、IEEE-802.11 と 802.16 用のパラメ

ータが定義してあります。  

また、本器はユーザー定義による SEM テストを実

行できます。 

操作： 1. > SEM[F5]>SEM[F2] の順で押し、SEM をオ

ンします。 

その他の測定モードは、自動的に無効になります。 

 2. 画面が上下に 2 分割されます。 

画面上部には、絶対または相対マスクとトレースを

表示します。 

画面下部には、SEM の測定結果を表示します。
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SEM測定値

Absolute limit line

 1. Setup[F1]>User Define[F6] を押し、SEM 測定の 

ユーザー定義を設定します。  

 2. Meas Type[F1] を押し、TotalPwrRef[F1] または

PSDRef[F2].を選択します。 

 3. Ref. Channel[F2] を押し、以下を設定します：  

 ChanIntegBW[F1] 積分帯域幅を設定します。 

 Chan Span[F2] チャンネルスパンを設定し

ます。 

 RBW[F3] 分解能帯域幅（RBW）を設

定します。 

 TotalPwrRef[F4]/ 
PSDRef[F4] 

トータル電力/PSD リファレ

ンスレベルを設定します。

 4. Return[F7] を押し、前のメニューへ戻ります。 
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 5. Offset/Limit[F3] を押し、オフセットパラメータを設

定します：  

 SelectOffset[F1] オフセット値を編集するオ

フセット番号を選択しま

す。 

 [F2] 選択したオフセットのオン/

オフを切り替えます。  

 StartFreq[F3] 選択したオフセットの 

スタート周波数を設定しま

す。 

 StopFreq[F4] 選択したオフセットの 

ストップ周波数を設定しま

す。 

 RBW[F5] 選択したオフセットの RBW

を設定します。 

 6. More 1/2[F6] を押し、絶対レベルと相対レベルリミ

ットと条件を設定します：  

 
Abs Start[F2] 選択したオフセットの絶対

スタートレベルリミットを設

定します。  

Abs Stop[F3] 
選択したオフセットの絶対

ストップレベルリミットを設

定します。 

 

Man： Abs ストップレベルを

ユーザ定義可能にします。 

Couple：Abs ストップレベル

を Abs スタートレベルへ設

定します。 
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Rel Start[F4]  選択したオフセットの相対

スタートレベルリミットを設

定します。 

 
Rel Stop[F5]  選択したオフセットの相対

ストップレベルリミットを設

定します。 

Man： Rel ストップレベルを

ユーザ定義可能にします。

Couple：Rel ストップレベル

を Rel スタートレベルへ設

定します。. 

 7. Fail Mask[F6] を押し、Fail マスク条件を設定しま

す： 

 Absolute[F1] Fail 条件を絶対レベル 

リミットに設定します。 

Relative[F2] Fail 条件を相対レベル 

リミットに設定します。 

 Abs AND Rel[F3] 絶対と相対レベルリミット

両方に Fail 条件を設定し

ます。 

 Abs OR Rel[F4] Fail 条件を絶対または相

対レベルリミットのどちらか

に設定します。 

 8. Select Offset[F1] を押し、その他のオフセットを設

定するには上記のステップを繰り返します。 

 Offset 番号： 1～5 

プリセットされた 

テストパラメータ： 

3GPP 

3GPP SEM テストパラメータの詳細については、

161 ページの SEM の概要を参照してください。 

1. Setup[F1]>3GPP[F1] の順で押し、3GPP 測定を選

択します。 
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 2. Ref. Channel[F2] を押し、以下の項目を設定しま

す：  

 
RBW[F3] 分解能帯域幅（RBW）を設

定します。 

 3. 他のすべてのリファレンスチャネル設定は、事前に

定義されています。 

 4. Return[F7] を押し、前のメニューへ戻ります。 

 5. Offset/Limit[F3]>Duplexing Mode[F1] の順で押

し、FDD または TDD を選択します：  

 6. FDD では、FDD Setup[F2] を押し、FDD パラメータ

を設定します。 TDD では、TDD Setup[F3]:を押しま

す。 

 Transmission[F1] BS(基地局)と UE(端末)テ

ストを切り替えます。 

 Chip Rate[F2] TDD 複信のためのチャネ

ル内電力を測定するため

に使用される RRC フィル

タ帯域幅を選択します： 

3.84MHz、1.28MHz, 

7.68MHz 

 Max Out Pwr[F2/F3] BS テスト用の最大出 y 六

電力を設定します： 

P>=43 

39<=P<=43 

31<=P<=39 

P<31 
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 Add.limits[F4] FDD 複信のためにオペレ

ーティング·バンドを選択し

ます：: 

None 

BandII 

BandIV 

BandV 

BandX 

BandX11 

BandXIII 

BandXIV 

 MinOffset/ 
Limit Value[F5] 

スタート/ストップ周波数、

RBW、Abs スタート/ストッ

プと Rel スタート/ストップ

などを含むオフセットの各

パラメータを表示します。 

プリセットされた 

テストパラメータ： 

802.XX 

802.11x と 802.16 SEM テストパラメータの詳細につ

いては、161 ページの SEM の概要をご覧ください。

1. Setup[F1]> を押し、802.XX テストを選択します： 

 802.11b[F2]  

 802.11g[F3] 
  802.11n[F4] 

 802.16[F5] 

 2. Ref. Channel[F2] を押し、チャネル統合帯域幅、チ

ャネルスパン、RBW および PSD ref のプリセット設

定を表示します。t 

 3. Offset/Limit[F3] を押し、スタートとストップ周波

数、RBW、Rel スタートとストップを含むオフセットの

各パラメータ値を表示します。  

3 次相互変調歪み (TOI) 
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概要 三次相互変調歪み（Third order intermodulation 

distortion）測定は、非線形システムで周波数が接

近している二つの信号によって発生する TOI の積

を計算するために使用します。上下の 3 次インター

セプトポイント（IP3）両方を計算します。 

マーカーは、TOI 積およびそれらのそれぞれの 

ベース信号の周波数に配置されます。 

リミットは、リミットテストのための上下 TOI 積上に

設定できます。  

パラメータ Reference Lower リファレンスレベルを最も低い

ベース信号に設定します。 

Reference Upper リファレンスレベルを最も高い

ベース信号に設定します。 

 
Limit Pass/Fail テストのリミットを

dBm で設定します。 

 
Pass/Fail Test Pass/Fail テストの有効/無効を

設定します。 

測定項目 Base Upper 周波数、dBm、dBc 

Base Lower 周波数、dBm、dBc 

 
3rd Order Lower 周波数、dBm、dBc、limit、 

Intercept point 

 
3rd Order Upper 周波数、dBm、dBc、limit、 

Intercept point 

 
Δf 周波数 
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例 

3rd Order Upper
Base Lower

3rd Order Lower

リミット

Base Upper

Δf

操作： 1. > TOI[F6]>TOI[F1] の順で押し、TOI をオン

にします。a  

その他の測定モードは、自動的に無効になります。 

 2. 画面が上下 2 画面に分割されます。 

画面上部は、上部および下部ベース周波数と上下

の 3 次相互変調積をマーカ付きトレースで表示し

ます。 

画面下部は、TOI 測定と Pass/Fail テスト結果を表

示します。 

TOI測定と判定結果

3rd Order
lower

marker

Lower and
upper base

3rd Order
upper
marker
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 3. Reference[F2] を押し、上部または下部のベース周

波数にリファレンスを設定します。 

 アイコンが選択した上部または下部リファレンス

の隣に表示されます。 

 4. Limit[F3] を押し、上下 3 次相互変調積振幅のため

のリミットを設定します。 

 5. Pass/Fail Test[F4] を押し、Pass/Fail テストのオン

/オフを切り替えます。 

 Pass または  Fail アイコンが上記で設定され

たリミットに応じて表示されます。 

CNR/CSO/CTB 測定 

CN 比（Carrier to Noise Ratio：CNR) 
 

概要 CN 比（搬送波対雑音比）は、送信中に存在する 

キャリア信号とノイズレベル間の振幅差を計算しま

す。  

CNR 測定は、アナログおよびデジタル CATV の両

方で使用さます。 

パラメータ Noise Marking 2 つのオプションを使用して 

デルタマーカ(Δ1)の位置を設定

します。： 

 

MIN： 

デルタマーカは、キャリア周波

数とキャリア周波数+4MHz の

間の最少値を検索します。 

 

ΔMarker： 

ユーザー定義のデルタマーカ
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位置 

測定項目 Visual Carrier 周波数、振幅 

CNR 振幅差 

 
Δf ビジュアルキャリアとノイズマー

カ間の周波数差。 

例 

C
N

R
 dB

1

Δ1

Δf

Visual carrier marker

Noise 
marker

Color subcarrier, 
aural carrier

Channel 
spacing

To next main channel

操作： 1. >More[F7]>CNR/CSO/CTB[F1]> 
Setup[F1]> CNR[F1] の順で押し、CNR 測定を選

択します。  

2. Noise Marking[F1] を押し、ノイズマーカタイプを

Min またはデルタマーカに切り替えます。  

3. MIｎを選択した場合、Return[F7] を押し、前の 

メニューへ戻ります。 

4. デルタマーカを選択した場合、 > Delta[F4] 
>Delta[F1] を押しデルタマーカ位置を設定します。

マーカ移動の詳細については、93 ページを参照くださ
い。 

> CNR/CSO/CTB[F7] 順で押し、前の 

メニューへ戻ります。 
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 5. CNR[F2] を押し、CNR をオンにします。 

• その他の測定モードは、自動的に無効になります。  

• CNR がオンにされる前に、音声とカラーサブキャリ
アが無効になっていることを確認してください。 

 6. 画面が、上下 2 画面に分割されます。 

画面上部は、ビジュアルキャリアマーカとノイズ 

マーカとトレースが表示されます。画面下部には、

CNR 測定値を表示します。 

CNR測定

Visual carrier
marker

Noise
marker

 7. CNR CH SP[F2] を押し、チャンネルスペースを設

定します。 

 

 範囲： 0～3.25GHz  

 8. Channel Move Down[F4] または Channel Move Up 
[F5] を押し、次または前のチャンネルへ移動しま

す。 
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 注意 
CNR 測定を行うとき、音声とカラーサブキャリアが

無効になっていることを確認してください。 

複合 2 次歪(CSO) 
 

概要 複合二次歪測定は、キャリア信号と複合二次歪 

ビート間の振幅の差を計算します。 

パラメータ CSO CH SP：チャンネルスペース 

測定項目 Visual Carrier：周波数、振幅 

Channel Space：周波数 

CSO：振幅差 

例 
C

S
O

 
dB

操作： 1. > More[F7]>CNR/CSO/CTB[F1]> 
Setup[F1]> CSO[F2] の順で押し、CSO を選択しま

す。 

2. CSO[F2] を押し、CSO をオンします。  

その他の測定モードは、自動的に無効になります 。 

 3. 画面が上下 2 画面に分割されます。 

画面上部は、ビジュアルキャリアマーカと CSO 

ビートマーカとトレースが表示されます。 

画面下部には、CSO 測定を表示されます。 
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CSO測定

Visual carrier
marker

CSO beat
marker

 4. CSO CH SPC[F3] 押し、チャンネルスペースを設

定します。  

 

 範囲： 0～3.25GHz  

 5. Channel Move Down[F4] または Channel Move Up 
[F5] を押し、次または前のチャンネルへ移動しま

す。 

 

複合 3 次歪（Composite Triple Beat：CTB) 
 

概要 複合 3 次歪測定は、ビジュアルキャリアと複合 3

次歪振幅との振幅差を計算します。 

測定項目 Visual Carrier：周波数, 振幅 

CTB：ビジュアルキャリアと複合 3 次歪振幅との 

   振幅差 

Triple Beat: 振幅 
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例 

操作： 1. > More[F7]>CNR/CSO/CTB[F1]> 
Setup[F1]> CTB[F3]>Return[F7] の順で押し、CTB

測定を選択し前のメニューへ戻ります。 

2. CTB[F2] を押し、CTB 測定をオンにします。  

その他の測定モードは、自動的に無効になります。 

 3. 画面が上下 2 画面に分割されます。 

画面上部は、ビジュアルキャリアマーカとトレースを

表示します。 

画面下部は、CTB 測定を表示します。 

ビジュアルキャリア上にマーカ( )を設定し、振幅を記
録します。 

CTB測定

Visual carrier
marker

CTB beat
marker
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 4. 入力信号からビジュアルキャリア信号をオフし前面

パネルの  キーを押します。 

5. CTB の振幅をマークするために第 2 トレースを表

示します。 

第 2 トレースにマーカ( )を設定し差( - ).を計算しま
す。 

 6. CTB CH SP[F2] を押し、チャンネルスペースを設

定します。 

 範囲： 0～3.25GHz  

 7. Channel Move Down[F4] または Channel Move Up 
[F5] を押し、次または前のチャンネルへ移動しま

す。 

 

 注意 
再度、CTB 測定を実行するには、 

Setup[F1]>CTB[F3]> Restart[F1]. を押します。 

高調波測定 
 

概要 高調波測定機能は、基本周波数の振幅と第 10 次

高調波までの高調波を簡単に測定できます。 

また、この機能は基本波(dBc)に対する相対的な振

幅と全高調波歪み（THD）を測定することができま

す。 
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測定項目 振幅 各高調波の振幅(dBm). 

dBc 基本波に対する相対的な各高

調波の振幅 

 THD 各高調波の振幅を二乗しその

和の平方根を、基本周波数の

振幅で割ったものです。 

例 基本周波数

1st, 2nd, 3rd, 4th, …......10th

高調波

dB
c

操作 1. > More[F7]>Harmonic[F2]>Harmonic[F1] を
の順で押し、高調波測定をオンします。 

• その他の測定は、自動的に無効になります。 

2. 画面が上下 2 画面に分割されます。 

画面上部には、基本測定（1）および高調波周波数

（2～10）の各高調波をバーグラフで表示します。 

画面下部は、振幅、dBc と THD の値を表示しま

す。 
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高調波測定

基本周波数
N次高調波

 

3. Fundamental Freq.[F2] を押し、基本周波数を設定

します。 

 4. Number of Order[F3] を押し、測定する高調波の数

を設定します。 

• 高調波周波数の設定数は、THD 測定に影響を与
えます。 

 5. RBW[F4] を押し、分解能帯域幅を Auto または

Man(手動)に設定します。 

RBW の手動設定では分解能帯域幅と単位を設定

します。 

RBW の設定は、THD 測定に影響を与えます。 

 モード： 

周波数範囲(3dB): 

Auto, Man 

10kHz～1MHz (1-3-10 

step) 

N dB 帯域幅 
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概要 N dB 帯域幅測定は、ピークの頂点から、指定され

た振幅（N dB）をカバーする周波数帯域幅を測定

するために使用します。 

例 

操作 1. > More[F7]>NdB Bandwidth[F3]> NdB 
BW[F1] の順で押し、N dB BW をオンにします。  

• その他の測定モードは、自動的に無効になります。

2. 画面は、上下 2 画面に分割されます。 

画面上部には、NdB と NdB BW のマーカとトレース

を表示します。 

画面下部には、リアルタイムで N dB の測定結果を

表示します。 

N dB BW測定

NdB BW
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3. NdB[F2] を押し NdB を設定します：  

 振幅： 0.1dB～80.0 dB 

 注意 
N dB 帯域幅の測定は、大きく RBW と VBW に関連

付けられています。  

P1dB 測定(トラッキングジェネレータ付きモデル) 
 

概要 P1dB compression point は、アクティブな DUT の

利得が入力に対する理想的な線形利得（または小

信号利得）より 1 デシベル小さいポイントのことで

す。 

例 

1dB

出
力
パ
ワ
ー

(d
B

m
)

入力パワー (dBm)

P
1d

B

DUT
の応答

理想
的な
応答

小信
号利
得
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P1dB Connection 

の設定 

RF 入力に DUT を接続します。 

トラッキングジェネレータの出力を DUT の入力に

接続します。 

必要に応じて、前面パネルにある DC 出力を DUT

の電力供給として使用できます。 

RF入力

GSP-VT/VGT

DUT

TG

出力
DC OUT*

 

*必要な場合は DC 電圧出力を使用できます。 

操作 1. > More[F7]>P1dB[F4]>P1dB[F1] の順で押

し、P1dB をオンにします。 

• その他の測定は、自動的に無効になります。 

• トラッキングジェネレータをオンにする必要はありま
せん。 

2. 画面は、上下 2 画面に分割されます。 

セットアップが完了した後（ステップ 3 を参照）、画

面上部に赤色で理想的な応答と実際のトレース

（黄色）を表示します。 P1dB 測定は、緑色で表示さ

れます。 

画面下部には、リアルタイムで P1dB の測定結果

を表示します。 
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P1dB測定

1dB

 

測定結果は、-30dBm から 0dBm まで 1dB ステッ

プで増加し全部で 31 ポイントを表示します。 

各列は、左側に入力電力を表示し右側はゲインを

表示しています。 

白色で表示されたゲインは、実効利得です。同時

に紫色で表示されたゲインは無効ゲインです。 

また、平均利得、P1dB ポイント（Pout と、1dB）での

出力電力と P1dB ポイントでの入力電力の結果を

表示しています。  

 3. P1dB Setup[F2] を押し、P1dB 設定を設定します。 

 4. Center Freq[F1] を押し、センター周波数を設定し

ます： 

 周波数： 0～3.25GHz 

 5. Gain Offset[F2] を押し、理想的な線形応答のオフ

セットゲインを設定します。. 

 ゲイン： -99.00dB～99.00 dB 

 6. 実際の周波数応答を滑らかにし、より正確な P1dB 
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compression point 測定を補助するために、 

Average[F3] を押し、平均回数を設定します。 

Start が-50dB 付近に設定されている場合に特に

便利です。 

 平均回数： 1～200 

 7. Start[F4] を押し、P1dB 測定の“開始”出力電力を

設定します。 

 開始電力： -50dB～-5dB 

 8. Reset[F5] を押すと、直ちに P1dB 測定を再スター

トします。  

 警告 
等価利得が 30dBm を超えた場合、波形表示エリア

は、赤色で縁取られ入力が特定レベルを超えたこ

とを示します。 

 注意 
前面パネルの DC 出力端子の最大電力は、DC 

7V/500mA です。 

P1dB ノーマライズ 
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概要 ノーマライズ機能は、長いケーブル損失など不正

確な測定の原因を補償するために使用します。 

この機能は、DUT が直接、TG または RF 入力のい

ずれかに接続されているかに依存しています。 

DUT（入力または出力）との関係で長いケーブルの

位置は、P1dB 出力測定に影響を与えます。 

ケーブルが DUT の入力に接続されている場合、信

号が DUT に入力される前にケーブルのライン損失

により TG の出力が減少します。ノーマライズ（正規

化）されていない場合、この設定（接続=前方）は、

P1dB ポイントの位置に影響を与えます。 

同様に、ケーブルが DUT の出力に接続されている

場合、DUT の利得は、ケーブルのライン損失によ

り RF 入力で減衰します。この構成（接続=後方）で

は、P1dB ポイントは影響を受けません。 

 注意 
TG 出力または RG 入力に直接 DUT を接続できな

い場合、ケーブル損失の影響を低減することがで

きるように最短のケーブルを使用してください。 

ノーマライズ機能を使用する場合、短いケーブルの

ライン損失を測定することはができません。  

例 1 接続 = 前方 

1dB

出
力
パ
ワ
ー

(d
B

m
)

入力パワー (dBm)

ノ
ー
マ
ラ
イ
ズ
し
た

P1
dB

ノーマライズした
DUTの応答

理想

DUT入力前段の
ライン損失のある
DUT応答

理想

1dB

マ
ラ
イ
ズ
し
て
い
な
い
 

P
1d

B
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例 2 接続 = 後方 

1dB

出
力
パ
ワ
ー

(d
B

m
)

入力パワー (dBm)
P

1d
B

ノーマライズした
DUT応答

理想

DUT出力後段のライン損失
のあるDUT応答

理想

1dB

 注意 
この機能は、P1dB がオンの時しか使用できませ

ん。  

操作 1. DUT と TG 間に接続するケーブルおよび RF 入力

に接続する別のケーブルを接続します。 

 

2. > More[F7]>P1dB[F4] >Normalize[F3]. の順

で押します。 

3. Execute Norm[F1] を押します。 

ケーブル損失をノーマライズします。 

ケーブル損失が、Execute Norm アイコンに表示さ

れます。 

 

4. 次に DUT を TG または RF 入力のいずれかに直
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接接続します。（図 A、B） 

DUT の場所は、ケーブル損失がノーマライズされ

た DUT の前後いずれかを決めます。 

 

DUT が接続されている場所に応じて、RF ケーブル

を TG または RF 入力のいずれかへ DUT からの接

続します。 

 接続 = 前方 接続 = 後方 

 

 5. 上図のように、Location[F2] で DUT の接続場所に

従って PREV または POST を設定します。  

6. Norm.[F3] を押し、オンにします。 

7. ケーブル損失が DUT が配置されている場所に基

づき正規化されます。 
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EMC プリコンプラいナンステスト  
本器の EMC プリテスト機能は、試験、デバッグ、または放射または伝

導エミッションだけでなく、イミュニティ試験のトラブル評価をするための

総合的テスト機能です。 

EMC プリテスト機能は、主に 5 つの機能に分かれています： 

EMI テスト、フィールドセンサ、ソースコンタクトプローブ、AC 電圧プロー

ブおよび EMS 試験 

EMI テスト機能は、放射または伝導エミッション試験を行うために使用し

ます。これらのテストは、テスト対象の EN 規格と FCC 規格の複数の設

定をサポートしています。 

 

フィールドセンサ機能を使用すると、複数の EN 規格および FCC 規格

の 3 メートルと 10 メートル放射エミッションをシミュレートすることができ

ます。 

 

ソースコンタクトプローブ機能は、GW Instek 製 EMI-E プローブを使用し

た電磁エミッションのソースをデバッグするのに使用できます。 

また、この機能は EN または FCC は放射エミッション規格に対するテス

トを可能です。 

AC 電圧プローブ機能は、GW Instek 製 AC 電圧プローブを使用するこ

とで LISN デバイスを使用するようなコストのかかる伝導放射テストでは

なく、電力線から伝導エミッションを評価することができます。また、DUT

上の伝導性エミッション源をデバッグするのに使用できます。 

 

トラッキングジェネレータ（TG）を装備するモデルでは、EMS テスト機能

により TG をユーザー定義の特性で出力させることにより、DUT の放射

イミュニティ（感受性）をデバッグできます。 

 

放射ノイズのための EMI テスト →203 ページから 

Near Field テスト ~ フィールドセンサ →209 ページから 

ニアフィールド試験 ~ ソースコンタクトプローブ →212 ページから 

AC 電圧プローブ Conducted Emissions Estimation →215 ページから 
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EMS テスト：感受性のデバッグ →218. ページから 

EMI テスト 
 

概要 EMI テスト機能は、放射または伝導性エミッション

試験用の EMI 予備試験の手順を大幅に簡略化す

ることができます。 

試験周波数帯域（6 個のプリセットとユーザー定

義）、試験規格（プリセット）と補正係数を決定する

だけです。 

また、ピークテーブル機能や、画面表示を対数表

示にできます。  

 注意 
以下の手順は、放射や伝導エミッション試験の実

施方法に精通しており、さまざまな放射規格に精通

していることを前提としています。  

EMI テストの概要 一般的に EMI テストは、4 種類の異なるテストに分

かれています： 

放射エミッション、放射性イミュニティ、伝導性エミッ

ション、伝導性イミュニティテスト。 

EMI テスト機能は、主に放射エミッションに関連し、

少しだけ伝導エミッションも関連します。 
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放射エミッション

試験 

以下は、放射テストの基本的な概要です。 

様々な規格がり、それぞれに特定のテスト構成と

方法があります。 

ほとんどの放射試験は、電波暗室またはオープン

サイトで行われテストエリアのサイズと試験装置の

位置は各規格により異なります。 

設定例を以下に示します 

DUT とアンテナをグランドプレーン（接地平面）上に

配置します。DUT を非導電性の台に配置し、DUT

とアンテナ間を 3 メートルまたは 10 メートルに配置

します。アンテナの位置を適用規格で指定されてい

る高さに設定します。アンテナを垂直位置で一度、

水平にして一度配置します。各テストの後に、DUT

を 45°回転させます。 

DUT

3mまたは10m

アンテナ

GSP

グランドプレーン
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伝導性 

エミッション 

伝導エミッション試験のためには、LISN（ラインイン

ピーダンス安定化ネットワーク）が必要です。  

LISN は、主に 2 つの理由から使用されます。 

第一に、DUT に供給される主電源からのノイズを

除去するために使用します。 

第二に、LISN は主電源に接続した DUT の RF ノイ

ズをフィルタリングし LSIN に接続され測定器（スペ

クトラムアナライザやレシーバや）に送ります。 

また、通常リミッタは、測定器（スペクトラムアナライ

ザなど）に入力する信号を安全なレベルに減衰す

るために使用します。 

GSP DUTLISN

主電源

リミッタ*
 

*必要に応じてリミッタを挿入します。 

操作 1.  > EMC On[F1]>EMI Test[F2] の順で押しま

す。 

テストに使用する周波数帯域を選択します。 

選択した試験周波数は、どの規格で測定するかに

基づき放射試験、伝導試験やユーザー定義などを

決めます。  

 EMI テスト周

波数 

電動テスト： 

9k～150kHz,  

150k～30MHz 

放射テスト： 

30M～300MHz, 

300M～1GHz, 

30M～1GHz,    

1G～3GHz. 

周囲雑音除去 2. Amb.Noise Reject[F2] を押し、周囲雑音除去を 

オンします。この機能は、基本的に RBW を 9kHz

に設定し、30MHz から 3GHz 間の帯域幅のノイズ

フロアを低減します。 
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この機能は、オープンな環境を電波暗室として 

エミュレートすることができます。 

アンテナ係数 

または LISN 補正

係数の設定 

3. Correction[F3] を押し、使用するアンテナ、LISN ま

たはアンテナ位置に基づいて補正係数を適用しま

す。 

使用可能なオプションは、事前に選択した EMI テス

ト周波数に依存します。 

 None[F1] 補正なし。 

補正機能をオフにします。 

 Horizontal[F2] 放射エミッション試験用。 

これは、アンテナが水平位置のと

きの補正セットです。 

この補正セットは、GW Instek 製 

アンテナ（※）でみの適用されるよ

うに構成されています。  

 Vertical[F3] 放射エミッション試験用。 

これは、アンテナが垂直位置のと

きの補正セットです。 

この補正セットは、GW Instek 製 

アンテナ（※）でみの使用されるよ

うに構成されています。 

 Other 

factor[F4] 

他社製アンテナで使用するカスタ

ムセット補正の読み込み、または

作成をします。  

 Cor.factor[F2] LISN デバイス用カスタム補正セッ

トの読み込み、または作成をしま

す。 

 上記で Other factor[F4] または Cor.factor[F2] を
選択した場合、補正セットを選択するかまたは既存

の補正セットを編集し Correction[F2]をオンに設定

します。  

 

Return[F7] を押すと前のメニューへ戻ります。 

正セットの作成または編集の詳細については、52 ペー
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ジを参照ください。 

リミットの呼出 4. Recall Limit[F4] を押し、EN55022A/B または FCC 

A/B リミットラインを画面に追加します。 

追加されたリミットラインは、選択された試験周波

数範囲に一致します。  

 None リミットラインなし 

 EN5502A Euro commercial standard 

 EN5502B Euro residential standard 

 FCC A American non-residential standard 

 FCC B American residential standard 

 5. 選択した規格に対するディテクタのリミットを

Average[F1] または Quasi-peak[F2] または

Both[F3]Average[F1]から選択します。 

これらの設定が使用できるかは、前に選択した

EMI テスト周波数に依存します。 

 ディテクタ： Average, Quasi-peak, Both. 

 6. Recall Limit[F4]リをオンにすると、選択した規格に

基づいてスイープ毎に Pass/Fail テストを実行し表

示ます。   

 Pass:  表示と緑色の画面枠。 

 Fail: 表示と赤色の画面枠。 

アイコン表示 
 

Recall Limit[F4]がオンになるとアラーム 

アイコンが画面下部に表示されます。 
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例 リミットライン

Pass/Fail判定とアラーム表示

トレース
規格

 

7. Peak Table[F5] を押しピークテーブルをオンしま

す。 

ピークテーブル表示は、画面を上下 2 分割し 

画面上部に 10 個のピークマーカを表示し、下部画

面にマーカ番号、Pass/Fail、周波数と振幅を一覧

表示します。

スペクトラム表示

ピークテーブル
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 8. Scale Type[F6] を押し周波数スケールをリニアま

たはログに設定します。 

ログ周波数スケールは、コンプライアンス試験でし

ばしば用いられます。 

 9. いずれかの試験が Fail の場合、試験が失敗した原

因を見つけるために、フィールドセンサ、ソースコン

タクトプローブまたは AC 電圧プローブ機能を使用

して試験が NG になった原因を見つけて修正し、再

試験します。 

Near Field テスト ~ フィールドセンサ 
 

概要 フィールドセンサ機能は、放射コンプライアンス試

験を行う前に、強磁界発生源を絞り込むために、

GW Instek 製フィールドセンサ（※）のいずれかを使

用することで 3 メートルまたは 10 メートル放射エミ

ッションをシミュレートすることができます。 

磁界発生源は、高電流が流れる PCB トレースなど

のような高電流、低電圧源によって特徴付けられ

る。 

 注意 
3 メートルと 10 メートルのシミュレート結果は、GW 

Instek 製 フィールドセンサアンテナ（※）のプローブ

係数に基づいているため、GW Instek 製 M プロー

ブ ATA-04 または ATA-05（※）でのみ使用できま

す。  
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セットアップ例 DUT の電源をオンにし、フィールドセンサを DUT と

並行にスキャンします。 

DUT からプローブの反応は、異なるいくつかの要

因により変動することがあります： 

 プローブの位置 

 DUT の位置 

 DUT の動作状態 

 使用しているプローブのサイズ 

 適用した規格のテスト周波数と帯域 

操作 1. >EMC On[F1]>Field Sensor[F3]> Band[F1]>
を押し、周波数帯域またはユーザー定義を選択し

ます。  

 フィールドセンサの 

テスト周波数 

30M～300MHz 

300M～1GHz 

30M～1GHz 

Ueser Define 

補正セット 2. Correction[F2] を押し、そのままニアフィールド試

験結果を観測するか、またはニアフィールドテスト

に基づいてシミュレートした放射結果として表示す

るかを選択します。  

 None[F1] 補正を使用しない 

 3m[F2] ニアフィールドエミッションに基づいてシ

ミュレートした 3 メートル放射エミッショ

ン 
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 10m[F3] シミュレートした 10 メートル放射エミッ

ション 

 Other 
factor[F4]

補正セットを作成、編集または選択しま

す。 

サードパーティ製の M-フィールドアンテ

ナを使用する場合、このオプションが便

利です。 

補正セット作成の詳細については、52

ページを参照してください。 

このオプションでは、3 メートルや 10 メ

ートルの放射エミッションをシミュレート

することはできません。 

各規格のリミット 3. Recall limit[F3]を押し、いずれかのリミット規格を選

択し規格のリミットラインを表示させると試験の

Pass/Fail を開始します。これらのリミットラインは、

3m と 10 メートルの補正セットが使用されるときに

のみ使用します。  

 EN5502A Euro commercial standard (10m) 

 EN5502B Euro residential standard (3m) 

 FCC A American non-residential standard 

(10m) 

 FCC B American residential standard (3m) 

 Pass/Fail テストは、選択された規格に基づいてス

イープ毎にシミュレートされた放射エミッションで実

行します。 

 Pass:  表示と緑色の画面枠。 

 Fail: 表示と赤色の画面枠。 

アイコン表示 
 

規格を選択するとアラームアイコンが画面

下部に表示されます。 
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例 リミットライン

Pass/Fail判定とアラーム表示

トレース

規格

ニアフィールド試験 ~ ソースコンタクトプローブ 
 

概要 ソースコンタクトプローブ機能は、コンプライアンス

試験前に強電界の発生源を絞り込むことために、

電界（E-フィールド）のニアフィールド試験を実行す

ることができます。 

フィールドのこれら種類は、通常、ハイインピーダン

ス部品に接続されたトレース、終端されていない 

ケーブルまたは論理回路からの 3 値出力に見られ

ます。 
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セットアップ例 DUT の電源を入れ、PCB のトレース、PCB のピ

ン、I / O ケーブルのピンまたはその他の露出した

導体の一方など、どこにでもソースコンタクトプロー

ブ PR-02 をタッチさせます。 

 

 警告 
ソースコンタクトプローブを使用する場合は、本器

の RF 入力を保護するために、トランジェントリミッタ

やその他 DC ブロックを利用してください。 

操作 1. >EMC On[F1]>Source Contact Probe[F4]> 
の順で押し、試験する周波数帯域を選択します。 

 ソースコンタクト 

テスト周波数 

30M-300MHz, 

300M-1GHz 

User Define 

 2. 次に、PCB TracePin[F2]または I/O Cable Pin[F2]
を押し、E フィールドプローブを使用する E フィール

ドソースの種類を選択します。 

 PCBtracePin[F2] PCB トレース/ピンに使用 

 I/OCablePin[F3] 入出力ケーブル/ピンに使用 

補正セット 3. Correction[F1]を押し、PCB トレース/入出力ケーブ

ルの長さを選択します。 

この機能は、これらのポイントから放射される放射

エミッションを推定するソフトウェアを補助します。 
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PCBtracePIN 用 None[F1] 補正を使用しない 

 20cm trace[F2] 約 20cm のトレース 

 15cm trace[F3] 約 15cm のトレース 

 10cm trace[F4] 約 10cm のトレース 

 6cm trace[F5] 約 6cm のトレース 

 4cm trace[F6] 約 4cm のトレース 

I/OCablePIN 用 None[F1] 補正を使用しない 

 2m cable[F2] 約 2m のケーブル 

 1.5m cable[F3] 約 1.5m のケーブル 

 1m cable[F4] 約 1m のケーブル 

 0.5m cable[F5] 約 0.5m のケーブル 

規格のリミット 4. Recall limit[F2]を押し、いずれかのリミット規格を選

択し、規格のリミットラインを表示し、Pass/Fail 試験

を開始します。 

 EN5502B Euro residential standard (3m) 

 FCC B American residential standard (3m) 

 Pass/Fail 試験は、選択した規格に基づいて、各ス

イープ後にシミュレートしたエミッションを実行しま

す。  

 Pass:  表示と緑色の画面枠。 

 Fail: 表示と赤色の画面枠。 

アイコン表示 
 

規格を選択するとアラームアイコンが画面

下部に表示されます。 
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例 

リミットライン

AC 電圧プローブ：伝導エミッション 
 

概要 AC 電圧プローブ機能は、DUT の伝導エミッション

のプリテストを実行するために使用します。 

この機能の特別な利点は、伝導エミッションのプリ

テストを LISN を必要とせずに行うことができること

です。 

この機能では、GW Instek 製 EMIAC 電圧プローブ

（GW Instek 製 GKT-008 プローブセットの PR-01*）

でのみ実行可能です。  

テスト例 この試験を実行するには、DUT の入力電力のライ

ン、ニュートラルまたはグラウンドラインに電圧プロ

ーブをタッチします。この試験を実行しているとき

DUT の電源がオンになっている必要があります。

安全のため、パススルー型の電源プラグアダプタ

を使用する必要があります。
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Transient 
Limiter

Mains power DUT

GSPL

 警告 
ライン入力を AC 電圧プロー

ブで試験する場合、ライン、

ニュートラルまたはアース線

へパススルー型電源プラグア

ダプタを使用するようにしてく

ださい。 

このタイプのアダプタを使用

すると、安全に入力電源ライ

ンを試験することができま

す。 

このプラグは、GW Instek 製

品にはありません。 

Pass through

.

 警告 
AC 電圧プローブ PR-01 は、主電源（AC100～

240V）に接続される一般的な電気機器にのみ使用

します。試験するときには、感電を防ぐために湿

気、雷、水またはその他の危険な条件にならない

ように十分注意する必要があります。 

警告 
測定中のプローブを保持する場合、プローブ（プローブ

の先端）上に安全記号が書かれているところより後を

保持するようにしてください。

 

マークより後ろ 
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 警告 
スペクトラムアナライザの RF 入力を保護するため

に、プローブと RF 入力の間にランジェントリミッタ

や DC ブロックなどを使用してください。 

操作 1. >EMC On[F1]>AC Voltage Probe[F5]> を押

し Pretest[F3]または Debug[F4]を選択してくださ

い。  

 Pretest プリテストオプションは、AC ラインのラ

イブで使用します。 

この機能は、LISN 装置を使用せずに

伝導エミッション試験を推定が可能で

す。 

この機能は、GW Instek 製 GKT-

008 の AC 電圧プローブ PR-01 のみを

サポートしています。  

 Debug スポットテスト電位は、DUT の AC 電源

部品上の伝導エミッションを測定しま

す。この機能は、伝導 RF の潜在的な

発生源を分析するのに有効です。  

リミットの呼出と

Pass/Fail テスト 

2. Recall Limit[F5] を押し、EN55022A/ B または FCC 

A/ B のリミットラインを選択します。画面に選択し

た規格のリミットラインが表示され Pass/Fail テスト

を開始します。  

 EN5502A Euro commercial standard (10m) 

 EN5502B Euro residential standard (3m) 

 FCC A American non-residential standard 

(10m) 

 FCC B American residential standard (3m) 

 Pass/Fail テストはまた、選択した規格に基づいて、

各スイープでシミュレートされた放射で判定を実行

します。  
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 Pass:  表示と緑色の画面枠。 

 Fail: 表示と赤色の画面枠。 

アイコン表示 
 

規格を選択するとアラームアイコンが画面

下部に表示されます。  

例 

トレース

EMS テスト 
 

概要 EMS 試験機能は、GW Instek 製 GKT-008 のフィー

ルドセンサ*を使用し DUT のイミュニティ（妨害感受

性）をデバッグすることが可能です。 

テスト機能は、ユーザ定義の信号強度でユーザー

定義の周波数掃スイープ範囲を出力することがで

きます。 

EMS テストを実行するには、TG 付きのモデルが必

要です。  
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セットアップ例 このテストのセットアップは簡単です。 

DUT の電源を入れ、プローブで DUT をスキャンし

ます。 

プローブからの出力に対して DUT の異常な応答を

観測します。 

操作 1. > EMS Test[F6]. を押します。 

 2. 80MHz-300MHz[F3], 300MHz-1GHz[F4] または

80MHz-1GHz[F5] を押し、プリセットされた周波数

範囲を選択しスイープを開始します。もう一度押す

とストップします。 

 3. あるいは、User Define[F6]を押し、ユーザー定義の

周波数スイープ範囲を設定します。 

 4. SRC FreqStart[F1]を押し、スイープのスタート周波

数を設定します。 

 Start Freq. 0Hz～3.25GHz 

 5. SRC FreqStop[F3]を押し、スイープのストップ周波

数を設定します。 ストップ周波数は、スタート周波

数より 100Hz 以上高い必要があります。 

 Stop Freq. 100Hz～3.25GHz 
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 6. Run Stop[F3] を押し、周波数スイープを開始しま

す。もう一度押すとスイープを停止します。 

 注意 
周波数は、選択した範囲のスタート周波数（最低周

波数）からストップ周波数（最高周波数）を 1％増加

ステップでスイープします。最高周波数に達する

と、スイープサイクルは、最小周波数から再び開始

します。 

 7. Source Strength[F2]を押し、TG の出力パワーを設

定します。  

 Power： 3V/m, 1V/m 

 単位： V/m 

 8. EMS Source[F1] を押し、ソースをオンにしテストを

開始します。 

9. プローブから信号が出力開始されたときに、DUT

が正しく動作しているかを確認してください。 

例 
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リミットラインテスト 
リミットラインは、全周波数範囲にわたって上限または下限の振幅リミッ

トを設定をするために使用します。 

リミットラインは、入力信号がリミットラインより上または下かリミットライ

ン内であるかを検出するために用います。 

リミットラインは、手動または自動で作成できます。 

リミットラインは、手動で周波数、トレースデータまたはマーカポイントか

ら編集することができます。.  

  

リミットを作成する (ポイントごと) →221 ページから 

リミットラインを生成する (トレースデータから) →223 ページから 

リミットラインを生成する(マーカデータから) →224 ページから 

リミットラインを生成する(マーカデータから) →224 ページから 

リミットラインの削除 →226 ページから 

Pass Fail テスト →226 ページから 

リミットを作成する (ポイントごと) 
 

概要 リミットを手動で 1 ポイントごとに作成します。  

最大 10 ポイントまで作成できます。 

操作 1. > Edit Select Limit[F1]>Limit Line [F1]  を
押し、リミットライン番号を選択します。  

 リミットライン： 1～5 

 2. Point by Point[F2].を押します。 

画面が上下 2 つに分割表示されます。 

画面上部に、トレースとリミットラインを表示します。 

画面下部にリミットラインテーブルを表示します。 
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スペクトラム表示

リミットラインテーブル  

3. Point Num[F1] 押し、ポイント番号を数値キーで入

力し編集します(必ず 1 番からスタートしていくださ

い)。 

4. Frequency[F2] を押し、ポイントの周波数を入力し

ます。 

5. Limit[F3] を押し、ポイントの振幅値を入力します。

入力したポイント（最大 10 ポイント）が画面下部に

リミットラインテーブルに表示されます。 

6. 残りのポイントをステップ 3 から 5 を繰り返して入

力します。（最大 10 ポイント。ポイント。番号順での

み作成できます。） 

7. 入力したポイントを削除するには、Point Num[F1] 
押して番号を指定するかスクロールノブを回して番

号を選択し、Delete Point[F6].を押し選択したポイ

ントを削除します。 

8. Return[F7]>Save Limit Line[F5] を押し、現在選択

しているリミットライン番号を保存します。 
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 注意 
リミットラインは、自動的に周波数順で並べ替えさ

れます（低い→高い） 

リミットラインを生成する (トレースデータから) 
 

概要 リミットラインは、トレースデータを使用して生成す

ることができます。  

スタート周波数からストップ周波数の各グリッド（目

盛）上のトレースデータから自動的に 10 ポイントの

リミットラインを生成します。 

操作 1. > Edit Select Limit[F1]>Limit Line [F1]  を
押し、リミットライン番号を選択します。  

 リミットライン： 1～5 

 2. Trace Data to Limit Line[F3] を押します。 

画面が上下 2 分割されます。 

画面上部には、トレースとリミットラインを表示し、

画面下部にはリミットラインテーブルを表示します。 

スペクトラム表示

リミットラインテーブル  

3. Limit Offset[F2] を押し、トレースに対するオフセッ
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トレベルを入力します。  

4. Create Limit Line Now[F1]. を押しトレースを自動

的に生成します。 

 
リミットラインがトレースとオフセットレベルに基づいて
自動的に作成されます。 
リミットラインは、Create Limit Line[F1]を押すたびに何
度でも作成することができます。. 

5. Return[F7]>Save Limit Line[F5] の順で押し、現在

選択されているリミットラインを保存します。 

リミットラインを生成する(マーカデータから) 
 

概要 マーカーデータからリミットラインを作成することが

できます。 

マーカの詳細は、92 ページのマーカの章を参照し

てください。 

リミットラインのポイントを最大 10 ポイントまで生成

できます。  

操作 1. > Edit Select Limit[F1]>Limit Line [F1]  を
押し、リミットライン番号を選択します。a  

 リミットライン： 1～5 

 2. Mkr Data to Limit Line[F4].を押します。 

画面が上下 2 分割されます。 

画面上部にトレースとリミットラインを表示され、 

画面下部にリミットラインテーブルが表示されます。
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スペクトラム表示

リミットラインテーブル  

3. Point Num[F1] を押し、編集するポイント番号を選

択します。（必ず 1 番から開始してください） 

4. Limit Offset[F3] を押し、ポイントのオフセットレベ

ルを入力します。  

• この値は、現在選択しているポイントに対してのみ
です。すべてのポイントに対してオフセットは作成され
ません。 

5. Mkr Data to Point[F2]. を押し Enter キーを押し確

定します。 

この機能は、現在アクティブなマーカ位置（周波

数、レベル+オフセット値）を選択したポイントに追加

します。 

6. マーカの位置は、スクロールノブで移動させること

ができます。 

7. ステップ 3 から 6 を繰り返し、その他のポイントを

設定します。（最大 10 ポイント  

8. Return[F7]>Save Limit Line[F5] の順で押し、現在

選択されているリミットラインを保存します。 
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 注意 
この機能を使用すると、リミット機能の外にマーカ 1

の位置を変更します。  

リミットラインの削除 
 

概要 5 個のリミットラインは、番号を指定し削除できま

す。  

リミットラインを選

択します。 
1. > Edit Select Limit[F1]>Limit Line[F1] の順

で押し、削除したいリミットライン番号（1～5）を選択

します。  

2. Delete Limit Line[F6]を押します。 選択したリミット

ライン番号が削除されます。 

Pass Fail テスト 
 

概要 Pass/Fail テストを開始の前に、上限/下限リミット

のためのリミットラインを先に保存しておく必要があ

ります。リミットラインの保存については、221, 223 

と 224 ページを参照ください。  

操作 1. >Pass/Fail Test.を押します。 

2. 上限リミットを設定するには High Limit[F1] を押し、

上限（ハイ）リミットとしてリミットラインを 1 つ選択し

ます。 

3. 下限リミットを設定するには Low Limit[F2] を押し、

下限（ロー）リミットとしてリミットラインを 1 つ選択し

ます。 

4. Pass Criterion[F3] を押し、Pass 基準を選択しま

す。 

 判定基準： All-In, Max-In, Min-In 
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 5. Pass/Fail Mode[F5] を押し、Fail 判定時にどのよう

にするか選択します。 

Single は、1 回 Fail 判定するとテストを停止します。 

Continue は、Fail 判定後でも、テストを継続しま

す。  

 Pass/Fail モード： Single, Continue 

 6. Pass/Fail Test[F4] を押し、テストをオンにします。

7. ハイ/ローリミットライン（有効な場合）が画面に表

示され、テスト結果が画面下部に表示されます。 

 Pass:  表示と緑色の画面枠。 

 Fail: 表示と赤色の画面枠。 

アイコン表示 
 

テストをオンにすると、画面下部にアラーム

アイコンが表示されます。  

例 リミットライン

Pass/Fail表示
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 注意 
テストを実行するためには、少なくとも 1 つのリミッ

トライン（ハイリミットまたはローリミット）がオンにな

っている必要があります。 

上限または下限リミットがオフになっている場合、

最大値または最小*表示レベルは、それぞれ上限

または下限リミットとして自動的に設定されます。 

 

* +30dBm+Ref レベルオフセットまたは 

   -150dBm+Ref レベルオフセット 
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シーケンス 
シーケンス機能は、ユーザー定義のマクロを記録し、それを実行をしま

す。最大 5 個のシーケンスを保存でき、1 つのシーケンスに最大 20 ス

テップの操作を設定できます。シーケンスの実行は、繰り返し実行また

はシングル（1 回のみ）で実行可能です。 

シーケンス内には、シーケンス中に測定結果や波形の確認ができるよ

うに遅延や一時停止が挿入できます。 

また、シーケンスは、他のシーケンスを呼び出すことでより長いシーケン

スを作成できます。 

 

シーケンスの作成と編集  →  229 ページから 

シーケンスを実行する→233 ページから 

シーケンスの作成と編集 
 

シーケンスの編

集 
1. > Sequence[F1] を押し、編集または作成す

るシーケンスを選択します。  

 シーケンス番号 1～5 

 2. Edit[F2]>Start Edit[F1] の順で押し、選択したシー

ケンスの編集を開始します。 

 3. 画面が上下 2 分割されます。 

画面上部にメイン画面を表示します。 

画面下部には、シーケンスエディタとシーケンスス

テップを表示します。 

• シーケンスエディタ画面に  アイコ
ンが表示されます。 
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シーケンス編集ウィンドウ

メイン表示
編集開始 /
編集終了アイコン

シーケンス
ファンクション
メニュー

ステップを追加す

る 

最大 20 ステップまで各シーケンスに設定できま

す。 

パネル操作をステップとして記録します。 

パネル操作毎に キーを押し、ステップを記録

します（いくつかのケースではこれが必要ではあり

ません。シーケンスエディタウィンドウに操作が表

示されている場合） 

 

以下の例は、センター周波数とスパンがステップと

してシーケンスに追加されます： 

1. >Center Freq[F1]>20MHz> の順で押

します。 

2. >Zero Span[F3]> の順で押します。 

3. 二つの操作がシーケンスエディタに追加されます。

 

4.  キーをもう一度押し、シーケンス機能 

メニューへ戻ります。 
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 注意 
Sequence メニュー内のとき、矢印キーまたはスク

ロールノブで希望するステップ位置へカーソルを移

動できます。 

遅延時間を挿入

する 

遅延機能は、ステップ間の遅延時間を追加します。  

1. Delay Time[F2]> を押し、遅延時間を入力します。 

 遅延時間範囲： 100ms～10s 

 2.  を押し、シーケンスエディタへ遅延時間を挿

入します。 

遅延時間がステップとして挿入されます。 

 注意 
Sequence メニュー内のとき、矢印キーまたはスク

ロールノブで希望するステップ位置へカーソルを移

動できます。 
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シーケンスの一

時停止 

一時停止（Wait to Go）機能は、Continue[F1]キー

が押されるまでシーケンスを一時停止するのに使

用します。 

この機能を使用すると、順次シーケンスを実行して

いる途中で一時停止するので測定値の確認や波

形確認ができます。 

1. Wait to Go[F3]> . を押します。 

Wait to Go （一時停止）がステップとして挿入されま

す。 

  

2. シーケンス実行中にこのステップで一時停止した

場合、Continue[F1] を押すとシーケンスを再開しま

す。 

別のシーケンスを

挿入する 

現在のシーケンスへ別のシーケンスを挿入できま

す。 

1. Do Sequence[F4]> を押し、現在のシーケンスへ挿

入する別のシーケンスを選択します。 

•選択したシーケンスがステップとして挿入されます。 

 

 注意 
現在編集中のシーケンスへ自分自身を挿入するこ

とはできません。 

ステップの削除 シーケンスエディタ内のステップは、削除できます。

 1. 前面パネルの矢印キーまたは 

スクロールノブで削除したいステップ

へカーソルを移動します。 
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 2. Delete Step[F5] > を押しステップを削除します。 

選択したステップが、シーケンスエディタから削除さ

れます。 

編集を終了する 1. Stop Edit[F6]を押し、エディタを終了します。.  

2. エディタ画面右上の  アイコン

が黒丸にまります。 

現在のシーケン

スを保存する 

シーケンスの編集が終了（中止）すると、保存が可

能になります。 

1. >Save Sequence[F4] >を押し、シーケンスを

保存します。 

2. 選択されたシーケンスが保存されます。 

現在のシーケン

スを削除する 
1. >Delete Sequence [F5] > を押し、現在の 

シーケンスを削除します。  

シーケンスを実行する 
 

実行モード 1. > Sequence[F1] を押し、シーケンスを選択

します。 

2. Run Mode[F6] を押し、実行モードを Single または

Cont を切り替えます： 

 Single シーケンスを一回のみ実行します。 
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 Cont. Stop Running Sequence[F7] が押され

るまでシーケンスを連続して実行しま

す。 

(注意：Stop Running Sequence[F7] オ
プションはシーケンス実行中にのみ表

示されます。)  

シーケンスを実行

する 

3. Run Now[F7] を押すと、選択したシーケンス開始し

ます。 

4. Stop Running Sequence[F7]を押しすとシーケンス

を停止します。 

• シングルモードでは、全てのステップが終了すると
シーケンスは停止します。 
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トラッキングジェネレータ 
トラッキングジェネレータは、本体と同じ周波数範囲と掃引時間で掃引

信号を出力します。 

対応モデル：GSP-9330VGT、GSP-93300VT 

振幅は、全周波数範囲にわたって一定値に維持されます。 

トラッキングジェネレータは、DUT の周波数応答試験などの測定に有効

です。 

 

トラッキングジェネレータを有効にする  →235 ページから 

トラッキングジェネレータをノーマライズする→236 ページから 

トラッキングジェネレータを有効にする 
 

操作 1. >Tracking Generator[F1]>TG[F1] の順で押

し、トラッキングジェネレータをオンにします。 

TG 出力が有効になります。 
 

2. TG Level[F2] を押し、トラッキングジェネ 

レータの出力レベルを設定します。 

 出力レベル範囲： -50～0dBm 

 

3. TG Lvl Offset[F3] を押し、システムの利得/損失を

補償するためにトラッキングジェネレータのオフセッ

トレベルを設定します。 

 オフセット範囲： 0dB～50dB 

 

4. TG Lvl Step[F4] を押し、TG 出力レベルのステップ

分解能を設定します。 

 分解能範囲： Auto, Man; 0.5～50dB, 

0.5dB ステップ 
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 5. Power Sweep[F5] を押すと、スイープ速度に合わ

せて TG の出力電力を変化させることができます。

スイープ開始時の出力電力は、TG レベル設定か

ら開始し直線的に増加/減少し掃引終了時に 

パワースイープレベルとなります。  

 スイープ範囲： -5dB～+5dB 

トラッキングジェネレータをノーマライズする 
 

概要 ノーマライズ機能は、リファレンストレースと各 

スイープ後のトレースを減算します。 

その結果として得られたトレースは、正規化された

リファレンスレベルに加算されます。 

接続 TG 出力をノーマライズするには、TG 出力を RF 入

力に直接接続します。 

ノーマライズ後、本器のトラッキングジェネレータ出

力を DUT を接続し、DUT の出力を本器の RF 入力

に接続します。 

GSP

DUT

TG
出力

RF
入力

ノーマライズ

操作 1. >Tracking Generator[F1]>TG[F1] を押し、 

トラッキングジェネレータをオンにします。 
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 2. Normalize[F6] を押し、ノーマライズメニューにしま

す。 

 

3. Norm. Ref. Level[F2] を押し、ノーマライズされたリ

ファレンスの垂直レベルを設定します。 

 範囲： -100dB～100dB 

 

4. Norm. Ref. Position[F3] を押し、画面上のノーマラ

イズされたトレースのオフセットを設定します。 

 範囲： 10～0div（目盛） 

(画面上部から画面下部ま

で) 

 

5. Norm.[F5] を押し、ノーマライズデータのオン/オフ

を切り替えます。 

別の方法として、Norm.[F1]を押しノーマライズを再

実行します。 
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ノーマライズしていない
トレース

ノーマライズを
オンにし
リファレンス
ポジションを5に設定

DUTの応答
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 注意 
ノーマライズされたデータは、X 軸関連のパラメー

タを変更したり、TG 出力レベルを変更したりした場

合、自動的にオフになります。 

このような場合、警告メッセージ, “Execute 

Normalization again!” が表示されます。. 
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パワーメータ 
別売のパワーメータ PWS-06 を使用する場合は、本器は測定範囲が

1MHz から 6.2GHz までの動作周波数範囲で-32dBm～+20dBm まで

DUT の平均信号電力レベルを測定し、ログを記録できます。 

 

パワーメータモードを有効にする → 240 ページから 

パワーメータ測定のデータログ → 242 ページから 

パワーメータモードを有効にする 
 

接続 パワーメータ PWS-06 の USB ケーブルを本器の

前面パネルの USB A ポートへ接続します。 

RF 信号源をパワーメータに接続します。 

GSP

PWS-06

USB A 
PORT

RF SOURCE

操作 1. > Power Meter[F2]>Power Meter[F1] の順で

押し、パワーメータをオンにします。 

 注意 
パワーメータが正しく接続されていない場合、 

パワーメータオプションが利用できません。 

 2. 画面が上下 2 分割されます。 

画面上部にパワーメータ測定値が dBm または W

で表示されます。 

画面下部には測定ログのグラフが表示されます。
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パワーメータのデータログ

パワーメータ測定値

パワーメータバー

 

3. Power Unit[F2] を押し、単位を選択します： 

 単位： dBm, W 

 

4. Frequency[F3] を押し、測定周波数を入力します。

（テンキーを使用します）： 

 周波数範囲： 1MHz～6200MHz 

 分解能： 1MHz 

 

5. Sensor Mode[F4] を押し測定スピード（測定精度に

関連します）を選択します：t 

 Low Noise: 100ms/sample,  typical  

 Fast: 30ms/sample, typical 

 

6. PASS/FAIL テストを作成するには、Pass/Fail 
Test[F5] を押し、以下のパラメータを設定します： 

 High Limit[F1]: -30dBm～20dBm 

 Low Limit[F2]: -30dBm～20dBm 

 Pass/Fail Test[F3]: On, Off 
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 Pass Icon:  

 Fail Icon: 
 

7. More[F6]>Trigger[F1] を押し、free run (内部)トリガ

と外部トリガを切り替えます。 

 トリガ： Free, Ext 

 
外部トリガ入力： 3.3V CMOS  

 

 

8. More[F6]> MAX/MIN HOLD[F2] を押し、パワー 

メータ測定バーの MAX/MIN ホールド測定のオン/

オフを切り替えます。 

MIN/ MAX 測定は、画面の中央にパワー測定バー
メータで表示されます。 

 MIN HOLD
測定

MIN HOLD
測定

 注意 
通常のスペクトラムモードに戻るには、 > 

Power Meter[F2]>Power Meter[F1] を押し、パワー

メータモードをオフにします。 

パワーメータ測定のデータログ 
 

概要 パワーメータモードでは、本器はユーザ定義の間

隔と周期でパワーメータの測定値を記録することが

可能です。 

操作 1.  を押し、保存メニューへ移動します。 

 2. Type[F2] を押 Power Meter[F7].を選択します。 
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 3. Data Source[F3] を押すと自動的に Power State.

に設定されます。 

 4. PMET Record Option[F4] を押し、記録オプションを

設定します： 

 Record Stop[F1]: 自動データログの記録時間を設

定： 

00 ：00 ：00 (連続)または 

00 ：00 ：01～23 ：59：59 

 Record Step[F2]: 20ms～999s 

 5. Save To[F1] を押し、保存先を選択します： 

 
Local: 内部メモリ 

 SD Card: 外部 micro SD カード 

 注意 
前面パネルのマイクロ SD カードポートに SD カー

ドが挿入されると、マイクロ SD カードのオプション

が利用できるようになります。 

 6. 保存先を選択した後に、記録オプションが表示され

ます。 

 7. ログファイルに名前を付けるには、

Name[F1].を押します。 

選択したファイルに名前を付けるに

は、以下に示すように、F1～F7 キー

やテンキーを使用します。 
 

 

制限事項： 

スペースなし 

英数（1～9, A～Z, a～z）文字のみ
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8. 入力しているファイル名が画面下側に表示されま

す。 

 

  

 を押しファイル名の設定を確定します。 

 注意 
ファイル名を、ユーザー定義しない場合、ファイル

名は次の形式で自動的に作成されます： 

ファイル名：タイプ_データソース_ファイル番号.ファ

イル拡張子 

ファイル番号のパラメータは、同じファイルタイプが

作成されるたびにカウントアップされます。 

 9. パワーメータ測定の記録を開始するには、Record 
Now[F3].を押します。 

記録が終了するとメッセージ“SaveFinish‼”が画面

の下部に表示されます。 

記録の停止 Record Stop[F2].を押すと手動で記録を停止しま

す。 

ファイル名 
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デモキット 
デモキットは、ASK と FSK ジェネレータです。デモキットには、3 種類の

プリセットされた周波数、ボーレートとノーマルモード/ゲートモードで出

力する機能と 5 種類の選択可能なデータ列をサポートしています。 

 

ASK(振幅偏移変調：Amplitude Shift Keying) →  245 ページから 

振幅偏移変調（FSK：周波数シフトキーイング） →247 ページから 

ASK(振幅偏移変調：Amplitude Shift Keying) 
 

接続 前面パネルの USB A ポートにデモキットを接続し

ます。 

デモキットの出力を RF 入力端子に接続します。 

設定 1. > Demo Kit[F4]>Demo Kit[F1] の順で押し、

デモキットをオンにします。. 

 注意 
デモキットが正しく挿入・認識されていないとデモ 

キットオプションが有効になりません。 

 2. Modulation[F2] を押し、ASK[F1].を選択します。 

 

3. Frequency[F3] を押し、周波数を選択します： 

 周波数： 315MHz, 433MHz, 868MHz 

 

4. Baudrate[F5] を押し、ボーレートを選択します： 
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 Baud 4800, 9600, 20000 

 

5. Output Mode[F6] を押し、ゲートモード、ノーマル 

モードまたは固定データを選択します。 

ゲートモードとノーマルモードは、ランダムデータを

出力し、一方固定データオプションは、5 種類のプ

リセットされたデータ列を出力します。 

 出力モード Norm., Gated (100ms 周

期, 16ms オン, 84ms オフ), 

固定データ 

 

6. 出力モードで固定データを選択した場合、データ列

を選択します。 

 固定データのデータ列 Seq1(00110101), 

Seq2(10100101), 

Seq3(00010010), 

Seq4(11011100), 

Seq5(10101010). 

 注意 
上記のデータ列は、ASK/ FSK 復調機能で復号が

できます。

Measure>Demod>ASK/FSK>View>Symbol の順で

選択し出力シーケンスを参照してください。 

操作 以下の操作は、上記手順で出力された ASK 信号

を観測するデモ方法について説明しています。 

これは、以下の設定が設定されたと仮定していま

す： 

ASK 変調, 周波数=315MHz, ボーレート=4800,  

出力モード=Normal  

 

1. >Center[F1] の順で押し、センター周波数を

315MHz に設定します。 



 リミットラインを生成する(マーカデータから) 

247 

2. >Span[F1] の順で押し、スパンを 200kHz に

設定します。 

3. >Demod[F2]>ASK[F4] の順で押し、ASK 復

調をオンにします。 

設定の詳細については、140 ページを参照くださ

い。 

振幅偏移変調（FSK：周波数シフトキーイング） 
 

接続 前面パネルの USB A ポートにデモキットを接続し

ます。 

デモキットの出力を RF 入力端子に接続します。 

設定 1. > Demo Kit[F4]>Demo Kit[F1] の順で押し、

デモキットをオンにします。 

 注意 
デモキットが正しく挿入・認識されていないとデモ 

キットオプションが有効になりません。 

 2. Modulation[F2] を押し、FSK[F2].を選択します。 

 

3. Frequency[F3] を押し、周波数を選択します： 

 周波数 315MHz, 433MHz, 868MHz 

 

4. Deviation[F4] を押し、周波数偏移を選択します： 
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 Deviation  25MHz, 50MHz  

 

5. Baudrate[F5] を押し、ボーレートを選択します： 

 Baud 4800, 9600, 20000 

 

6. Output Mode[F6] を押し、ゲートモード、ノーマル 

モードまたは固定データを選択します。 

ゲートモードとノーマルモードは、ランダムデータを

出力し、一方固定データオプションは、5 種類のプ

リセットされたデータ列を出力します。 

 Output mode Norm., Gated (100ms 

period, 16ms on, 84ms 

off), Fixed data. 

 

7. 出力モードで固定データを選択したときは、データ

列を選択します。 

 固定データのデータ列 Seq1(00110101), 

Seq2(10100101), 

Seq3(00010010), 

Seq4(11011100), 

Seq5(10101010). 

 注意 
上記のデータ列は、ASK/ FSK 復調機能で復号が

できます。

Measure>Demod>ASK/FSK>View>Symbol の順で

選択し出力シーケンスを参照してください。 

操作 以下の操作は、上記手順で出力された FSK 信号

を観測するデモ方法について説明しています。 

これは、以下の設定が設定されたと仮定していま

す：: 

FSK 変調, 周波数=315MHz, 偏移=25MHz,  
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ボーレート=4800, 出力モード=Norm. 

 

1. >Center[F1] の順で押し、センター周波数を

315MHz に設定します。 

2. >Span[F1] の順で押し、スパンを 200kHz に

設定します。 

3. >Demod[F2]>FSK[F5] の順で押し、FSK 復

調をオンにします。 

設定の詳細については、148 ページを参照くださ

い。 
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ファイル操作 

ファイル操作の概要 
ファイル機能は、コピー、削除、並び替えなどを含む基本的なファイル

関連の操作に使用します。  

本器には、トレースデータ、リミットライン、振幅補正、シーケンスおよび

パネル操作などの異なるファイル形式があります。 

保存するファイルと保存先（ローカル、USB またはマイクロ SD）は、ファ

イル機能で選択できます。 

 

ファイル保存先 →  250 ページから 

ファイルの種類 →251 ページから 

ファイルエクスプローラを使用する →253 ページから 

ファイルのコピー →255 ページから 

ファイルの移動 →256 ページから 

ファイルの削除 →  257 ページから 

ファイル名の変更→258 ページから 

ファイルの保存 →260 ページから 

ファイルの呼出 →263 ページから 

クイック保存（Quick Save →265 ページから 

ファイル保存先 
 

Local 本器は、データ保存用に 16MB の内蔵ローカルメ

モリを持っています。 

USB 外部 USB フラッシュメモリへ保存できます。  
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 USB のタイプ： 1.1/2.0 (FAT32/NTFS 

フォーマット) 

Micro SD 外部マイクロ SD へ保存できます。  

 フォーマット： SDSC, SDHC (FAT32 

フォーマット) 

ファイルの種類 
 

概要 ファイルタイプをファイルメニューで表示される順で

説明します。 

State（情報デー

タ） 

情報データ（State）は、パネル設定の情報を含ん

でいます： 

 Frequency 

 Span 

 Amplitude 

 BW/AVG 

 Sweep 

 Trace 

 Display 

 Measure 

 Limit Line 

 Sequence 

 Trigger 

 Marker 

 Marker  

 Peak Search 

 Preset 

 System 

Trace トレースデータには、CSV 形式でトレースのデータ

を含んでいます。 

・センター周波数 

・スパン 

・分解能帯域幅（RBW） 

・ビデオ帯域幅（VBW） 

・リファレンスレベル 

・スイープ時間 

・ポイントの数値 (トレースデータのポイント) 

Screen 画面イメージ：J-PEG 形式(800X600) 
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Limit Line リミットラインデータには、CSV 形式で以下の内容

が含まれています： 

・ポイント数 

・ポイントの周波数 

・ポイントの振幅 

・振幅の単位 

Correction  補正値のデータには、以下の補正（ライン）データ

が含まれています： 

・ポイント数 

・ポイントの周波数値 

・ポイントのゲインオフセット 

・単位 

 

Sequence  シーケンスファイルは、そのシーケンスのシーケン

ス番号とステップ操作が含まれています。 

このデータは、独自フォーマットです。 

PC などで編集できません。 

トラッキング 

ジェネレータ 

TG データの内容： 

・TG レベル 

・TG レベルオフセット 

・TG レベルステップ 

・パワースイープの情報と値 

・ノーマライズのリファレンスレベル 

・ノーマライズのリファレンス位置 

・ノーマライズ情報 
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Power Meter パワーメータデータの内容： 

・日付 
・時間 

・パワー（dBm） 

・スタート時間/エンド時間 

・ステップ時間 

 

ファイルエクスプローラを使用する 
 

外部メモリを接続

する 

USB フラッシュドライブまたはマイクロ SD カード上

のファイルを表示するには、先ず前面パネルの 

ポートに相当する適切なデバイスを挿入します。 

ファイル選択 1. >を押しファイルエクスプローラを選択しま

す。 

2. メモリの場所を選択します： 

 Local[F1]: 内部メモリ 

 USB[F2]: 前面パネルの USB メモリ

 SD Card[F3]: Micro SD カード 

 3. 上/下矢印キーまたはスクロールノブ

でファイル一覧上のカーソルを上/下

に移動ができます。 

 4. 左/右矢印キーは、ファイル一覧で 

ファイルページが複数ページのばあ

い、次ページ/前ページに移動するた

めに使用します。 
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 注意 
USB フラッシュドライブとマイクロ SD カードのオプ

ションは、前面パネルのポートにメモリが挿入され

たときにのみ使用可能になります。 

形式別でファイル

を表示する 

ファイルエクスプローラは、特定のタイプのみを表

示するように設定できます。 

ファイルタイプの詳細については、250 ページを参

照してください。 

1. Type[F2] を押し、表示するファイル形式を選択しま

す： 

 All 全てのファイル形式を表示しま

す。 

 State State ファイルのみ表示します。 

 Trace Trace ファイルのみ表示します。 

 Screen  Screen ショットのみ表示します。 

 Limit Line リミットラインファイルのみ表示し

ます。 

 Correction 補正データファイルのみ表示しま

す。 

 Sequence シーケンスファイルのみ表示しま

す。 

 Power Meter パワーメータファイルのみ表示し

ます。 

 表示するファイル形式を選択すると、選択したファ

イル形式のみがファイルエクスプローラに表示され

ます。 

ファイルの並び替

え 

ファイルは、ファイル名または日付のどちらか並べ

替えるできます。初期設定では、ファイル名で並び

替えされています。 

1. Sort By[F3] を押し、並べ替えの種類を選択しま

す： 
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 Name: ファイル名をアルファベット順で並

び替え 

 Date 作成日順で並び替え 

イメージファイル

のプレビュー 

イメージファイルは、プレビュー機能を有効にするこ

とで画面にプレビューできます。 

1. More[F7]>Preview[F2] の順で押し、プレビュー機

能のオン/オフを切り替えます。 

例 

 注意 
プレビューをオンにすると、他のファイルタイプはエ

クスプローラに表示されません。 

ファイルのコピー 
 

概要 内蔵メモリのファイルは、USB フラッシュドライブや

マイクロ SD カードなど外部メモリへコピーできま

す。また、その逆も可能です。 

外部メモリを挿入

する 

前面パネルのポートへ USB フラッシュドライブまた

はマイクロ SD カードのどちらかを挿入します。 
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ファイルの選択 1. >を押し、ファイルエクスプローラを開きます。

2. FileExplore[F1]を押し、.内部メモリ（Local）または外

部メモリ（USB または SD）を選び、ファイルを選択

します。 

3. Copy to[F4].を押します。 

4. Media [F1] を押し、コピー先（local, USB, SD card）

を選択します。 

5. Copy Now [F2].を押します。 

6. ファイルがコピー先のディレクトリへコピーされま

す。 

 注意 
USB フラッシュドライブ/ マイクロ SD カードのオプ

ションは、前面パネルのポートに USB メモリやマイ

クロ SD カードが挿入されたときにのみ使用可能に

なります。 

ファイルの移動 
 

概要 ローカルメモリのファイルは、USB またはマイクロ

SD カード等の外部メモリに移動できます。 

また、その逆も可能です。 

外部メモリを挿入

する 

前面パネルのポートへ USB フラッシュドライブまた

はマイクロ SD カードのどちらかを挿入します。 
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ファイルの選択 1. >File Explorer[F1]の順で押します。 

2. 内部メモリ（Local）または外部メモリ（USB または

SD）を選びます。 

3. More[F7] > Move to[F1] の順で押します。 

4. Media [F1] を押し、移動先（local、USB、SD カード）

を選択します。 

5. Move Now [F2]を押します。 

6. 移動先へファイルが移動します。 

 注意 
USB フラッシュドライブと SD カードのオプション

は、前面パネルのポートに USB やマイクロ SD 

カードが挿入されたときにのみ使用可能になりま

す。 

ファイルの削除 
 

概要 ローカル（内部）メモリや、USB やマイクロ SD カー

ドなどの外部メモリ内の任意のファイルを削除でき

ます。 

外部メモリを挿入

する 

USB フラッシュドライブまたはマイクロ SD カード上

のファイルを削除するには、前面パネルのポートに

適切なデバイスを挿入します。 
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ファイル削除 1. >File Explorer[F1]の順で押します。 

2. ローカルまたは外部メモリ内のファイルを選択しま

す。 

3. Delete[F5].を押します。 

4. Delete Now[F1].を押します。 

5. 初期設定では、削除対象とした（カーソル位置）の

任意のファイルを削除するか確認するメッセージが

表示されます 

No[F1]キャンセルまたは Yes[F2]で削除するかどう

か確認します。 

削除の警告 1. ファイル削除の確認プロンプトを無効にするには、

Delete caution[F2] を押し、オプションを切り替えま

す： 

 Don’t Ask ファイル削除のとき確認メッセー

ジを表示しません。 

 Ask ファイルを削除するかどうかを

No[F1]キャンセルまたは

Yes[F2]で確認します。 

 注意 
USB フラッシュドライブ/ マイクロ SD カードのオプ

ションは、前面パネルのポートに USB やマイクロ

SD カードが挿入されたときにのみ使用可能になり

ます。 

ファイル名の変更（Rename） 
 

概要 ローカル（内部）メモリまたは USB やマイクロ SD 

カードなどの外部メモリ内の任意のファイル名を変

更できます。 
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外部メモリを挿入

する 

USB フラッシュドライブまたはマイクロ SD カード上

のファイルを削除するには、前面パネルのポートに

適切なデバイスを挿入します。 

ファイル名の変更 1. >File Explorer[F1]の順で押します。 

2. ローカルまたは外部メモリ内のファイルを選択しま

す。 

3. Rename[F6].を押します。 

 4. 以下に示すように、F1～F7 のキーま

たはテンキーを使用し選択したファイ

ルの名前を変更します：  

 

 制約事項： 

スペース（空白文字）なし 

英数（1～9、A～Z、a～z）文字のみ 

 5. 名前を変更しているファイル名がエクスプローラ上
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のリストに表示されています。 

 

6.  を押し、ファイル名を確定します。 

 注意 
USB フラッシュドライブとマイクロ SD カードのオプ

ションは、前面パネルのポートに USB やマイクロ

SD カードが挿入されたときにのみ使用可能になり

ます。 

ファイルの保存 
 

概要 キーを使用することで、本器に設定した任意

の機能設定や構成を保存ができます。 

外部メモリを接続

する 

USB フラッシュドライブまたはマイクロ SD カードに

ファイルを保存する場合には、前面パネルのポート

に適切なデバイスを挿入します。 

 注意 
パワーメータのデータ（データログ）保存については

242 ページを参照してください。本章では説明しま

せん。 

ファイルの保存 1.  を押し、保存メニューへ移動し SaveTo[F1]
で保存先を指定します。 

 2. Type[F2] を押し、保存するファイルの種類を選択し

ます。ファイルの種類については 250 ページを参

照してください： 

 State： State（パネル設定）データ 

 Trace： トレースデータ 

 Screen： 画面イメージ（J-PEG9 データ 

ファイル名 
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 Limit Line： リミットラインデータ 

 Correction： 補正データ 

 Sequence： シーケンスファイル 

 Power meter： パワーメータデータ*  

*詳細は、242 ページを参照くだ

さい。 

 3. 選択が可能な場合は、Data Source[F3] 押し、ファ

イルタイプのデータソースを選択します： 

 State データ： 本体専用データ(固定、選択不

可) 

 Trace データ： Trace1～4 を選択可能 

 Screen shots： Normal：画面イメージ通りに保存 

Save Toner：背景を白黒反転し

て保存 

 Limit line： リミットライン 1～5 を選択可能 

 Correction： 補正データ 1～5 を選択可能 

 Sequence： シーケンスデータ 1～5 を選択可

能 

 Power meter： パワーメータ情報* 

*詳細は、242 ページを参照くだ

さい。 

 4. トレースデータについては、Format[F4] を押し、保

存する形式を選択します：  

 Trace： トレースデータのみ 

 Trace+State： トレースデータと情報 

 5. Save To[F1] を押し、保存先を選択します： 

 Register 1～6： 内部メモリレジスタ、この内部レ

ジスタは、ローカルメモリとは別

です。 

 Local： 内部メモリ 

 USB： 外部 USB メモリ 
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 SD Card： 外部マイクロ SD カード 

 6. 保存先を選択した後、ファイル名を付けるか、また

はそのまま直ぐに保存することができます。 

 7. 選択したファイルに名前を付けるに

は、Name[F5]を押し F1～F7 キーま

たテンキーを使用して名前を変更しま

す.： 

 

制約次項： 

スペース（空白文字）なし 

英数（1～9、A～Z, a～z）文字のみ 

  

8. 入力中のファイル名は、画面下部に表示されてい

ます。 

 

9. を押しファイル名を確定します。 

ファイル名 
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 注意 
ファイル名を変更しない場合、デフォルトのファイル

名形式を使用します。  

詳細については、下記の注意を参照してください。

 10. 選択したファイルを保存するには、Save Now[F7].
を押してください。 

保存が完了したら、“SaveFinish‼”メッセージが画面

下部に表示されます。 

 注意 
ファイル名を、ユーザー定義（ファイル名変更）しな

い場合、ファイル名は、データファイルに対して以

下のフォーマットで自動的に作成されます：  

ファイル名：データソースの種類_XX.ファイル拡張

子 

画像ファイル名は、自動的に次の形式で作成され

ます： 

ファイル名：QuickJpgX.jpg 

パラメータ X（数値）は、同じファイル形式が作成さ

れるたびに増加します。 

 注意 
USB フラッシュドライブとマイクロ SD カードのオプ

ションは、前面パネルのポートに USB やマイクロ

SD カードが挿入されたときにのみ使用可能になり

ます。 

*パワーメータオプションは、別売のパワーメータが

挿入された場合にのみ有効になります。 

パワーメータの詳細については、240 ページの 

パワーメータの項を参照してください。 

ファイルの呼出 
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概要 以前に保存した設定（状態）ファイルのほとんど

は、 キーを使用し本体へ呼び出すことができ

ます。 

例外として、データロギング設定です。 

240 ページを参照してください。 

外部メモリを挿入

する 

USB フラッシュドライブまたはマイクロ SD カードか

らファイルを呼び出すには、前面パネルのポートに

適切なデバイスを挿入します。 

 1.  を押し Recall メニューへ移動し、

RecallFrom[F1]で呼出先を選択します。 

2. Type[F2] を押し、呼び出すファイルの種類を選択

します。ファイルの種類については、250 ページを

参照ください： 

 State： State（パネル情報）データ 

 Trace： Trace データ 

 Limit Line： Limit line データ 

 Correction： Correction データ 

 Sequence： Sequence ファイル 

 3. 可能な場合は、Destination[F3] を押し、保存先を

選択します： 

 State data： ローカルステートデータ（固定、

選択不可） 

 For Trace data： Trace1～4 

 For Limit Lines： Limit line 1～5 

 For Correction： Correction データ 1～5 

 For Sequence： Sequence 1～5 

ファイルの呼出 1. Recall From[F1] を押し呼出元を選択します： 
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 Register 1～6： 内部メモリレジスタ。 

この内部レジスタはローカルメモ

リとは別です。 

 Local： 内部メモリ 

 USB： 外部 USB メモリ 

 SD Card： 外部マイクロ SD カード 

 2.  選択したファイルを呼び出すには Recall Now[F4]. 
を押します。 

3. 呼出が完了すると、“SaveFinish‼”メッセージが画

面下部に表示されます。 

 注意 
USB フラッシュドライブとマイクロ SD カードのオプ

ションは、前面パネルのポートに USB やマイクロ

SD カードが挿入されたときにのみ使用可能になり

ます。 

クイック保存（Quick Save） 
 

概要  キーは、ホットキーです。キーを押すだけで

直ちにファイルを保存できます。  

保存するファイルの種類は、 キーで事前に設

定した種類です。 

初期設定では、 キーを押すと画面イメージを

ローカル（内部）メモリまたは外部フラッシュメモリ

（挿入されていた場合）へ保存します。 
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サポートしている

ファイルの種類 

画面イメージ、トレース、パネル情報、リミットライ

ン、補正値、シーケンス、パワーメータ *. 

*パワーメータデータを保存するには、別売の 

パワーメータが事前に装着されている必要があり

ます。 

外部メモリを挿入

する 

USB フラッシュドライブまたはマイクロ SD カードに

ファイルを保存するには、前面パネルのポートに適

切なデバイスを挿入します。 

Quick Save の 

設定 
1.  キーを押し、ファイルの種類、データソースと

形式を設定します。 

詳細は、260 ページを参照していください。  

Quick Save キー

を使う 
1. いつでも  を押すと、上記で設定したファイル

の種類を、直ちに保存します。 

2. 保存が完了すると“SaveFinish‼”メッセージが画面

下部に表示されます。 

 注意 
ファイル名は、自動的にデータファイル形式（以下）

で作成されます：  

ファイル名：データソースの種類_XX.ファイル拡張

子 

画像ファイル名は、自動的に次の形式で作成され

ます： 

ファイル名：QuickJpgX.jpg 

パラメータ X（数値）は、同じファイル形式が作成さ

れるたびに増加されます。 
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 注意 
USB フラッシュドライブと SD カードのオプション

は、前面パネルのポートに USB やマイクロ SD 

カードが挿入されたときにのみ使用可能になりま

す。 
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リリモートコントロール 
この章では、IEEE488.2 ベースのリモートコントロー

ルの基本的な構成を説明しています。 

コマンドリストについては、プログラミングマニュアル

を参照してください。 

プログラミングマニュアルは、弊社ウェブサイトから

ダウンロードできます。 
 

インターフェースの構成 ....................... 269 
USB リモートインターフェースを設定する ............................................................................ 269

GP-IB インターフェースの設定 ................................................................................................. 269

LAN と LXI インターフェースの構成 ........................................................................................ 270

無線 LAN(WLAN)インターフェースの構成............................................................................ 273

RS-232C の設定 ............................................................................................................................. 277

RS-232C リモートコントロールの確認 ................................................................................... 277

LXI ブラウザインターフェースと機能チェック ...................................................................... 278

GPIB/LAN/USB コントロール機能のチェック..................................................................... 282

 



 USB リモートインターフェースを設定する 

269 

インターフェースの構成 

USB リモートインターフェースを設定する 
 

USB 設定 PC 側の接続 タイプ A, ホスト 

本器側の接続 背面パネル タイプ B, スレーブ 

Speed 1.1/2.0 (full speed/high speed) 

 USB クラス USB TMC (USB T&M class)  

パネル操作 1. USB ケーブルを背面パネルの USB 

B ポートへ接続します。 

 2. >More[F7]>RmtInterface Config[F1]>USB 
Mode を押し、USB モードを Device.へ切り替えま

す。 

 注意 
USB モードを切り替えるために、本器は少し時間

がかかります。 

GP-IB インターフェースの設定 

GP-IB を使用するには、GP-IB が装着されたモデルが必要です。 
 

GP-IB の設定 1. 本体の電源がオフになっていることを確認してくだ

さい。 

 2. GPIB コントローラに接続した GP-

IB ケーブルを本体背面の GP-IB

コネクタへ接続します。 
 

 3. 本体の電源をオンにします。 
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 4. >More[F7]>RmtInterface Config[F1]>GPIB 
Addr[F1] を押し、GP-IB アドレスを設定します。  

 GPIB アドレス 0～30 

GPIB の制約 全部で最大 15 デバイス、ケーブル長は 20 メートルま
で、各デバイス間は 2 メートル 
各デバイスに固有アドレスを割り当て• 
少なくとも 2/3 の機器は電源がオン 
ループなし、並列接続なし 

 LAN と LXI インターフェースの構成 

本器は、クラス C LXI に準拠した測定器です。 

LXI 仕様は、LAN または WLAN 経由でデバイスをリモート制御やモニタ

することが可能です。 

また、本器は HiSlip をサポートしています。  

HiSlip（High-Speed LAN Instrument Protocol）は、488.2 通信規格をもと

にした高度な LAN です。 

LXI 規格、準拠クラスと HiSLIP の詳細については、LXI のウェブサイト

を参照してください。 

LXI website @ http://www.lxistandard.org. 
 

概要 LAN インターフェースは、ネットワーク経由でリモー

ト制御するために使用します。 

本器は、自動的に既存のネットワークに接続できる

ように DHCP 接続をサポートしています。 

または、手動でネットワークの設定も可能です。  

LAN 構成の設定 IP アドレス Default Gateway 

サブネットマスク DNS サーバ 

DHCP on/off  

接続 背面パネルの LAN ポートにネット 

ワーク側からイーサネットケーブルを

接続します。  
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説明 1. >More[F7]>RmtInterface[F1]> LAN[F2]>LAN 
Config[F1] の順で押し、LAN 設定を設定します：t 

 IP Address[F1] IP アドレスの設定 

 Subnet Mask[F2] サブネットマスクの設定 

 Default 
Gateway[F3] 

デフォルトゲートウェイの設定 

 DNS Server[F4] DNS サーバアドレスの設定 

 LAN Config[F5] LAN 設定を DHCP また手動に

切り替えます。 

 ヒント：IP アドレスを入力するときは、ドットと 10 進
数を使用してください。 
例：172.16.20.8  

 2. Apply[F6] を押し LAN 構成を確定します。 

アイコン表示  LAN が接続されると緑色の LXI アイコンが

表示され、「Identification（識別）」設定がオ

ンになっている場合は点滅します。 

278 ページを参照してください。 

パスワードの 

設定 

LXI ウェブページ上のパスワードは、本器から設定

できます。パスワードは、システム情報に表示され

ています。 

パスワードの初期設定は：lxiWNpwd  

1. >More[F7]>RmtInterface 
Config[F1]>LAN[F2]>LXIPassword[F3]の順で押し

パスワードを設定します。 

 2. 以下に示すように、F1～F7 のキーを

使用してパスワードを入力するか、数

字をテンキーで入力します： 
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制約次項： 

スペース（空白文字）なし 

英数（1～9, A～Z, a～z）文字のみ 

 
パスワード入力のメニューツリー 

 3. 作成中パスワードは画面の下部に表示されていま

す。 

 

4.  を押しパスワード設定を確定します。 

Hi SLIP ポート  1. >More[F7]>RmtInterface 
Config[F1]>LAN[F2] >HiSLIPPort を押し、Hi Slip 

Port 番号を確認します。 

 HiSlip port 4880  

 

パスワード 
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LAN 設定の 

リセット 

LAN を使用する前に、LAN 設定値をリセットする必

要があるかもしれません。 

1. >More[F7]>RmtInterface Config[F1]>LAN 
Reset[F3] を押し、LAN をリセットします。 

2. LAN のリセットには、少し時間がかかります。 

 注意 
LAN がリセットされるたびに、初期設定のパスワー

ドは初期設定に復元されます。  

初期設定のパスワード：lxiWNpwd 

無線 LAN(WLAN)インターフェースの構成 

WLAN 設定は、任意の 3G 規格 USB モデムを使用することで操作しま

す。遠隔地で、3G モデムを使用して本器の Web サーバにアクセスした

り、リモート制御コマンドを経由して本器をコントロールしたりできます。 
 

概要 3G モデムを使用してサーバとして本器を使用する

には、まずネットワークプロバイダから固定 IP アド

レスを取得する必要があります。各プロバイダは、

異なる固定 IP アドレスを割り当てます。  

WLAN の設定 IP アドレス Default Gateway 

サブネットマスク DNS サーバ 
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接続 3G USB モデムを前面パネルの USB A 

ポートに接続します。 

3G USB アダプタが接続されると、3G ステータスア

イコン が表示されます。 

初めて接続した場合には、アダプタ接続はされた

が有効ではないことをグレーで表示します。 

設定 1. 前面パネルの USB にポートに 3G USB モデムを

挿入し、3G USB の アイコンが表示されるのを待

ちます。 

2. >More[F7]>RmtInterface[F1]> LAN[F2]> 
WLAN Config[F2]>Apply[F6] を押し、3G USB モデ

ムの WLAN 設定が確立するのを待ちます。 

 設定が完了すると “Finish‼”メッセージが表示され

ます。 

3. ネットワーク設定が、システムメニューアイコンに表

示されます。 
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WLANの設定

アイコン表示 正常に接続が行われると、3GUSB アイコ

ンが緑色に変わります。 

パスワードの 

設定 

LXI ウェブページ上のパスワードは、本器から設定

できます。パスワードは、システム情報に表示され

ています。 

初期設定のパスワード：lxiWNpwd 

1. >More[F7]>RmtInterface Config[F1]> 
LAN[F2]>LXIPassword[F3] を押し、パスワードを設

定します。 

 2. 以下に示すように、F1～F7 のキーを

使用してパスワードを入力するか、テ

ンキーを使用し数字を入力します： 

 
制約次項： 

スペース（空白文字）なし 

英数（1～9, A～Z, a～z）文字のみ
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パスワード入力のメニューツリー 

 3. 作成中パスワードは画面の下部に表示されていま

す。 

 

4.  を押し、パスワードを確定します。 

Hi SLIP ポート 5. >More[F7]>RmtInterface 
Config[F1]>LAN[F2] >HiSLIPPort の順で押し、Hi 

Slip Port 番号を確認します。 

 HiSlip ポート 4880  

LAN のリセット LAN を使用する前に、LAN の設定値をリセットする

必要がある場合があります。 

6. >More[F7]>RmtInterface Config[F1]>LAN 
Reset[F3] の順で押し、LAN をリセットします。 

7. LAN のリセットには、少し時間がかかります。 

パスワード 
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 注意 
LAN がリセットされるたびに、初期設定のパスワー

ドが初期設定に復元されます。 

パスワードの初期値：lxiWNpwd 

RS-232C の設定 
 

概要 RS232C インタフェースは、PC でリモートコントロー

ルするために使用します。 

RS-232C の設定 ボーレート ストップビット：1 (固定) 

パリティ：なし（固定） データビット：8 (固定) 

接続 背面の RS-232C ポートへ PC か

らの RS-232C ケーブルを接続し

ます。 

 1. >More[F7]>RmtInterface Config[F1]>RS232 
BaudRate[F4] を押し、ボーレートを設定します。  

 
300 600 1200 

2400 4800 9600 

19200 38400 57600 

115200   

RS-232C リモートコントロールの確認 
 

機能チェック Realterm などのターミナルアプリケーションを起動

します。 

PC のデバイスマネージャで COM ポート番号を確

認します。 

Windows 7 では；コントロールパネル → システム

→ ハードウェアタブ 
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 RS-232C リモートコントロール（ページ 304）を設定

した後、下のクエリコマンドを実行します。(277 ペー

ジ) 

*idn? 

このコマンドの応答は、製造者、モデル番号、シリ

アル番号、ファームウェアのバージョンを次の形式

で返します。 

GWINSTEK,GSP9330,XXXXXXXX,V3.X.X.X 

製造者： GWINSTEK 

モデル名（奇異本モデル名）： GSP9330 

シリアル番号： XXXXXXXX 

ファームウェアバージョン：V3.X.X.X 

 注意 
詳細については、当社ウェブサイトにあるプログラ

ミングマニュアルを参照してください。 

LXI ブラウザインターフェースと機能チェック 
 

機能チェック 本器の LAN（270 ページ）または WLAN（273 ペー

ジ）の設定が完了し接続した後、Web ブラウザに本

器の IP アドレスを入力します。 

http:// XXX.XXX.XXX.XXX 

Web ブラウザインタフェースが表示されます： 
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ウェルカムページ ウェルカムページには、全ての LXI と LAN/ WLAN

構成の設定と機器の識別情報を一覧で表示されま

す。本器の識別情報は、このページから無効にす

ることができます。 

 

  

 注意 
 識別情報の設定をオンにしたとき、本器の

画面上の LXI アイコンが表示されます。 
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構成の表示と 

変更 

View & Modify Configuration 画面は、ブラウザから

LAN 設定を変更することができます。 

ブラウザの Modify Configuration ボタンを押し構成

ファイルのいずれかを変更します。 

設定を変更するには、パスワードを入力を入力す

る必要があります。 

パスワードの初期値：lxiWNpwd 

[注意：パスワードは、大文字と小文字が区別され

ます。] 

 

 注意 
「Factory Defaults」オプションが選択されると、パス

ワードが初期設定のパスワードにリセットされま

す。 

また、Web ブラウザ上でメッセージプロンプトが表

示されたら、手動で本器をリセットする必要があり

ます。 
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SCPI コマンド SCPI コマンドのページでは、SCPI コマンドを入力

するとブラウザから直接フルリモートコントロールで

きます。 

詳細については、プログラミングマニュアルを参照

してください。 

リモートコマンドを使用する前に、パスワードを入力

する必要があります。 

 

パスワードの初期値：lxiWNpwd 
[注意：パスワードは、大文字と小文字が区別されます。]  
 

画面イメージの 

取得 

Get Image ページは、リモートで本器の画面表示を

ブラウザへキャプチャできます。 

 

 

 注意 
詳細については、弊社ウェブサイトにあるプログ

ラミングマニュアルを参照してください。 
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GPIB/LAN/USB コントロール機能のチェック 
 

機能チェック GPIB / LAN 機能を確認するには、ナショナルイン

スツルメンツ社の Measurement＆Automation 

Controller ソフトウェアを使用してください。 

 

Measurement＆Automation Controller ソフトウェア

については、ナショナルインスツルメンツ社のウェ

ブサイトを参照してください。 

http://www.ni.com  

 注意 
詳細については、当社ウェブサイト上のプログラミ

ングマニュアルを参照してください。 
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FAQ 
 

• 
信号を接続したが、画面に表示されない。 

• 
装着してあるオプションを確認したい。 

• 
性能が仕様と一致しない。 

信号を接続したが、画面に表示されない。 
 

オートセットを実行してください。 

本器は、自動的に目的の信号を見つけ最適に表示するように動作しま

す。Autoset キーを押し、次に Autoset[F1]キーを押します。詳細につい

ては、62 ページを参照ください。 

装着してあるオプションを確認したい。 
 

システム情報ウィンドウのオプション項目をチェックしてください。 

System キー → System Information[F1]を押します。 

詳細については、115 ページを参照してください。 

性能が仕様と一致しない。 
 

本器の使用環境が、+20℃～30℃の環境で本器の電源をオンしてから

少なくとも 45 分以上経過しているか確認してください。 

本器が仕様と一致するためにこのことが必要です。 

より詳細な情報が必要な場合は、弊社までご連絡ください。 
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付録 

時計用電池の交換 
 

概要 システムクロックと自動起動（Wake-Up Clock ）は、

ボタン電池で動作していま。 

 電池の種類： CR2032, 3V, 210mAh 

交換 1. 本器の電源をオフし電源コードを

外します。 

背面下のバッテリーカバーを外し

ます。バッテリーが装着してある場

合は、バッテリーを取り外します。 

 2. 同じ性能で同じタイプの電池（CR2032）に交換しま

す。 

 

ボタン電池 



 性能が仕様と一致しない。 

285 

略語の用語集 
 

略語 内容・定義 

2FSK Binary Frequency Shift Keying 

3GPP 3rd Generation Partnership Project 

ACPR Adjacent Channel Power Ratio 

BS 基地局 

CF センター周波数 

CH BW チャンネル帯域幅 

CH SPC Channel Space 

CISPR 

国際無線障害特別委員会： 

International Special Committee on Radio 

Interference 

CNR 搬送波と雑音の比 

CSO 複合 2 次歪：Composite Second Order 

CTB 複合 3 次歪：Composite Triple Beat 

DANL 
表示平均ノイズレベル：Displayed Average Noise 

Level 

Def. 初期値、初期設定：Default 

DL Down Link 

DSSS-OFDM Direct Sequence Spread Spectrum- Orthogonal 

Frequency Division Multiplexing 

EMC 電磁両立性：Electromagnetic Compatibility 

EMI 電磁干渉：Electromagnetic Interference 

EMS 電磁感受性：Electromagnetic Susceptibility  

ERP-CCK Extended Rate Physical layer- Complimentary Code 

Keying 

ERP-DSSS Extended Rate Physical layer- Direct Sequence 

Spread Spectrum 

ERP-OFDM Extended Rate Physical layer- Orthogonal 

Frequency Division Multiplexing 

ERP-PBCC Extended Rate Physical layer- Packet Binary 

Convolutional Code 

ETSI European Telecommunications Standards Institute 

FDD Frequency-Division Duplexing 

IF Intermediate Frequency 
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HiSLIP High Speed LAN Instrument Protocol 

LOI 局部発振器：Local Oscillator 

LPF 低域通過フィルタ：Low Pass Filter 

LXI LAN eXtensions for Instrumentation 

OCBW Occupied Channel Bandwidth  

PSD Power Spectral Density 

P1dB One-dB compression point 

RBW Resolution Bandwidth 

REF リファレンス：Reference 

SEM Spectrum Emission Mask 

SINAD Signal to Noise and Distortion Ratio 

TDD Time-Division Duplexing 

TG Tracking Generator 

TOI Third Order Intercept 

UE User Equipment 

UP Up Link 

VBW Video Bandwidth 
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GSP-9330 の初期設定（Default Settings） 
以下のデフォルト設定は、工場出荷時の構成設定（機能設定/テスト設

定）です。 

 

周波数   

 センター周波数：1.625GHz スタート周波数：0Hz 

 ストップ周波数： 3.25GHz CF ステップ： Auto 

 周波数オフセット： 0Hz  

Span 

 Span：3.25GHz  

振幅 

 リファレンスレベル：0.00dBm アッテネータ：Auto 

 スケール目盛（Div）： 10 スケール表示： Off 

 Y 軸単位： dBm スケールの種類：Log 

 
リファレンスレベルオフセット： 

0.00dBm 
補正： Off 

 入力インピーダンス（Z）：50Ω 入力 Z 補正：6.000dB 

 プリアンプ設定：Bypass  

Autoset 

 Amp.Floor: Auto Span: Auto 

BW/AVG 

 RBW: Auto VBW: Auto 

 VBW/RBW: N/A Average: Off 

 Average Power: Log Power EMI Filter: Off 

Sweep 

 スイープ時間：Auto スイープ：連続（Continuous） 

 Gated Sweep Mode: Off Gate 遅延： 50ms 

 Gate Length: 540ms Sweep コントロール：Norm 

Trace 

 表示トレース：trace 1 トレースタイプ：Clear&Write 

 Trace 演算： Off ディテクタ： Auto, Normal 

Display 
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 ウィンドウ設定：Spectrum LCD 輝度： Hi 

 LCD バックライト： On 
ディスプレイライン：-50.0dBm, 

Off 

Meas 

 全測定機能： Off 

EMC Pretest 

 全 EMC テスト機能： Off 

Limit Line 

 Limit lines：Off Pass/Fail テスト： Off 

Trigger 

 Free Run トリガ条件：Video 

 トリガモード：Norm. トリガ遅延時間：50ms 

File 

 表示ファイルの種類： All 並び替え：ファイル名 

Quick Save 

 保存の種類：Screen データソース：Normal 

Save 

 保存の種類：Screen データソース：Normal 

Recall 

 呼出の種類：State  呼出先： Local State 

Marker 

 全マーカ： Off データソース：Normal 

Marker  

 N/A  

Peak Search 

 ピークトラック：Off Peak Excursion: 3dB 

 ピークしきい値：-50dBm ピークテーブル：Off 

Mode 

 モード：Spectrum   

Sequence 

 シーケンス オフ  

Option Control 

 トラッキングジェネレータ：Off パワーメータ： Off 

System 

 言語：出荷地域による 電源 ON：Preset 

 
Preset の種類：工場出荷時

プリセット 
Alarm 出力：Off 
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リモートインターフェース設定 

GPIB Address： 3 

LAN： DHCP 

LXI Password： lxiWNpwd 

HiSPIP Port：4880 

RS232 BaudRate： 115200 

USB Mode： Host 
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メニューツリー 

振幅：Amplitude 
 

Ref Level
-30 dB

Attenuation
10dB

Auto Man

Scale/Div
10 5     2     1

Auto Scale

Scale
On Off

Scale Pos.
Left Cent. Right

More
1/3

Y Axis>
dBm

Scale Type
Log Lin

Correction>

RefLvlOffset
0.000dB

Preamp
Auto     Bypass

Return
2/3

More
2/3

dBm

dBmV

dBuV

Watts

Volts

Select
Correction>

1

Correction
On               Off

Edit>

Save
Correction

Delete 
Correction

Return

Correction 1

Correction 2

Correction 3

Correction 4

Correction 5

Point Num
15

Frequency
1.2345 GHz

Gain Offset
10.00 dB

Delete Point

Return

Input Z
50 75

Input Z Cal
0.000dB

Return
3/3
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dBm

dBmV

dBuV

Watts

Volts

dBm

-dBm

W

mW

uW

nW

pW

dBmV

V

mV

uV

dBm

dBuV

V

mV

uV

dBm

W

mW

uW

nW

pW

dBm

V

mV

uV

dBmV

dBuV

dBm

Y Axis>
dBm

周波数, Span, Autoset, BW Avg, Sweep 
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Center Freq
1.2345GHz

Start Freq
1.2345GHz

Stop Freq
1.2345GHz

CF Step
1.00000MHz

Auto Man

Freq Offset
0.00Hz

Span
1.2345GHz

Full Span

Zero Span

Last Span

Autoset

Amp. Floor
-80.00dBm

Auto Man
Span

3.000000MHz
Auto Man

RBW
1MHz

Auto Man
VBW

1MHz
Auto Man

VBW/RBW
1.00000

Average
20

On               Off

Average Type>
Log Power

EMI Filter
On               Off

LOG Power

Volt Average

Power Average

Sweep Time
50.00 ms

Auto Man

Sweep Single

Sweep Cont

Gated Sweep
Mode

On Off

Gate Delay
50.0 ms

Gate Length
540 ms

Sweep Control

Norm.        Fast

リミットライン：Limit Line 
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Edit
Select Limit>

Pass/Fail
Test>

Limit Line>
1

Point by Point>

Trace Data to
Limit Line>

Mkr Data to
Limit Line>

Save Limit Line

Delete Limit
Line

Return

Point Num
1

Frequency
0Hz

Limit 
0.00 dBm

Delete Point

Return

High Limit>
Off

Low Limit>
Off

Pass Criterion
All-In Max-In

Min-In

Pass/Fail Test
On               Off

Pass/Fail Mode
Single      Cont.

Return

Limit 1

Limit 2

Limit 3

Limit 4

Limit 5

OFF

Point Num
1

Mkr Data to
Point

Limit Offset

Return

Limit 1

Limit 2

Limit 3

Limit 4

Limit 5

Create Limit Line
Now

Limit Offset
0.000dB

Return

トリガ：Trigger, シーケンス：Sequence 
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Free Run

Trigger 
Condition>

Video

Trigger Mode
Norm. Sgl. Cont.

Trigger Delay
50.0 ms

Action Now

Video>

Ext. Edge
Pos Neg

Return

Video Edge
Pos Neg

Video Level
10.00dBm

Trigger Freq
1.12345M Hz

Return

Sequence>
1

Edit>

Save Sequence

Run Mode
Single Cont.

Run Now

Start Edit

Delay Time
100 ms

Wait to Go

Do Sequence>
1

Delete Step

Stop Edit

Return

Sequence 1

Sequence 2

Sequence 3

Sequence 4

Sequence 5

Continue

Stop Running 
Sequence

Delete Sequence

Only for when “Wait to 
go” is used in the 

sequence

 

トレース：Trace  
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Select Trace>
1

Clear & Write

Max Hold
-130.0dBm

Min Hold

View

Blank

More
1/2

Trace Math>

Detection>
Normal

Auto Man

Return

TR1>
Trace 2

TR2>
Trace 2

Power Diff
TR1-TR2

Log Diff
-50.00dBm

TR1-TR2+Ref
Log Offset

0.00dB
TR1 + Offset

OFF

Return

Trace

Trace 1

Trace 2

Trace 3

Trace 4

Auto

Normal

Peak +

Peak -

Sample

RMS Average

EMI>

Quasi Peak

Average

 

画面・表示：Display 
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Spectrogram
Marker

On Off

Ref.>

Delta>

Topographic
Marker

On Off

Ref.>

Delta>

Restart

X Axis
xxx

Y Axis
yyy

Frequency
Hz

Amplitude
dBm

Time
s

Return

X Axis
xxx

Y Axis
yyy

ΔFrequency
Hz

ΔAmplitude
dB

ΔTime
s

1/ΔTime
Hz

Return

Window Setup>

LCD Brightness
Hi Mid Lo

LCD Backlight
On Off

Display Line
-50.00dBm

On Off

Spectrum

Split Spectrum>

Spectrogram

Topographic

Spectrogram
+

Spectrum
Topographic

+
Spectrum

Return

Active Win.
Upper Lower

Alternate
Sweep

Return

Display

On ffOOnOO

Return

マーカ：Marker 
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Select Marker>
1

on off

Normal

Delta>

Function>

All Off

More 
1/2

Marker 1

Marker 2

Marker 3

Marker 4

Marker 5

Marker 6

Delta

Move Ref

Move Delta

Move Pair 
Span

Move Pair 
Center

Return

Marker Trace>
Trace 1

Auto Man

Marker Table
On               Off

Return 2/2

Auto

Trace 1

Trace 2

Trace 3

Trace 4

Freq  Counter>

Marker Noise
On               Off

Return

Freq Counter
On               Off

Resolution
1kHz

Auto Man

Return

Marker

ピークマーカ：Peak Search, Marker  
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Marker  

Peak Search

Mkr>Center

Next Peak

Next Peak Right

Next Peak Left

Min Search

More 
1/2

Peak Track
On Off

Peak Excursion
10.00dB

Peak Threshold
-50.00dBm

On                 Off

Peak Table>

Return
2/2

Peak Table
On Off

Peak Sort
Freq Amp

Return

Mkr>Center

Mkr>Start

Mkr>Stop

Mkr>CF Step

Mkr>RefLvl

システム：System 
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System 
Information

Error message>

Language>
English

Date/Time>

Pwr On/preset>

Alarm Output
On Off

More
1/2

Show Error
message

Prev Page

Next Page

Clear Error
queue

Return

Power On
Last Preset

Preset Type>

Save User 
Preset

Return

Rmt Interface
Config>

Upgrade

Service>

Return
2/2

Set Date>

Set Time>

Wake-Up Clock
Edit>

Clock
On Off

Return

Year
2011

Month
10

Day
5

Return

User Preset

Factory Preset

Hour
5

Minute
11

Second
52

Return
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Select Clock>
1

State
On Off

Hour
10

Minute
08

Rept. Single

Select Date>
Monday

Return

Clock 1

Clock 2

Clock 3

Clock 4

Clock 5

Clock 6

Clock 7

Monday

Tuesday

Wednesday

Thursday

Friday

Saturday

Sunday

System>Date/ Time>
Wake-Up Clock Edit>の続き

English

簡体中文

繁體中文

Pусский

日本語

Return

System>Language
の続き
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300

600

1200

2400

4800

9600

More 1/2

19200

38400

57600

115200

Return

GPIB Addr
3

LAN>

LAN Reset

RS232
Baud Rate>

115200

USB Mode
Host Device

Return

の続き
System>More 1/2>
Rmt Interface Config>

IP Address
0.0.0.0

Subnet Mask
0.0.0.0

Default
Gateway

0.0.0.0

DNS Server

LAN Config
DHCP Manual

Apply

Return

LAN Config>

WLAN Config>

LXIPassword>

Hi SLIP Port

4880

Return

OK

Cancel

IP Address
0.0.0.0

Subnet Mask
0.0.0.0

Default
Gateway

0.0.0.0

DNS Server

Apply

Return
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ABCDE

FGHIJ

KLMNO

PQRST

UVWXY

Z

Return

A

B

C

D

E

Lowercase

Return

a

b

c

d

e

Return

System>More 1/2> Rmt
Interface Config>LAN>LXIPasswordの続き

オプション：Option Control  
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Tracking 
Generator>

Power Meter>

Demo Kit>

Power Meter
On Off

Power Unit
dBm mV

Frequency
3 MHz

Sensor Mode
LowNoise Fast

Pass/Fail
Test>

More
1/2

Return

High Limit
-10 dBm

Low Limit
-10 dBm

Pass Fail Test
On               Off

Return

Option 
Control

TG
On Off

TG Level
0.00dBm

TG Lvl Offset
0.000dB

TG Lvl Step
0.000dB

Auto Man
Power Sweep

0.000dB
On Off

Normalize>

Return

Exe. Norm.

Norm. 
Ref. Level

0.000dB
Norm.

Ref. Position
10

Norm
On Off

Return
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変
調

=
F

S
K
の
み

Demo Kit
On Off

Modulation>
ASK

Frequency>
315MHz

Deviation>
25kHz

Baudrate>
4800

Output Mode
Gated

Return

Option Control>Demo Kitの続き

Normal

Gated

Seq1
00110101

Seq2
10100101

Seq3
00010010

Seq4
11011100

Seq5
10101010

4800

9600

20000

25kHz

50kHz

ASK

FSK

315MHz

433MHz

868MHz

ファイル操作：File 
 



 ファイル操作：File 

305 
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All

State

Trace

Screen

Limit Line

Correction

More 1/2

Sequence

Power Meter

Return 2/2

Delete Now

Delete Warning
Don’t Ask Ask

Return

ABCDE

FGHIJ

KLMNO

PQRST

UVWXY

Z

Return

A

B

C

D

E

Lowercase

Return

a

b

c

d

e

Return

File>Typeの続き File>Deleteの続き

File>Renameの続き

.sta

.tra

.jpg

.cor

.seq

.pmet

Delete All
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保存：Save 
 

(モード = パワーメータ) 

See: File>Rename

According to type:

Save To>
Local

Type>
State

Data Source>
Local State

PMET
Record Option>

Name>

Record Stop

Record Now

State

Screen

Power Meter

Record Stop
00: 00: 00

Record Step
1 s

Return

Power Meter
State Local State Normal

Save Toner

Hour
06

Minute
07

Second
08

Return

See: Save>Save To
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Register 1

Register 2

Register 3

Register 4

Register 5

Register 6

Return

Register>

Local

USB

SD Card

Return

From: Save>Save To 



 呼出：Recall 
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(モード = スペクトラム) 

Save To>
Local

Type>
Trace

Data Source>
Trace 1

Format>
Trace

Name>

Save Now

State

Trace

Screen

Line Line

Correction

Sequence

Power Meter

Trace

Trace + State

Local State Trace 1

Trace 2

Trace 3

Trace 4

Normal

Save Toner

Limit 1

Limit 2

Limit 3

Limit 4

Limit 5

Save

Correction 1

Correction 2

Correction 3

Correction 4

Correction 5

Sequence 1

Sequence 2

Sequence 3

Sequence 4

Sequence 5

Save>Save Toを参照

File>Renameを参照

Traceのとき

State Trace Screen Limit Line Correction Sequence

 

呼出：Recall 
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(モード = パワーメータ) 

According to type:

Recall From>
Local

Type>
State

Destination>
Local State

Recall Now

State Local State
.sta

Register 1

Register 2

Register 3

Register 4

Register 5

Register 6

Return

Register>

Local

USB

SD Card

Return
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(モード = スペクトラム) 

Recall From>
Local

Type>
Trace

Destination>
Trace 1

Recall Now

State

Trace

Line Line

Correction

Sequence

Power Meter

Local State Trace 1

Trace 2

Trace 3

Trace 4

Limit 1

Limit 2

Limit 3

Limit 4

Limit 5

Correction 1

Correction 2

Correction 3

Correction 4

Correction 5

Sequence 1

Sequence 2

Sequence 3

Sequence 4

Sequence 5

.sta

.tra

.cor

.lmt

.seq

Register 1

Register 2

Register 3

Register 4

Register 5

Register 6

Return

Register>

Local

USB

SD Card

Return

 

自動測定：Measure 
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Channel
Analysis>

Demod>

2FSK

Phase Jitter>

SEM>

TOI>

More
1/2

ACPR Setup>

ACPR
On Off

OCBW Setup>

OCBW
On Off

Channel
Move Up

Channel
Move Down

Return

Main CHBW
2.000000MHz

Main CH
HLimit

0.00dBm
Main CH

LLimit
0.00dBm

CH SPC
2.000000MHz

ADJCH
Setup>

Def. Help
On Off

Return

Measure

Meas>Demodを参照

Phase Jitter
On Off

Start Offset
0Hz

Stop Offset
0Hz

Return

2FSK
On Off

Peak Threshold
-50.00dBm

On Off

Max Hold
-130.0dBm

Restart

Limit Edit>

Pass/Fail Test
On Off

Return

CHBW
2.000000MHz

CH SPC
2.000000MHz

OCBW %
90.0%

Return

Select Adj Ch>
1

on off

ADJ CHBW
2.000000MHz

ADJ CH Offset
2.000000MHz

ADJ CH
H Limit

0.00dBm

ADJ CH
L Limit

0.00dBm

Return

AdjCh 1

AdjCh 2

AdjCh 3

CNR/CSO/CTB>

Harmonic>

NdB
Bandwidth>

P1dB>

Return
2/2
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AM Analysis>

FM Analysis>

Sound>

ASK>

FSK>

Return

Setup>
CNR

CNR
On Off

CNR
CH SPC

6.000 MHz

Channel
Move Down

Channel
Move Up

Return

CNR>

CSO

CTB>

Return

Noise Marking
Min ΔMarker

Return

Restart

Return

Measure>Demodの続き

Measure>More>CNR/CSO/CTBの続き

NdB BW
On Off

N dB
0.000dB

Return

TOI
On Off

Reference
Lower Upper

Limit
-30.00dBm

Pass/Fail Test
On Off

Return

Measure>TOIの続き

Earphone Out
On Off

Volume
10

Digital Gain
Control

0.000dB

Demod Type
AM FM

Return

Measure>More>
NdB Bandwidthの続き
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IF Bandwidth
300kHz

LPF>
Bypass

Time Axis>

Depth Axis>

AF Trigger>

Squelch Level
-130.0dBm

Return

Bypass

1.6MHz

781kHz

521kHz

391kHz

313kHz

Ref. Value
0.0ns

Ref. Pos
5

Scale/Div
10.00ms

Auto Scale
On Off

Return

Ref. Value
0.0 %

Ref. Pos
5

Scale/Div
10 %

Auto Scale

Return

Free Run

Trigger Setup>

Start Time
0.00 ns

Stop Time
20.0 ms

Action Now

Return

Measure>Demod>AM
Analysisの続き

Decimation
frequency*

AM Analysis
On Off

Setup>

Min/Max Reset

Limit Edit>

Pass/Fail Test
On Off

Return

Edge Slope
Rising Falling

Trigger Mode
Norm. Sgl. Cont.

Trigger Level
10 %

Trigger Delay
50 ms

Return

* 選択可能な LPF フィルタについては、130 ページを参照ください。 
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IF Bandwidth
300kHz

LPF>
Bypass

Time Axis>

Deviation Axis>

AF Trigger>

Return

Bypass

16kHz

7.8kHz

5.2kHz

3.9kHz

3.1kHz

Ref. Value
0.0ns

Ref. Pos
5

Scale/Div
10.00ms

Auto Scale
On Off

Return

Ref. Value
30Hz

Ref. Pos
5

Scale/Div
10 Hz

Auto Scale

Return

Free Run

Trigger Setup>

Start Time
0.00 ns

Stop Time
20.0 ns

Action Now

Return

Measure>Demod>FM
Analysisの続き

Decimation
frequency*

FM Analysis
On Off

Setup>

Min/Max Reset

Limit Edit>

Pass/Fail Test
On Off

Return

Edge Slope
Rising Falling

Trigger Mode
Norm. Sgl. Cont.

Trigger Level
10 Hz

Trigger Delay
50 ms

Return

 
*選択可能な LPF フィルタについては、135 ページを参照ください。 
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ASK Analysis
On Off

Bit Rate
100 bit/s

IF Bandwidth
30kHz

Axis>

Preamble/Sync>

More
1/2

Return

Measure>Demod>ASKの続き

Time Axis>

Depth Axis>

Return

Ref. Value
0

Ref.Pos
0

Scale/Div
2

Return

Preamble Bits
16

Ref. Value
0.0%

Ref.Pos
5

Scale/Div
20.0%

Auto Scale

Return

Preamble/Sync
On Off

Sync Bits
16

Sync Words
0

Return
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View>
Waveform

Trigger>

Meas Length
100

Limit Edit>

Pass/Fail Test
On Off

Min/Max Reset

Return

Measure>Demod>ASK>More 1/2の続き

Symbol

Waveform

Symbol Setup>

Return

Decoding>
None

Decode Invert
On Off

Format
Bin Hex

Return

Carr. Offset
500Hz

None

Miller

Manchester

D_Manchester

Bi-Phase

AM Depth
100.0%

Carr. Power
0.00dBm

Compare Values

Compare Number
1

Return

Trigger
Condition>

RF

Free Run

Trigger Mode
Norm. Sgl.Cont.

Trigger Delay
0.00ns

Action Now

Trigger Setup>

Return

Ext. Edge
Pos Neg

RF Trigger
-30.00dBm

Video Edge
Off Pos   Neg

Return

Stop Bits
0

Start Bits
0

Return
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FSK Analysis
On Off

Bit Rate
100 bit/s

IF Bandwidth
30kHz

Axis>

Preamble/Sync>

More
1/2

Return

Measure>Demod>FSKの続き

Time Axis>

Deviation Axis>

Return

Ref. Value
0

Ref.Pos
0

Scale/Div
2

Return

Preamble Bits
16

Ref. Value
0.0%

Ref.Pos
5

Scale/Div
20.0%

Auto Scale

Return

Preamble/Sync
On Off

Sync Bits
16

Sync Words
0

Return
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View>
Waveform

Trigger>

Meas Length
100

Limit Edit>

Pass/Fail Test
On Off

Min/Max Reset

Return

Measure>Demod>FSK>More 1/2の続き

Symbol

Waveform

Symbol Setup>

Return

Decoding>
None

Decode Invert
On Off

Format
Bin Hex

Return

Carr. Offset
500Hz

None

Miller

Manchester

D_Manchester

Bi-Phase

Freq. Deviation
100Hz

Carr. Power
0.00dBm

Compare Values

Compare Number
1

Return

Trigger
Condition>

RF

Free Run

Trigger Mode
Norm. Sgl.Cont.

Trigger Delay
0.00ns

Action Now

Trigger Setup>

Return

Ext. Edge
Pos Neg

RF Trigger
-30.00dBm

Video Edge
Off Pos   Neg

Return

Stop Bits
0

Start Bits
0

Return
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Measure>2FSK>Limit Editの続き

Freq. Deviation
200.000kHz

Carr.Offset
200.000kHz

High Limit
30.00dBm

Low Limit
-120.0 dBm

Return

From: Measure>Demod>FM Analysis>Limit Edit

Freq. Deviation
200.000kHz

Carr.Offset
200.000kHz

Carr.Power
0.00dBm

Return

Measure>Demod>AM Analysis>
Limit Editの続き

AM Depth
100.0%

Carr.Offset
200.000kHz

Carr.Power
0.00dBm

Return
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SEM Setup>
3GPP

SEM
On Off

Def. Help
On Off

Return

3GPP>

802.11b>

802.11g>

802.11n>

802.16>

User Define>

Return

Meas Type>
Total pwr Ref

Ref. Channel>

Offset/Limit>

Return

Chan Integ BW
3.84 MHz

Chan Span
3.96 MHz

RBW
10kHz

Auto Man
Total Pwr Ref

-74.3dBm
Auto Man

Return

Duplexing Mode
FDD TDD

FDD Setup>

TDD Setup>

Return

Meas Type>
PSD Ref

Ref. Channel>

Offset/Limit>

Return

Measure>SEMの続き

Measure>SEM> 3GPP>
REF. Channelの続き

Measure>SEM>3GPP>
Offset/Limitの続き
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Transmission
BS               UE

Chip Rate
3.84M 1.28M

7.68M

Min Offset/Limit
Value>

Return

Offset
1 2    3    4   5

On Off

Start Freq
2.7MHz

Stop Freq
2.7MHz

RBW
3MHz

More
1/2

Return

Offset
1 2    3    4   5

Rel Start
-22dBm

Rel Stop
-22dBm

Return

P>=34

26<=P<34

P<26

P>=43

39<=P<43

31<=P<39

P<31

From: Measure>SEM>3GPP> 
Offset/Limit>TDD Setup Chip Rate = 3.84/7.68M

Chip Rate = 1.28M

Transmission
BS UE

Chip Rate
3.84M 1.28M

7.68M

Max Out Pwr>
P>=43

Min Offset/Limit
Value>

Return

Offset
1 2    3    4   5

On Off

Start Freq
2.7MHz

Stop Freq
2.7MHz

RBW
3MHz

More
1/2

Return

Offset
1 2    3    4   5

Abs Start
-22dBm

Abs Stop
-22dBm

Return

From: Measure>SEM>3GPP> 
Offset/Limit>TDD Setup

BS 
Mode

UE 
Mode
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Offset
1 2     3      4

Start Freq
2.7MHz

Stop Freq
2.7MHz

RBW
3MHz

Rel Start
-22dBc

Rel Stop
-22dBc

Return

Chan Integ BW
3.84MHz

Chan Span
3.96MHz

RBW
10kHz

PSD Ref
-74.3dBm/Hz

Return

Modulation>
ERP-OFDM/

DSSS-OFDM

Min Offset/Limit
Value>

Return

ERP-OFDM/
DSSS-OFDM

ERP-DSSS/
ERP-PBCC/

ERP-CCK

Channelization
10M 20M

Min Offset/Limit
Value>

Return

Offset
1 2

Start Freq
2.7MHz

Stop Freq
2.7MHz

RBW
3MHz

Rel Start
-22dBc

Rel Stop
-22dBc

Return

CH BW
20M 40M

Min Offset/Limit
Value>

Return

Measure>SEM>
802.11b/g/n/
802.16>Ref. Channel

Measure>SEM>
802.11g>Offset/
Limitの続き

Measure>SEM>
802.11n>Offset/
Limitの続き

Measure>SEM>
802.16>Offset/Limit

Measure>SEM>
802.11b>Offset/Limit

Measure>SEM>
802.11n/802.16>Offset/Limit>
Min Offset/Limit

の続き

の続き の続き
の続き
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Measure>SEM>802.11g>
Offset/Limit>Min Offset/Limit

802.11g modulation=OFDM

Offset
1 2

On Off

Start Freq
2.7MHz

Stop Freq
2.7MHz

RBW

More
1/2

Return

Offset
1

Rel Start
-22dBc

Rel Start
-22dBc

Return

Offset
1 2      3     4

On Off

Start Freq
2.7MHz

Stop Freq
2.7MHz

RBW

More
1/2

Return

Measure>SEM>802.11g >
Offset/Limit>Min Offset / Limitの続き

802.11g modulation=DSSS

Offset
1 2      3     4

Rel Start
-22dBc

Rel Start
-22dBc

Return

3 4 2 3 4
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Absolute

Relative

Abs AND Rel

Abs OR Rel

Meas Type>
Total Pwr Ref

Ref. Channel>

Offset/Limit>

Return

Total Pwr Ref

PSD Ref

Chan Integ BW
3.84MHz

Chan Span
3.96MHz

RBW
10kHz

Auto Man
Total Pwr Ref

-74.3dBm
Auto Man

Return

Offset
1 2   3    4    5

On Off

Start Freq
2.7MHz

Stop Freq
2.7MHz

RBW
10kHz

Auto Man

More
1/2

Return

Offset
1 2   3    4    5

Abs Start
-22dBm

Abs Stop
-22dBm

Rel Start
-22dBc

Rel Stop
-22dBc

Couple Man

Fail Mask>
Absolute

Return

From: Measure>SEM> 
User Define>
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EMC プリテスト 
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None

Cor.factor

Band

Amb.Noise

Collection

9k-150kHz

Reject
None High

None
On Off

Recall limit
None

On Off

Peak Table
On Off

Scale Type
Log Lin

Return

None

Horizontal

Vertical

Other factor

EMI Test>

EMI Test >

Field Sensor>

AC Voltage

>

EMS Test>

EMC
Pretest

Select
Correction

2

Correction
On Off

Edit

Return

Off
None

EN55022A

EN55022B

FCC A

FCC B

EMI Test:Band=
9k-150kHz
または
150k-30MHz

Source Contact
>Probe

Probe

>Band

Amb.Noise

Collection

User Define

Reject
None High

None
On Off

Recall limit
None

On Off

Peak Table
On Off

Scale Type
Log Lin

Return Return

9k-150kHz

1GHz-3GHz

User Define

150k-30MHz

30M-300MHz

300M-1GHz

30M-1GHz

>

Delete

Collection

Save Collection

ReturnReturn

Average

Quasi-peak

Both

Return

None

EN55022A

EN55022B

FCC A

FCC B

Return
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EMC
On Off

EMI Test>

Field Sensor>

Source Contact
Probe>

AC Voltage
Probe>

EMS Test>

EMC
Pretest

User Define>

Return

Band>
User Define

Correction
None

On Off
Recall limit

None
On Off

Peak Table
On Off

Return

30M-300MHz

300M-1GHz

30M-1GHz

None

EN55022A

EN55022B

FCC A

FCC B

Return

None

3m

10m

Other
factor

Return

EMC
On Off

EMI Test>

Field Sensor>

Source Contact
Probe>

AC Voltage
Probe>

EMS Test>

EMC
Pretest

150k-30MHz

Pretest

Debug

Return

Recall limit
None

On Off

None

EN55022A

EN55022B

FCC A

FCC B

Return

Average

Quasi-peak

Both

Return
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GSP-9330 仕様 
本器は、特に指定しない限り温度 20℃～30℃で電源を入れてから少な

くとも 45 分間以上ウォームアップした状態のときの仕様です。 

  45 分代表値、最大 90 分 

周波数 
 

周波数 

 

 

レンジ 9 kHz～3.25 GHz  

分解能 1 Hz  

周波数リファレンス 

 確度 ±(最終調整からの周期×エージングレート)＋ 

全温度範囲での安定度+供給電圧の安定度 

エージングレート ±1 ppm max. 最終校正から 1 年 

 全温度範囲での

周波数安定性 

±0.025 ppm 0℃～50℃ 

 供給電圧の安定

性 

±0.02 ppm  

周波数リードアウト確度 

 Start, Stop, 

Center, Marker 

±(マーカ周波数表示 X 周波数リファレンス確度 

+ 10% x RBW + 周波数分解能 1) 

トレースポイント数 最大 601 ポイント, 最小 6 ポイント 

マーカ周波数カウンタ 

 分解能 1Hz, 10Hz, 100Hz, 1kHz 

確度 ±(マーカ周波数表示 X 

周波数リファレンス確度 + 

カウンタの分解能) 

RBW/Span >=0.02 ; 

Mkr レベルから

DNL>30 dB 

周波数スパン 

 レンジ 0Hz (ゼロスパン),  

100Hz ～3.25GHz 

 

 分解能 1Hz  

 確度 ±周波数分解能 1 RBW： Auto; 

位相ノイズ 

 キャリアからのオ

フセット 

 Fc =1GHz; 

RBW=1kHz, VBW = 

10Hz;平均≧40 

10kHz <-88 dBc/Hz Typical2 

100kHz <-95 dBc/Hz Typical 
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1MHz <-113 dBc/Hz Typical 

分解能帯域幅(RBW)フィルタ 

 フィルタ帯域幅 1Hz～1MHz, 1-3-10 シー

ケンス 

-3dB 帯域幅 

200Hz, 9kHz, 120kHz, 

1MHz 

-6dB 帯域幅 

確度 ± 8％, RBW = 1MHz Nominal3 

± 5%％ RBW < 1MHz Nominal 

シェープファクタ < 4.5：1 Nominal ;  
Normal Bandwidth 
ratio: -60dB:-3dB 

ビデオ帯域幅 (VBW)フィルタ 

 フィルタ帯域幅 1Hz～1MHz, 1-3-10 シー

ケンス 

-3dB 帯域幅 

[1] 周波数分解能 = Span/(トレースポイント数 - 1) 

[2] このデータシート上の Typical（代表値）は、性能が温度範囲 20℃～30℃、信頼

レベル 95％で製品の 80％が示す性能を意味します。それらは製品保証の対象で

はありません。 

[3] Nominal（公称値）は、性能の期待値を示します。性能保証の対象ではない製品

性能を示します。 

振幅 
 

振幅範囲 
 測定範囲 100kHz～1MHz 表示平均ノイズレベ

ル(DANL)～18dBm 

1MHz～10MHz DANL～21dBm 

10MHz～3.25GHz DANL～30dBm 

アッテネータ 

 入力アッテネータ

範囲 

0～50dB, 1dB ステップ Auto または manual 

ステップ 

最大安全入力レベル 

 平均トータル電力 ≦ +33dBm 入力アッテネータ 

≧10dB 

 DC 電圧 ±50V  

1 dB Gain Compression 

 トータル電力  

1st Mixer にて 

> 0dBm Typical; Fc≧50MHz; 

プリアンプ オフ 

 トータル電力 

プリアンプにて 

> -22dBm Typical; Fc≧50MHz; 

プリアンプ オン 
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  ミキサ電力レベル(dBm)=  

入力電力(dBm)－アッテネータ (dB) 

表示平均ノイズレベル (DANL)4 

 プリアンプ オフ ATT 0dB; RF 入力は 50Ω負荷に終端.  

RBW 10Hz; VBW 10Hz; span 500Hz;  

Ref レベル=  -60dBm; トレース平均≧40 

 9kHz～100kHz <-93dBm 

Nominal 

 100kHz～1MHz <-90dBm－3×(f/100kHz) 

dB 

 1MHz～2.7GHz < -122 dBm 

 2.7GHz～3.25GHz < -116 dBm 

 プリアンプ オン ATT 0dB; RF 入力を 50Ω終端; RBW 10Hz; VBW 

10Hz; span 500Hz;  Ref レベル =  -60dBm;  

トレース平均≧ 40 

 100kHz～1MHz <-108dBm-3×(f/100kHz) 

dB 

Nominal  1 MHz～10MHz < -142dBm 

 10MHz～3.25GHz < -142dBm＋3×(f/1GHz) 

dB 

[4] DANL の仕様は、スプリアス応答を含みます。 

 

レベル表示範囲 

 スケール Log, Linear  

 単位 dBm, dBmV, dBuV, V, W  

 マーカレベル 

リードアウト 

0.01dB Log スケール 

  リファレンスレベルの 0.01 

% 

Linear スケール 

 レベル表示モード トレース, トポグラフィック, 

スペクトログラム 

単一/分割ウィンドウ 

 トレース数 4  

 ディテクタ ＋ピーク, －ピーク, サンプ

ル,  ノーマル, RMS(not 

Video), Quasi-Peak, 

Average 

トレースごとに設定可

能 

 トレース機能 Clear & Write, 最大/最少

ホールド, ビュー, ブランク, 

平均 

 

絶対振幅確度 
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 絶対ポイント センター=160MHz ; RBW 10kHz; VBW 1kHz;  

span 100kHz; log スケール; 1dB/div; ピークディ

テクタ; 23℃±1℃; 信号はリファレンスレベル 

 プリアンプ オフ ± 0.3dB Ref レベル 0dBm;  

RF ATT10dB 

 プリアンプ オン ± 0.4dB Ref レベル -30dBm; 

RF ATT 0dB 

周波数応答 

 プリアンプ オフ ATT: 10dB; リファレンス 160MHz; 20℃～30℃ 

 100kHz～2.0GHz ±0.5dB  

 2GHz～3.25GHz ±0.7dB  

 プリアンプ オン ATT： 0dB; リファレンス 160MHz; 20℃～30℃ 

 1MHz～2GHz ±0.6dB  

 2GHz～3.25GHz ±0.8dB  

アッテネータ切替の不確かさ 

 アッテネータ設定 0～50dB, 1dB ステップ  

 不確かさ ±0.25dB リファレンス：160MHz, 

ATT 10dB 

RBW フィルタ切替の不確かさ 

 1Hz～1MHz ±0.25dB リファレンス：10kHz 

RBW 

レベル測定の不確かさ 

 全体の振幅確度 ±1.5dB 20℃～30℃; 周波数 > 1MHz;  

信号入力 0～-50dBm; 

 リファレンスレベル 0～-50dBm;  

入力 ATT 10dB;   

RBW  1kHz; VBW 1kHz; 校正後;  

プリアンプ オフ 

 ±0.5 dB Typical 
スプリアス応答 

 第 2 高調波 

インターセプト 

 プリアンプ オフ; 入力信号 -30dBm; 

ATT 0dB 

 +35 dBm Typical; 10MHz < fc < 775MHz 

 +60 dBm Typical; 775MHz≦ fc < 1.625GHz 

 3 次 

インターセプト 

  プリアンプ オフ; 入力信号 -30dBm; 

ATT 0dB 

 > 1dBm 300MHz～3.25GHz 

 入力スプリアス 

関連 

< -60dBc 入力信号レベル -30dBm, ATT. 

モード, Att=0dB; 20℃～30℃  

 残留応答（固有） <-90dBm 入力端子; Att 0dB; プリアンプ オフ
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スイープ 
 

スイープ時間 
 レンジ 310µs～1000s Span > 0Hz 

 50µs～1000s Span = 0Hz; Min 

Resolution = 10µs 

 スイープモード 連続; シングル  

 トリガソース Free run; Video; External  

 トリガスロープ ＋エッジまたは－エッジ  

RF プリアンプ 
 

 周波数範囲 1MHz～3.25GHz  

 ゲイン 18dB Nominal 

  (標準装備) 

前面パネル入力/出力 
 

RF 入力 
 コネクタの種類 N 型端子、メス  

 インピーダンス 50Ω Nominal 

 VSWR <1.6：1 300kHz～3.25GHz;  

入力 ATT≧10dB 

オプション用電源 

 コネクタの種類 SMB 端子、オス  

 電圧/電流 DC +7V/ 最大 500mA 短絡保護あり 

USB ホスト 

 コネクタの種類 A プラグ  

 プロトコル Version 2.0 Full/High/Low 

スピードをサポート 

MicroSD ソケット 

 プロトコル SD 1.1  

 サポートカードの

種類 

 microSD, microSDHC 最大容量 32GB まで 

背面パネルの入力/出力 
 

リファレンス出力 
 コネクタの種類 BNC 端子、メス  

 出力周波数 10MHz Nominal 
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 出力振幅 3.3V CMOS  

 出力インピーダン

ス 

50Ω  

リファレンス入力 

 コネクタの種類 BNC 端子、メス  

 入力リファレンス

周波数 

10MHz  

 入力振幅 -5dBm～＋10dBm  

 周波数ロック範囲 入力リファレンス周波数の

±5ppm 以内 

 

アラーム出力 

 コネクタタイプ BNC 端子 メス オープンコレクタ出力

トリガ入力/ ゲートスイープ入力 

 コネクタの種類 BNC 端子、メス  

 入力振幅 3.3V CMOS  

 切り替え 機能により自動選択  

LAN TCP/IP インターフェース 

 コネクタの種類 RJ-45  

 Base 10Base-T; 100Base-Tx; Auto-MDIX 

USB デバイス 

 コネクタの種類 B プラグ リモートコントロールのみ 

USB TMC をサポート 

 プロトコル Version 2.0 Full/High/Low Speed をサポート

IF 出力 

 コネクタの種類 SMA 端子、メス  

 インピーダンス 50Ω Nominal 

 IF 周波数 886 MHz Nominal 

 出力レベル -25 dBm ATT：10 dB;  

RF 入力: 0dBm @ 1GHz 

イヤフォン出力 

 コネクタの種類 3.5mm ステレオジャック, モノラル結線 

ビデオ出力 

 コネクタの種類 DVI-I (Integrated analog and digital) , Single Link. 

アダプタ経由で VGA または HDMI 規格に対応 

RS-232 インターフェース 

 コネクタの種類 D-sub 9 ピン、メス Tx, Rx, RTS, CTS 

GPIB インファーフェース(GSP-9330VG、GSP-9330VGT) 

 コネクタの種類 IEEE-488 bus コネクタ  

AC 電源電圧 

 電源 AC 100 V～240 V, 50 / 60 Hz 

自動レンジ切り替え 
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バッテリーパック (別売アクセサリ) 

 バッテリーパック 6 セル, Li-Ion 充電式, 

3S2P 

With UN38.3 

Certification 

 電圧 DC 10.8 V  

 容量 5200 mAh / 56Wh  

一般 
 

 ディスプレイ 8 インチ、SVGA（

800600）カラー液晶

 

 内部データ保存 16 MB nominal  

 消費電力 <82 W  

 Warm-up Time < 45 分  

 温度範囲 +5℃～+45℃ 動作 

 -20℃～ + 70℃ 保存 

 質量 約 4.5 kg (9.9 lb) 全オプションを装着 (基本

+TG+GPIB+バッテリー) 

 寸法 350（W） x 210（H） x 

100（D）mm 

 

  13.8 x 8.3 x  3.9 (in)  

トラッキングジェネレータ 5 (GSP-9330VT,GSP-9330VGT)  
 

 周波数範囲 100kHz～3.25GHz  

 出力電力 -50 dBm～0 dBm in 0.5 dB ステップ 

 絶対確度 ± 0.5 dB @160 MHz, -10 dBm, ソー

ス-スアッテネータ 10 dB, 

20℃～30℃ 

 出力平坦性 リファレンス～160MHz, -10dBm 

 100 kHz～2 GHz ± 1.5dB 

 2 GHz～3.25 GHz ± 2 dB 

 出力レベルスイッチ

ング不確定 

± 0.8 dB リファレンス～-10dBm 

 高調波 < -30 dBc Typical, 出力レベル= -10 

dBm 

 Reverse Power 最大＋30 dBm  

 接続の種類 N 型、メス  

 インピーダンス 50Ω Nominal 

 出力 VSWR < 1.6：1 300 kHz～3.25 GHz, ソー

スアッテネータ≧12 dB 
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[5] TG 出力オンのとき、最小 RBW フィルタは 10kHz。 

GSP-9330 寸法図 
 

 

LOCAL

Quick
Save

/ Enter

BK  SP

Fast/
Normal

RF  INPUT  50

REV  PWR  +30dBm

TG  OUTPUT  50 500mA  MAX.

DC  7V

OUTPUT +30dBm   MAX.

MAX.DC ±50V MAX.DC ±50V

9 kHz     3.25 GHz

Spectrum  AnalyzerG S P -9 3 3 0

350.0
100.0

105.7
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Declaration of Conformity 

 

We 

GOOD WILL INSTRUMENT CO., LTD. 
No. 7-1, Jhongsing Rd, Tucheng Dist., New Taipei City 236, Taiwan  

GOOD WILL INSTRUMENT (SUZHOU) CO., LTD. 
No. 69 Lushan Road, Suzhou New District Jiangsu, China. 

declare that the below mentioned product 

Type of Product: Spectrum Analyzer 
Model Number: GSP-9330 
is herewith confirmed to comply with the requirements set out in the 
Council Directive on the Approximation of the Laws of the Member States 
relating to the Low Voltage Directive (2006/95/EC) and Electromagnetic 
Compatibility (2004/108/EC). 
 
For the evaluation regarding the Electromagnetic Compatibility and Low 
Voltage Directive, the following standards were applied: 
 

◎ EMC 
EN 61326-1 : 
EN 61326-2-1: 
EN 61326-2-2: 

Electrical equipment for measurement, control and 
laboratory use –– EMC requirements (2006) 

Conducted and Radiated Emissions 

EN 55011: 2009+A1: 2010 

Electrostatic Discharge 

EN 61000-4-2: 2009 

Current Harmonic 

EN 61000-3-2: 2006+A1: 2009+A2: 2009 

Radiated Immunity 

EN 61000-4-3: 2006+A1: 2008+A2 :2010 

Voltage Fluctuation 

EN 61000-3-3: 2008 

Electrical Fast Transients 

EN 61000-4-4: 2012 

------------------------- 
Surge Immunity 

EN 61000-4-5: 2006 

------------------------- 
Conducted Susceptibility 

EN 61000-4-6: 2009 

------------------------- 
Power Frequency Magnetic Field 

EN 61000-4-8: 2010 

------------------------- 
Voltage Dips/ Interrupts 

EN 61000-4-11: 2004 

 
Low Voltage Equipment Directive 2006/95/EC 
Safety Requirements 
 

EN 61010-1: 2010  (Third Edition) 
EN 61010-2-030: 2010 (First Edition) 
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